Contents

What’s New in SAS 9.4 ODS Graphics Designer ......................... ix
Accessibility Notice ......................................................... xv

PART 1  Getting Started  1

Chapter 1  / Get Started Using the ODS Graphics Designer .................. 3
About the ODS Graphics Designer ........................................ 4
Important Information Related to SAS Viya and CAS Data .......... 5
Main Tasks That You Can Perform in the ODS Graphics Designer .... 6
Start the ODS Graphics Designer ......................................... 7
Where to Go from Here ..................................................... 9

Chapter 2  / Understanding the User Interface ............................... 11
Overview of the User Interface ............................................ 11
About the Graph Gallery .................................................... 13
About the Elements Pane .................................................... 16

Chapter 3  / Quick-Start Examples ........................................... 21
About the Quick-Start Examples .......................................... 22
Quick-Start Example One: Design a Simple Graph .................... 22
Quick-Start Example Two: Enhance the Simple Quick-Start Graph ... 27
Run the Examples on the SAS Server .................................... 36

PART 2  Designing Graphs  37

Chapter 4  / Fundamentals of Designing Graphs .......................... 39
Components of a Graph ..................................................... 39
### Chapter 5 / Creating and Managing Graphs

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a Graph</td>
<td>46</td>
</tr>
<tr>
<td>Add a Plot to a Graph</td>
<td>48</td>
</tr>
<tr>
<td>Assigning Data to a Plot</td>
<td>49</td>
</tr>
<tr>
<td>Plot Roles and Data Attributes</td>
<td>57</td>
</tr>
<tr>
<td>Select a Plot</td>
<td>69</td>
</tr>
<tr>
<td>Adding Reference Lines to Graphs</td>
<td>70</td>
</tr>
<tr>
<td>Remove a Plot from a Graph</td>
<td>75</td>
</tr>
<tr>
<td>Save a Graph to a File</td>
<td>76</td>
</tr>
<tr>
<td>Add a Graph to the Graph Gallery</td>
<td>77</td>
</tr>
<tr>
<td>Open a Graph</td>
<td>79</td>
</tr>
<tr>
<td>Working with the Graph Code</td>
<td>79</td>
</tr>
<tr>
<td>Copy and Paste a Graph to Another Application</td>
<td>81</td>
</tr>
<tr>
<td>Manage the Plots and Insets in a Cell</td>
<td>81</td>
</tr>
</tbody>
</table>

### Chapter 6 / Generating Bulk Graphs Automatically

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Auto Charts</td>
<td>85</td>
</tr>
<tr>
<td>Generate Auto Charts</td>
<td>88</td>
</tr>
<tr>
<td>Working with the Generated Graphs</td>
<td>91</td>
</tr>
<tr>
<td>Saving the Auto Charts</td>
<td>93</td>
</tr>
</tbody>
</table>

### Chapter 7 / Working with Titles and Footnotes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Titles and Footnotes</td>
<td>95</td>
</tr>
<tr>
<td>Add a Title or a Footnote</td>
<td>96</td>
</tr>
<tr>
<td>Edit and Format a Title or Footnote</td>
<td>96</td>
</tr>
<tr>
<td>Align a Title or Footnote Horizontally</td>
<td>98</td>
</tr>
<tr>
<td>Remove a Title or Footnote from a Graph</td>
<td>98</td>
</tr>
</tbody>
</table>

### Chapter 8 / Working with Legends

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Legends</td>
<td>99</td>
</tr>
<tr>
<td>Change the Contents of a Legend</td>
<td>102</td>
</tr>
<tr>
<td>Edit a Legend's Labels</td>
<td>103</td>
</tr>
<tr>
<td>Add a Title to a Legend</td>
<td>104</td>
</tr>
</tbody>
</table>
**Chapter 22 / Managing Graphs in the Graph Gallery** .................................................. 281
  - Add a Graph to the Graph Gallery ................................................................. 282
  - Change the Name, Icon, or Tooltip for a Graph in the Graph Gallery ................................................................. 283
  - Managing the Graphs in the Graph Gallery ..................................................... 285
  - Managing the Groups in the Graph Gallery ..................................................... 288

**PART 7  Examples** 291

**Chapter 23 / Examples for Creating Single-Cell Graphs** ................................. 293
  - Example: Create a Grouped Series Plot ......................................................... 294
  - Example: Create a Scatter Plot with Modified Axis Labels and Two Titles ......................................................... 297
  - Example: Add a Regression Overlay and Set Plot Properties ........................ 300

**Chapter 24 / Examples for Creating Multi-Cell Graphs** ................................. 307
  - Example: Create a Classification Panel ......................................................... 308
  - Example: Create a Heterogeneous Panel ....................................................... 312
  - Example: Create a Shared-Variable Graph and Add a Dynamic Title ............ 317

**Recommended Reading** ................................................................................. 329
**Glossary** ........................................................................................................ 331
**Index** ............................................................................................................. 335
What’s New in SAS 9.4 ODS Graphics Designer

Overview

The ODS Graphics Designer has the following changes and enhancements:

- enhancements for SAS 9.4M1
- enhancements for SAS 9.4M3
- a new Auto Charts feature for bulk graph generation
- new plots and charts
- updates to existing plots and charts
- general appearance enhancements
- enhancements to axes
Enhancements for SAS 9.4M1

The following enhancements have been added to SAS 9.4M1:

- When working with automatically generated graphs, you can save the graphs as images, as HTML files, or as ODS Graphics Designer files (SGD) that you can later edit.
- For charts, such as bar charts that enable you to specify a statistic, the default statistic is now MEAN. Previously, the default was SUM.
- You can save a graph to and open a graph from a remote server location.

Enhancements for SAS 9.4M3

The following enhancements have been added to SAS 9.4M3:

- Density (normal and kernel) and histogram plots support the Group option. In addition, these plots have a new Include Missing Group Values option that specifies whether missing values of the group variable are included in the plot.
- Help is now available from the Help menu.
- Subpixel rendering has been implemented, resulting in clearer images. Subpixel rendering generates smoother curves and more precise bar spacing.

Bulk Graph Generation

The new Auto Charts feature enables you to create graphs in bulk from a list of variables. Using the Auto Charts feature, you can easily generate a variety of graphs.
based on your data and the graph types that you specify. After generating the graphs, you can choose one or more graphs as the starting point for further enhancement. For example, you can modify the automatically generated titles and legends. You can also add more plots and other items to a graph.

The Auto Charts feature is ideal for exploring different visualizations of your data. You can generate a series of graphs and then choose the ones that best visualize the information. If you are not satisfied with the graphs, you can change a few parameters and generate another set of graphs.

New Plots and Charts

The following plots and charts have been added to the ODS Graphics Designer:

- Axis tables display data values at specific locations along the vertical or horizontal axis. An axis table is used with other charts to enhance the graph. The axis table must use the same type of data as the plot. A graph can have more than one axis table, and you can combine a horizontal and vertical axis table in the same graph.

  Axis tables are not available for classification panel graphs.

- High-low plots create a display of floating vertical or horizontal lines or bars that represent high and low values. When you create a high-low plot, your data can be presented as bars or as lines. You can also specify that OPEN and CLOSE variables be displayed as tick marks.

  You can specify appearance options for both plot types. For example, you can specify labels and change their text attributes. For high-low plots, you can change the appearance of the bars and lines.
Updates to Existing Plots and Charts

The following options and enhancements have been added to plots:

- For box plots, the Y and X role names have been changed to ANALYSIS and CATEGORY.
  
  You can specify the box width when an interval CATEGORY role is specified. The box width is specified in the Properties dialog box for the chart.

- For scatter plots, you can specify the marker position and size. These attributes are specified in the Assign Data dialog box for the plot.

- For histograms, you can specify the scaling that is applied to the vertical axis. This attribute is specified in the Assign Data dialog box for the plot. You can display the axis values as a percentage of the total, as a frequency count, or as proportions of the total.

- For plots that enable you to group the data, two features have been added.
  - For plots that use the CLUSTER group display option, you can assign a cluster width. The cluster width is specified as a ratio of the maximum midpoint spacing.
  - Grouped data can be ordered in ascending, descending, or data order. Data order displays each group value in the data order of the group variable.

General Appearance Updates

Four new ODS styles have been added to the ODS Graphics Designer: HTMLBlue, Dove, Pearl, and Raven.

The following appearance enhancements have been added to graphs, plots, and charts:

- You can specify subpixel rendering for a graph in order to generate smooth curves and more precise bar spacing. Subpixel rendering is available for line-based plots.
and bar charts. You enable subpixel rendering in the Graph Properties dialog box for the graph.

- Plots that support data labels or curve labels include the ability to customize the text attributes for those labels.

  Scatter plots enable you to split the text for the labels when there is not enough room to display the text normally. The labels can split at one or more characters that you specify.

- When you group the data in your graph, by default the ODS Graphics Designer rotates through the GraphData style elements for the presentation of each unique group value. To change the default appearance, you can specify attributes for group values. For example, you can specify fill colors, line patterns, and marker symbols. You can also change the number of attributes that are rotated.

  You can also change the attribute priority that determines the rotation pattern. These changes are made in the Graph Properties dialog box for the graph.

- The data skin property is enabled for most plots. The data skin applies a special effect to be used on filled graphics elements. You can select or clear the data skin property for a plot, and you can specify which data skin to use in the graph’s property dialog box. The default data skin is specified in the Preferences dialog box.

---

Enhancements to Axes

The following enhancements have been added to axes:

- The user interface for axis properties has been enhanced with new labels and fields that make axes easier to customize.

- Axis offsets enable you to specify an offset that precedes the lowest data value on the axis, an offset that follows the highest data value on the axis, or both. The specified value represents the offset as a proportion to the total length of the axis.
For discrete axes, you can specify alternating wall-color bands. When you specify color bands, you can customize the color bands by changing their style element, color, and transparency.

If your axis shows tick marks, then you can enable minor tick marks. This option is available only for linear and time axes.

If you display grid lines, then you can change the style element that is applied to the grid lines. You can also display minor grid lines at the minor tick values.

A new Tick Values List option enables you to customize the tick marks. For linear, time, and logarithmic axes, you can change the tick values and the text that is displayed. You can also add and delete ticks.

For a discrete axis, you can change the tick values and the text that is displayed. You can also remove ticks from the axis and change the order of ticks.
Accessibility Notice

For information about the accessibility of this product, see Accessibility Features of SAS 9.4 ODS Graphics Designer at support.sas.com.
Getting Started

Chapter 1
Get Started Using the ODS Graphics Designer .................. 3

Chapter 2
Understanding the User Interface .................................. 11

Chapter 3
Quick-Start Examples ................................................. 21
Get Started Using the ODS Graphics Designer

About the ODS Graphics Designer ........................................ 4
  What Is the ODS Graphics Designer? ................................. 4
  Who Uses the ODS Graphics Designer? ............................. 4
  About SGD Files ................................................................ 4
  About the SGDESIGN Procedure .................................... 5
  Supported Platforms .......................................................... 5

Important Information Related to SAS Viya and CAS Data ...... 5

Main Tasks That You Can Perform in the ODS Graphics Designer ........................................ 6

Start the ODS Graphics Designer ........................................ 7
  SAS Windowing Environment ........................................... 7
  SAS Studio ....................................................................... 8

Where to Go from Here ...................................................... 9
About the ODS Graphics Designer

What Is the ODS Graphics Designer?
The SAS ODS Graphics Designer is an interactive graphical application that you can use to create and design custom graphs. The designer creates graphs that are based on the Graph Template Language (GTL), the same system that is used by SAS analytical procedures and SAS ODS Graphics procedures. The ODS Graphics Designer provides a graphical user interface for designing graphs easily without having to know the details of templates and the GTL.

Using point-and-click interaction, you can create simple or complex graphical views of data using a wide array of plot types. You can design multi-cell graphs, classification panels, and scatter plot matrices. Your graphs can have titles, footnotes, legends, and other graphics elements. You can save the results as an image for inclusion in a report or as an ODS Graphics Designer file (SGD) that you can later edit.

Who Uses the ODS Graphics Designer?
The ODS Graphics Designer is generally used by analysts, statisticians, managers, academics, and others who want to graphically explore data or present the results of their analyses. Users do not need to know about the GTL. However, having knowledge about the DATA step and SAS/STAT procedures enables users to provide their own data using SAS data sets.

About SGD Files
An SGD file is a graph file that has been created using the ODS Graphics Designer and that has an .sgd file extension. The file contains a description of the graph to be rendered. You can open this file in the designer and make changes to the graph. You can also render the graph to an ODS destination by using the SGDESIGN procedure.
About the SGDESIGN Procedure

The SGDESIGN procedure complements the ODS Graphics Designer and is used to render a graph that has been saved as an SGD file. The procedure enables you to run one or more graphs in batch mode and render the graphs to any ODS destination. You can run graphs using different variables against the same or different data.

The basic syntax of the procedure is as follows:

```sas
PROC SGDESIGN SGD='SGD-file-name' <options>;
```

Here is an example:

```sas
ods html file="CarsLattice.html";
  proc sgdesign sgd="C:\SGDFiles\CarsLattice.sgd";
  run;
  ods html close;
```

You can specify a data set as an option to the procedure. By default, the procedure uses the data set that was used to create the SGD file.

For more information about the SGDESIGN procedure, see the SAS ODS Graphics: Procedures Guide.

Supported Platforms

The ODS Graphics Designer runs in Windows and UNIX operating environments.

Important Information Related to SAS Viya and CAS Data

The ODS Graphics Designer is not included in SAS Viya.

In addition, the ODS Graphics Designer cannot access SAS Cloud Analytic Services (CAS) in-memory tables. CAS is a server that provides the cloud-based run-time environment for data management and analytics with SAS. CAS performs analysis on in-memory tables.
Main Tasks That You Can Perform in the ODS Graphics Designer

The following list highlights some of the tasks that you can perform using the ODS Graphics Designer:

- use a gallery of predefined graphs to quickly create a graph. You can then customize a graph by adding titles, footnotes, legends, additional plots, and other items. You can also add your own graphs to the gallery.

- create bulk graphs automatically from a list of variables. Using the Auto Charts feature, you can easily generate a variety of graphs based on your data and the graph types that you specify. After generating the graphs, you can choose one or more graphs as the starting point for further enhancement. For example, you can modify the automatically generated titles and legends. You can also add more plots and other items to a graph.

- create multi-cell graphs, classification panels, and scatter plot matrices.

- add plots and reference lines to a graph.

You can add axis tables to graphs. An axis table displays data values at specific locations along the vertical or horizontal axis. An axis table is used with other charts to enhance the graph. A graph can have more than one axis table, and you can combine a horizontal and vertical axis table in the same graph.

- add and format titles and footnotes.

- add and customize legends.

- change the visual appearance of the entire graph by changing the applied style. You can also develop your own style.

- change the appearance of individual plot elements such as markers and lines.

- change the appearance of the axes. You can also change an axis type and customize the range of values that are displayed on the axis.
- resize the graph.
- copy a graph (image) to the system clipboard to paste directly into other applications.
- create graphs that can be reused with different variables in the same or different data set. These graphs are called shared-variable graphs.

## Start the ODS Graphics Designer

### SAS Windowing Environment

You can start the ODS Graphics Designer from the SAS menu or by using a macro.

1. Start a SAS session.

2. Do either of the following:
   - In the SAS windowing environment, select **Tools ➤ ODS Graphics Designer**.
   - Submit either of the following macro statements:
     ```
     %sgdesign;
     %sgdesign()
     ```

The designer appears in a separate window. When the designer starts, the following events occur:

- A new internal SAS session is launched, and the designer connects to this session. The designer obtains pertinent information about all libraries, data sets, and formats that have been defined at the time of invocation. The designer can then access these items in the new SAS session.

  **Note:** If you later add a SAS library, you must restart the designer to detect the new library. However, if you create a data set in a library that has already been defined, then the designer automatically detects your new data set.
The SAS session creates sample data sets that the designer uses to create its sample graphs. The sample graphs appear in the Graph Gallery.

The designer macro has optional parameters:

*portNum = integer*
Default = 5310. This parameter indicates the port that the designer uses to communicate with the SAS server. If another application is using port 5310, you can specify a different port for the designer.

*dataSets = Y | N*
Default = N. Some of the plots that are supplied with the designer depend on data sets that the designer creates in the WORK library. If you inadvertently delete some of these data sets, you can re-create them by setting this parameter to Y the next time you start the designer.

For example, to change the server port number to 5320 and re-create the data sets, you can submit the following statement:

```
%sgdesign( portnum=5320 , datasets=Y)
```

The parameters can be used in any order.

**SAS Studio**

To open the designer in SAS Studio, click the **More application options** button and select **Tools**. Then select **ODS Graphics Designer**.

**Note:** Depending on your edition and deployment of SAS Studio, you might need to install the designer first. For information about installing or starting the designer, see the SAS Studio documentation on the SAS Support site for your release of SAS Studio.

**TIP** To determine your SAS Studio release, select ? ➤ About SAS Studio.
### Where to Go from Here

**Table 1.1  Tasks for Exploration**

<table>
<thead>
<tr>
<th>Task</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn to navigate and use the designer’s graphical interface.</td>
<td>Chapter 2, “Understanding the User Interface,” (p. 11)</td>
</tr>
<tr>
<td>Learn by example how to create and design a graph.</td>
<td>Chapter 3, “Quick-Start Examples,” (p. 21)</td>
</tr>
<tr>
<td>Learn about the components that a graph contains. For example, a graph can contain cells, titles, legends, and so on.</td>
<td>“Components of a Graph” (p. 39)</td>
</tr>
<tr>
<td>Learn the high-level steps for designing graphs.</td>
<td>“High-Level Steps for Designing Graphs” (p. 43)</td>
</tr>
<tr>
<td>Learn about the different ways to create a graph.</td>
<td>“Creating a Graph” (p. 46)</td>
</tr>
</tbody>
</table>
Understanding the User Interface

Overview of the User Interface

The ODS Graphics Designer user interface consists of several main components, as shown in the following display.
Main menu bar

contains menus that you can use to perform these tasks:

- open, save, print, and edit SGD files
- open the Graph Gallery or view the code for a graph
- insert titles, footnotes, and legends
- add rows and columns to the graph
- apply a different style to a graph, customize styles, and define new styles
- set properties for graphs, plots, axes, legends, and other graph elements
- set display and usage preferences for the designer

Note: In addition to the main menu, the designer has pop-up menus that you can open by right-clicking various parts of a graph.
Elements pane
contains plots, lines, and insets that you can insert into a graph. To insert an element, click and drag the element to the graph. The elements on this pane are available only when a graph is open. For more information about the Elements pane, see “About the Elements Pane” on page 16.

Toolbar
contains icons that you can click to perform commonly used tasks such as saving files and inserting titles or footnotes. The icons on this toolbar are available only when a graph is open.

Work area
contains one or more graphs that you create and design in the designer. In addition to the graphs, you can display the Graph Gallery, a collection of predefined graphs. For more information about the Graph Gallery, see “About the Graph Gallery” on page 13.

About the Graph Gallery

Overview of the Graph Gallery

The ODS Graphics Designer provides a gallery of predefined, commonly used plots. The Graph Gallery is organized into groups of graphs. Each group is represented as a tab in the gallery. The following display shows the default view of the graphs that are on the Basic tab.
You can choose one of these predefined graphs as the basis for your graph. You can then customize your graph by adding titles, footnotes, legends, additional plots, and other items.

In addition to the predefined graphs, you can add your own custom graphs to the Graph Gallery.

**Open and Use the Graph Gallery**

If the gallery is not already displayed, you can open the gallery in any of the following ways:
Select **File ▶ New ▶ From Graph Gallery**. You typically use this command when you are ready to create a graph.

Select **View ▶ Graph Gallery**.

Click the View Graph Gallery icon in the toolbar.

After you open the gallery, you can open one of the graphs in the gallery. To open a graph, double-click the icon for the graph, or select an icon and then click **OK**.

### Description of the Tabs in the Graph Gallery

The Graph Gallery organizes graphs into tabs. For example, the **Grouped** tab contains plots for data that has been grouped by a variable.

For graphs that are created from the Graph Gallery, placeholder data is assigned to the plot or plots in the graph. When you create your graph, you can change the data as appropriate.

**Note:** Before changing the data, you should ensure that your replacement data has been properly preprocessed for the plots in the gallery. Some plots require particular types of data. For example, in the Pareto graph on the **Analytical** tab, the series plot requires a variable that calculates a cumulative percent.

Here are the predefined tabs:

#### Table 2.1  Predefined Tabs in the Graph Gallery

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>Includes scatter plots, histograms, and other basic plots</td>
</tr>
<tr>
<td>Grouped</td>
<td>Includes plots for data that has been grouped by a variable</td>
</tr>
<tr>
<td>Analytical</td>
<td>Includes commonly used analytical graphs</td>
</tr>
<tr>
<td>Custom</td>
<td>Includes graphs that require custom data</td>
</tr>
<tr>
<td>Matrix</td>
<td>Includes various scatter plot matrices</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panels</td>
<td>Includes various types of classification panel graphs</td>
</tr>
</tbody>
</table>

You can add your own custom groups to the gallery.

**About the Elements Pane**

**Overview of the Elements Pane**

The **Elements** pane contains plots and insets that you can insert into a graph.

The **Elements** pane contains the following panels:
The **Plot Layers** panel contains plots that you can click and drag to a graph cell. For a description of this panel, see “About the Plot Layers Panel” on page 18.

The **Insets** panel contains graphics elements that you can click and drag to a graph cell. For a description of this panel, see “About the Insets Panel” on page 19.

The elements on these panels are available only when a graph is open. To insert an element into a graph, click and drag the element to the graph.

**Note:** You can also insert an element by using a pop-up menu. For more information, see “Use the Add an Element Pop-up Window” on page 17.

### Show or Hide the Elements Pane

To show or hide the Elements pane, select or clear the **View ▶ Elements** menu option.

### Use the Add an Element Pop-up Window

As an alternative to dragging plots and insets from the **Elements** pane, you can insert an element by using a pop-up menu.

To use the Add an Element pop-up window:

1. Right-click inside a graph cell, and select **Add an Element**. The Add an Element pop-up window appears.
2 Click the element that you want to insert. If an element is dimmed, then you cannot add it to the cell.

**About the Plot Layers Panel**

*Figure 2.3  Plot Layers Panel*

The **Plot Layers** panel contains plots that you can click and drag to a graph cell. The panel contains a number of different plot types that can be used to design many types of graphs. All of the elements in this panel are plots. Here are the general types of plots:
basic plots, such as scatter, series, step, band, needle, and bar chart
fits and confidence plots, such as loess, regression, penalized B-spline, and ellipse
distribution plots, such as histogram, box plot, and density plot (normal and kernel)
vector and contour plots
lines, reference lines, and drop lines
block and stack block plots

You can add multiple plots to a graph cell as long as the data types are compatible. These plots are layered, or overlaid, in the cell.

About the Insets Panel

Figure 2.4 Insets Panel

The Insets panel contains elements that you can click and drag to a graph cell. You can add the following items to your graph:

- a discrete legend or a gradient legend (for contour plots)
- one or more cell headers and text entries

Legends and text insets can be placed in one of several locations within the cell.

Change the Appearance of the Elements Pane

You can change the appearance of the Elements pane by setting a preference so that a simpler interface is used.

The following display shows the Elements pane with the simpler interface.
Figure 2.5  Modified Elements Pane

The preference setting also applies to the Add an Element pop-up window.
Quick-Start Examples

**About the Quick-Start Examples** ................................................................. 22

**Quick-Start Example One: Design a Simple Graph** ................................. 22
  About Quick-Start Example One .............................................................. 22
  Step One: Create the Graph and Assign Data ......................................... 23
  Step Two: Add a Normal Plot to the Graph ............................................ 24
  Step Three: Customize the Graph Title .................................................. 25
  Step Four: Remove the Graph Footnote .................................................. 26
  Step Five: Save the Graph ....................................................................... 26

**Quick-Start Example Two: Enhance the Simple Quick-Start Graph** ........... 27
  About Quick-Start Example Two .............................................................. 27
  Step One: Open Quick-Start Example One ............................................... 28
  Step Two: Add a Kernel Density Plot to the Histogram ......................... 28
  Step Three: Add a Column Cell to the Graph ......................................... 28
  Step Four: Add a Box Plot to the New Cell ............................................ 29
  Step Five: Add a Global Legend to the Graph ........................................ 31
  Step Six: Change the Format of the Kernel Plot ..................................... 33
  Step Seven: Widen the Cell in the First Column ..................................... 35
  Step Eight: Save the Graph ..................................................................... 36

*Run the Examples on the SAS Server* ......................................................... 36
About the Quick-Start Examples

Two quick-start examples have been provided to help you get started creating graphs:

- “Quick-Start Example One: Design a Simple Graph” on page 22
- “Quick-Start Example Two: Enhance the Simple Quick-Start Graph” on page 27

The examples provide step-by-step instructions for creating a graph. You first create a simple graph and then add more complexity to the graph. The graph is based on data that is available in the SASHELP library.

These examples are intended to be followed in order. The graph that you create in example two builds on and enhances the graph that you create in example one.

By following the steps in these examples, you can learn about several main features of ODS Graphics Designer, such as titles, legends, plot properties, and multi-cell graphs.

For more examples, see these chapters:

- Chapter 23, “Examples for Creating Single-Cell Graphs,” on page 293
- Chapter 24, “Examples for Creating Multi-Cell Graphs,” on page 307

Quick-Start Example One: Design a Simple Graph

About Quick-Start Example One

This example uses the Heart data set in the SASHELP library. The example shows the distribution of the weight of individuals who participated in a medical study. The graph that you create here contains a histogram and a normal density curve.
To create this graph, follow these steps.

**Step One: Create the Graph and Assign Data**

In this step, you create a graph from the Graph Gallery.

1. Open the Graph Gallery if it is not already open. Select **File ➤ New ➤ From Graph Gallery**, or click the Graph Gallery toolbar button.

2. On the **Basic** tab, double-click the Histogram icon.

   The Histogram icon looks like this: 

   ![Histogram Icon]

   The Assign Data dialog box appears.

3. In the Assign Data dialog box, complete these steps:
Select SASHELP from the Library list box.
Select HEART from the Data Set list box.
Select WEIGHT from the X list box.

4 Click OK.

Step Two: Add a Normal Plot to the Graph

1 From the Plot Layers panel of the Elements pane, click and drag the Normal icon to the graph. (If the Elements pane is not visible, select View ▶ Elements to display it.)

The Normal icon looks like this: 🔄

The Assign Data dialog box appears.
2 In the Assign Data dialog box, keep the default selections.

![Assign Data Dialog Box](image)

Note the following:

- You cannot change the library and data set. All plots that reside in a common cell must use a common data set.

- By default, the **Fit an existing plot** check box is selected. This setting indicates that the variables of the normal density curve are matched to those of the histogram. Accordingly, the **X** variable list box is dimmed.

3 Click **OK**.

**Step Three: Customize the Graph Title**

The histogram contains a placeholder title above the plot. By default, the title contains the text “Type in your title...”.
1 Double-click the placeholder title. The placeholder text is highlighted:

[Type in your title...]

2 In the text box, enter Weight Distribution.

**Step Four: Remove the Graph Footnote**

The histogram contains a placeholder footnote in the lower left corner of the graph. By default, the footnote contains the text “Type in your footnote...”.

For this example, you can remove the footnote.

To remove the footnote, right-click the placeholder footnote and select *Remove Footnote* from the pop-up menu.

**Step Five: Save the Graph**

It is recommended that you save this graph so that you can later return to it.

1 Select **File ➢ Save As**.

2 Save the file to the desired location. Specify the name that you want for the file. For example, you might enter quickStart. The file type *SGD Files (*.sgd)* is selected by default.

3 Click **Save**.

The next quick-start example builds on this graph. See “Quick-Start Example Two: Enhance the Simple Quick-Start Graph” on page 27.
Quick-Start Example Two: Enhance the Simple Quick-Start Graph

About Quick-Start Example Two

This example builds on and enhances the graph that you created in quick-start example one, which showed the distribution of the weight of individuals who participated in a medical study.

The graph that you create here adds more information to the example. In this example, you add a kernel density plot to the histogram. You also create a second column that contains a box plot, add a global legend, and change the line format of the kernel density curve.

Figure 3.2 Enhanced Graph
Step One: Open Quick-Start Example One

Open the graph that you created and saved in quick-start example one.

Select File ➤ Open, and then navigate to the file that you saved.

If you have not yet created the graph, then follow the steps provided in “Quick-Start Example One: Design a Simple Graph” on page 22 to create the graph.

Step Two: Add a Kernel Density Plot to the Histogram

1. From the Plot Layers panel, click and drag the Kernel icon to the graph.
   
   The Kernel icon looks like this: ⌳
   
   The Assign Data dialog box appears.

2. In the Assign Data dialog box, keep the default selections and click OK. The kernel plot is added to your graph.

Step Three: Add a Column Cell to the Graph

Right-click anywhere within the plot area of the graph and select Add a Column. A new blank column is added to the graph. The column consists of one cell that contains the text “(drop a plot here...)”.
Step Four: Add a Box Plot to the New Cell

1. From the Plot Layers panel of the Elements pane, click and drag the Box icon to the new cell in the graph.

   The Box icon looks like this: 

   The Assign Data dialog box appears.

2. In the Assign Data dialog box, complete these steps:
   - Select SASHELP from the Library list box.
   - Select HEART from the Data Set list box.
   - Select WEIGHT from the Analysis list box.
   - Select SEX from the Category list box.
3 Click **OK**.

The graph now contains a box plot.
Step Five: Add a Global Legend to the Graph

1. Click in the toolbar to add a global legend. The Global Legend dialog box appears.

2. Select the check box next to normal and kernel.
3 Click **OK**.

The graph now contains a global legend.
Step Six: Change the Format of the Kernel Plot

In the example, both the normal and the kernel density plots have the same visual properties, and you cannot distinguish between the two. In this step, you change the format of the kernel plot so that you can distinguish the kernel plot from the normal plot.

1. Right-click anywhere within the plot area of the first cell (column one) and select Plot Properties. The Cell Properties dialog box appears with the Plots tab displayed.

2. From the Plot list box, select kernel.

   **Note:** Alternatively, in step 1, right-click directly on the kernel plot and select Plot Properties. Then kernel is already selected in the Plot list box.

3. From the Style Element list box, select GraphFit2.

![Cell Properties dialog box with kernel plot settings](image)
4 Click **OK**.

The kernel curve is now a red dashed line. This change makes it easier to distinguish the normal curve from the kernel curve. Note also that the legend has been updated with the new property.
Style elements are obtained from ODS styles and determine the format of plot elements. It is preferable to change the style element rather than the explicit line properties of the kernel plot. Changing the style element guarantees that the kernel and normal plots are visually distinct for any style that is applied to the graph.

**Step Seven: Widen the Cell in the First Column**

Both cells in the graph currently have the same width. You can widen the cell that contains the histogram so that the histogram has more space.

1. Position the cursor between the two cells of the graph. A dashed line appears between the cells and the cursor changes to a two-headed arrow ↔.

2. Click and drag the dashed line toward the right. The cell with the histogram becomes wider and the cell with the box plot becomes narrower.
Step Eight: Save the Graph

To save the graph, select File ➤ Save As and then specify the filename and type. For more information, see “Save a Graph to a File” on page 76.

Run the Examples on the SAS Server

After you have created and saved a graph in ODS Graphics Designer, you can use the SGDESIGN procedure to run the SGD file in batch mode and render the graph to any ODS destination. For more information, see “About the SGDESIGN Procedure” on page 5.
Part 2

Designing Graphs

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td><em>Fundamentals of Designing Graphs</em></td>
<td>39</td>
</tr>
<tr>
<td>5</td>
<td><em>Creating and Managing Graphs</em></td>
<td>45</td>
</tr>
<tr>
<td>6</td>
<td><em>Generating Bulk Graphs Automatically</em></td>
<td>85</td>
</tr>
<tr>
<td>7</td>
<td><em>Working with Titles and Footnotes</em></td>
<td>95</td>
</tr>
<tr>
<td>8</td>
<td><em>Working with Legends</em></td>
<td>99</td>
</tr>
</tbody>
</table>
Chapter 9

Working with Text Entries ............................................. 109

Chapter 10

General Information about Modifying Textual Elements … 113
Components of a Graph

In general, a graph is made of up of the following parts:

- titles and footnotes
- one or more cells that contain a composite of one or more plots
- legends, which can reside inside or outside a cell
The following figure shows the different parts of a graph:

**Figure 4.1  Components of a Graph**

1. **Graph**
   a visual representation of data. The graph can contain titles, footnotes, legends, and one or more cells that have one or more plots.

2. **Cell**
   a distinct rectangular subregion of a graph that can contain plots, text, and legends.

3. **Title**
   descriptive text that is displayed above any cell or plot areas in the graph.

4. **Plot**
a visual representation of data such as a scatter plot, a series line, a bar chart, or a histogram. Multiple plots can be overlaid in a cell.

5 Legend

refers collectively to the legend border, one or more legend entries (where each entry has a symbol and a corresponding label) and an optional legend title.

6 Axis

refers collectively to the axis line, the major and minor tick marks, the major tick mark values, and the axis label. Each cell has a set of axes that are shared by all the plots in the cell. In multi-cell graphs, the columns and rows of cells can share common axes if the cells have the same data type.

7 Footnote

descriptive text that is displayed below any cell or plot areas in the graph.

Compatible Plot Types

The ODS Graphics Designer enables you to combine multiple plots together in a graph cell. For example, you can design overlays from a wide array of plot types. Some plots, such as histograms and density plots, are often combined in a graph to achieve an effective overlay layout.

You can add multiple plots to a graph cell as long as the data types are compatible. In other words, the axis types for the plots in the cell must match, whether they are X or X2, Y or Y2.

The following graph from the Analytical tab of the Graph Gallery contains several compatible plots, including a band plot, a series plot, and a scatter plot.
Here are some general guidelines for compatibility:

- Some plots that show the raw data without any summarization can handle all data types. For example, scatter and series plots can be combined in any situation. However, other plots that also do not provide summarization do have type restrictions. Examples are needle, step, band, and vector plots.

- Plots such as bar charts that summarize the response data require the response data type to be numeric. Other plots, such as box plots and histograms, create a display based on some analysis of the data. These plots might have special requirements for the data.

Note that these plots can be vertical or horizontal. The response axis is Y or Y2 for vertical plots and X or X2 for horizontal plots.
When a plot that you drag to a cell is incompatible with existing plots in the cell, the ODS Graphics Designer displays a message.

---

**High-Level Steps for Designing Graphs**

The ODS Graphics Designer provides many options for designing graphs, and your approach can vary from what is described here. Generally, a typical design process might consist of the following steps:

1. **Create the graph** if you have not already done so.

2. Add additional plots to the graph as desired. For instructions, see “Add a Plot to a Graph” on page 48.

   Exception: You cannot add plots to matrix graphs that you create from the **Matrix** tab of the Graph Gallery.

3. To design a multi-cell graph, add one or more rows, columns, or both to the graph. Then add one or more plots to the new cells. For instructions, see “Adding Rows and Columns to a Graph” on page 227.

   Exception: You cannot add rows and columns to graphs that you create from the **Matrix** tab or the **Panels** tab of the Graph Gallery.

   **Note:** The designer also enables you to create classification panels, which are data-driven layouts that create a grid of cells based on one or more classification variables. For more information, see Chapter 18, “Creating Classification Panels,” on page 241.

4. Customize the graph. Here are some of the changes that you can make:
   - Change the graph’s style, size, or background color.
   - Change the visual attributes of a plot, such as marker color, symbol, line color, and thickness.
   - Change axis properties, including grid lines.
Add titles and footnotes to the graph.

Add or customize legends, which can reside inside or outside of a cell.

Add headers to a cell.

Add text to a cell.

5  Save the graph. For instructions, see “Save a Graph to a File” on page 76.

You can also create graphs that can be reused with different variables in the same or in a different data set. For more information, see Chapter 20, “Using Shared Variables in Graphs,” on page 259.
Creating and Managing Graphs

Creating a Graph .................................................. 46
  About Creating a Graph ........................................ 46
  Create a Graph from the Graph Gallery ...................... 47
  Create a Graph from a Blank Graph Window .................. 48

Add a Plot to a Graph ............................................ 48

Assigning Data to a Plot ......................................... 49
  About Assigning Data to a Plot .............................. 49
  About Plot Roles .............................................. 50
  Assign Data to a New Plot .................................... 50
  Change the Data Assignment for a Plot in a Graph ......... 53

Plot Roles and Data Attributes ............................... 57
  Data Roles (X, Y, Z) ......................................... 57
  Plot Data ...................................................... 57
  Group Options .................................................. 65
  Appearance Options .......................................... 67

Select a Plot ...................................................... 69

Adding Reference Lines to Graphs .......................... 70
  About Adding Reference Lines ............................... 70
  Add a Reference Line to a Graph ............................ 71
  Reposition a Reference Line .................................. 74
  Change the Length of a Drop Line ......................... 75
Creating a Graph

About Creating a Graph

ODS Graphics Designer provides more than one way to create a graph:

- The designer provides a gallery of predefined, commonly used graphs. If the graph that you want to create exists in the Graph Gallery, then an easy way to create the graph is to open the predefined graph from the gallery.

  For instructions, see “Create a Graph from the Graph Gallery” on page 47. For more information about the gallery, see “About the Graph Gallery” on page 13.

  If you do not find the exact graph that you need in the gallery, you might find a graph that can be used as a starting point, from which to build your custom graph. Or, you can dynamically generate your own gallery of graphs, as explained in the next bullet.

- The Auto Charts feature enables you to generate graphs based on your data and the graph types that you specify. You can easily generate a number of graphs and then use the graph layout that you want.

  For instructions, see “Generate Auto Charts” on page 88. For more information about Auto Charts, see “Overview of Auto Charts” on page 85.
You can start from a blank graph window and then add plots, titles, legends, and other elements to create your graph.

For instructions, see “Create a Graph from a Blank Graph Window” on page 48.

**Note:** You can also create what is called a shared-variable graph. This type of graph is useful when you want to reuse a graph with different variable names. For more information, see “About Shared Variables” on page 259.

### Create a Graph from the Graph Gallery

For graphs that are created from the Graph Gallery, placeholder data is assigned to the graph. You can change the data as appropriate for your graph. After you create the graph, you can add plots, titles, legends, and other elements to the graph.

To create a graph from the Graph Gallery:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

   The Graph Gallery appears and displays graphs that are grouped into different tabs.

2. In the gallery, locate and select the graph that you want. Then either double-click the graph or click **OK**.

   The Assign Data dialog box appears.

   Exception: The Assign Data dialog box does not open if you selected a multi-cell graph from the gallery. This is because each cell of the graph might use a different data set. After opening a multi-cell graph, to customize the data for the various plots in the graph, you must open the Assign Data dialog box for each cell individually.

3. In the Assign Data dialog box, specify the data for the plot or plots in the graph, and then click **OK**. For more information, see “Change the Data Assignment for a Plot in a Graph” on page 53.

After you have created a graph, you can perform additional steps as desired to design and customize your graph. For example, you might add another plot or more cells to the graph. You can also add titles, footnotes, and make other changes to the graph. For
Create a Graph from a Blank Graph Window

To create a graph from a blank graph window:

1. Select File ➔ New ➔ Blank Graph, or click the New Blank Graph toolbar button.

2. Add a plot to the blank graph. One way to add a plot is to click and drag the plot icon from the Plot Layers panel to your graph. For more information, see “Add a Plot to a Graph” on page 48.

   The Assign Data dialog box appears.

3. In the Assign Data dialog box, specify the data for the plot in the graph, and then click OK. For more information, see “Assign Data to a New Plot” on page 50.

After you have created a graph, you can perform additional steps as desired to design and customize your graph. For example, you might add another plot or more cells to the graph. You can also add titles, footnotes, and make other changes to the graph. For more information about the tasks that you can perform, see “High-Level Steps for Designing Graphs” on page 43.

Add a Plot to a Graph

A plot is a visual representation of data such as a scatter plot, a series line, a bar chart, or a histogram. A graph can contain one or more plots. Many analytical graphs are built by layering multiple plots in a graph cell.

Note: You cannot add plots to matrix graphs that you create from the Matrix tab of the Graph Gallery.

To add a plot to a graph cell:

1. Do one of the following:
- In the **Plot Layers** panel of the **Elements** pane, click and drag a plot icon to a cell in your graph.

- Right-click inside a graph cell and choose **Add an Element** from the pop-up menu. Then click a plot icon from the **Elements** pop-up window.

  The Assign Data dialog box appears.

2. Specify the data for the plot, and then click **OK**. For more information, see “Assign Data to a New Plot” on page 50.

3. Repeat the previous steps if you want to overlay another plot on the existing plot.

   **Note:** All plots in a cell must use a single common data set.

4. Save your changes. See “Save a Graph to a File” on page 76.

---

### Assigning Data to a Plot

#### About Assigning Data to a Plot

You assign plot data when you add a plot to a graph or when you first create a graph from the Graph Gallery. Here are more details:

- When you add a plot to a graph, an Assign Data dialog box appears in which you can assign a library, data set, and one or more plot variables.

  **Note:** If you are adding a plot overlay to a cell, you cannot change the library or the data set when you assign data. All plot layers in a cell must use a common data set.

- If you create a graph from the Graph Gallery, placeholder data is assigned to its plots. For this pre-assigned data, the designer uses data from the WORK, SASHELP, or the SASUSER library. You can change the data that is associated with the plot or plots in the graph.

Regardless of the method used to create a graph, you can later change the data for all plots in a cell of a graph.
Note: If you have customized an axis, some changes to the data can cause your custom axis changes to be lost. For example, adding or removing panel variables removes your axis changes. However, changes to a group variable, group display, data label, or curve label do not affect your custom axis settings. Also, appearance options such as discrete offsets do not affect your custom axis settings.

About Plot Roles

When you assign data to a plot, you can assign variables to various plot roles.

A role is a generic term for the purpose that a variable serves in a plot. All plots have predefined roles. For example, a scatter plot includes roles named for X, Y, Group, Data Label, Error Upper, and Error Lower. A bar chart includes roles named Category, Response, Group, and URL. In the scatter plot example, you might assign a data variable WEIGHT to the plot role X.

Assign Data to a New Plot

For each new plot that you add to a graph, you assign data in the Assign Data dialog box. The fields on this dialog box vary by plot. The Assign Data dialog box displays the plot type in its title bar.

The following display shows the Assign Data dialog box that appears when you add a scatter plot.
The dialog box appears automatically when you add the plot to a graph.

Note: If you are changing the data for an existing plot, see “Change the Data Assignment for a Plot in a Graph” on page 53.

To assign data to a plot:

1. In the Assign Data dialog box, specify the SAS library and data set that you want to use for the plot. Select the appropriate items from the **Library** and **Data Set** list boxes.
   
   All plot layers in a cell must use a common data set. If you are adding a plot overlay to an existing plot in a cell, you cannot change the library or the data set at this time.

   Note: The designer cannot access CAS data tables.
2 In the **Variables** section, assign a data variable to each plot role that is listed. (Some roles might be optional.) To assign a variable, select the variable from the list box next to the role's label. For more information about the roles, see “Plot Roles and Data Attributes” on page 57.

If the **More Variables** button is available, then you can click this button to assign variables to additional plot roles. In the scatter plot example, this option enables you to set error upper and error lower limits.

3 If the **Fit an existing plot** check box is available, select the check box to match the variables of the plot to those of another plot. This check box is available only for specific plot overlays, such as a Loess plot over a scatter plot or a normal plot over a histogram.

If you select the check box, make sure that the plot that you want to fit appears in the **Plot** list box.

The following display shows the fields for a normal density plot that is overlaid on a histogram.

![Fit an existing plot](image)

In the example, the check box is selected. This setting indicates that the X role of the normal plot is matched to that of the histogram. Accordingly, the **X** list box is dimmed. If you clear the **Fit an existing plot** check box, then you must assign a variable to the X role.

4 (Optional) If you want a more descriptive name for the plot, enter the name in the **Name** text box. This name identifies the plot in the Assign Data dialog box, in the Cell Properties dialog box, in the Legend Contents dialog box, and other places within the application.

By default, the designer uses generic names for each plot. It is good practice to assign a descriptive name that indicates a response variable or some identifying characteristic of the plot.
5 (Optional) Specify use of a secondary axis (X2, Y2, or both X2 and Y2). The secondary axis is a duplicate of the X or Y axis, and is displayed on the opposite side of the cell area from the primary axis.

**Note:** You cannot specify a secondary axis if the graph is a classification panel.

6 If the **Advanced Options** button is available, you can click this button to specify additional options.

Advanced options typically involve computational settings. For example, for plots that have confidence limits, this feature enables you to set the alpha value, the degree, and the interpolation.

7 If you want to create a classification panel, click the **Panel Variables** tab and select one or more classification variables. For instructions, see “Creating a Classification Panel” on page 243.

The **Panel Variables** tab is not available for multi-cell graphs (graphs that have more than one column or row).

---

**Change the Data Assignment for a Plot in a Graph**

After a graph has been created, you can change the data assignment for one or more plots in the graph. You also change the data assignment for one or more plots when you open a graph from the Graph Gallery. (Placeholder data is assigned to plots for the graphs in the gallery.)

You assign data in the Assign Data dialog box. The fields on this dialog box vary by plot. The following display shows the Assign Data dialog box for a scatter plot.
Depending on how you opened the graph, the Assign Data dialog box appears as follows:

- If you open a graph that you have already created, then you must open the dialog box manually (as described in the following procedure).
- The dialog box appears automatically when you open a graph from the Graph Gallery.

Exception: The Assign Data dialog box does not open if you select a multi-cell graph from the gallery. After opening a multi-cell graph, to customize the data for the
various plots in the graph, you must open the Assign Data dialog box for each cell individually.

To change the data assignment for a plot:

1. Open the Assign Data dialog box if it is not already open. To open the dialog box, right-click inside the graph cell that contains the plot whose data you want to modify, and select **Assign Data**.

   The Assign Data dialog box appears.

   **Note:** Alternatively, right-click directly on the plot and select **Assign Data**. This action opens the Assign Data dialog box with the plot already selected.

2. If you want to change the SAS library and data set, select the appropriate items from the **Library** and **Data Set** list boxes.

   After you change the library or data set, the plot labels might appear red. This color indicates that required variables do not exist in the new data set, and that you must assign variables for the plots. When you assign variables for any of these plots, the plot name changes to black.

3. Make sure that the **Plot** list box displays the plot that you want to modify. If necessary, select a different plot from the list box.

4. In the **Variables** section, assign a data variable to each plot role that is listed. (Some roles might be optional.) To assign a variable, select the variable from the list box next to the role's label. For more information about the roles, see “Plot Roles and Data Attributes” on page 57.
If the **More Variables** button is available, then you can click this button to assign variables to additional plot roles. In the scatter plot example, this option enables you to set error upper and error lower limits.

5. If the **Fit an existing plot** check box is available, select the check box to match the variables of the plot to those of another plot. This check box is available only for specific plot overlays, such as a Loess plot over a scatter plot or a normal plot over a histogram.

If you select the check box, make sure that the plot that you want to fit appears in the **Plot** list box.

The following display shows the fields for a normal density plot that is overlaid on a histogram.

![Fit an existing plot](image)

In the example, the check box is selected. This setting indicates that the X role of the normal plot is matched to that of the histogram. Accordingly, the X list box is dimmed. If you clear the **Fit an existing plot** check box, then you must assign a variable to the X role.

6. (Optional) If you want a more descriptive name for the plot, enter the name in the **Name** text box. This name identifies the plot in the Assign Data dialog box, in the Cell Properties dialog box, and in other places within the application.

By default, the designer uses generic names for each plot. It is good practice to assign a descriptive name that indicates a response variable or some identifying characteristic of the plot.

7. (Optional) Specify use of a secondary axis for the X axis, the Y axis, or both X and Y axes. The secondary axis is a duplicate of the X or Y axis, and is displayed on the opposite side of the cell area from the primary axis.

**Note:** You cannot specify a secondary axis if the graph is a classification panel.
8 If the **Advanced Options** button is available, you can click this button to specify additional options.

Advanced options typically involve computational settings. For example, for plots that have confidence limits, this feature enables you to set the alpha value, the degree, and the interpolation.

9 If the graph contains another plot whose variables you want to change, select the plot from the **Plot** list box. Then change the variables for the plot.

10 If you want to create a classification panel, click the **Panel Variables** tab and select one or more classification variables. For instructions, see “Creating a Classification Panel” on page 243.

The **Panel Variables** tab is not available for multi-cell graphs (graphs that have more than one column or row).

---

**Plot Roles and Data Attributes**

In the Assign Data dialog box, you assign data variables to various plot roles, such as X, Y, and so on. The roles that are available depend on which type of plot you are editing. You can also assign data attributes, such as data labels, and other options that are described here.

**Data Roles (X, Y, Z)**

For most of the plots, you assign the variable for the X role, the Y role, or both roles. These roles correspond to the X and Y axes. (Exceptions include bar charts, which have category and response roles instead. Box plots have analysis and category roles.)

For the contour plot, you also assign a variable for the Z role.

**Plot Data**

The following list summarizes the roles that you can specify for plots:
Bar Chart and Bar Error Chart Data

For bar charts, you provide a category variable and an optional response variable. If you do not specify a response variable, then the designer displays the frequency for the category variable.

Here are additional options:

- **Group** role creates a separate bar segment for each unique group value in each category. You can also use the **Group Display** option to specify whether bars are stacked or clustered. For more information about group options, see “Group Options” on page 65.

- **Bar Width** enables you to specify the width of the bars as a ratio of the maximum possible width. The maximum width is equal to the distance between the center of each bar and the centers of the adjacent bars. Specify a value from 0.0 (narrowest) to 1.0 (widest).

  For example, if you specify a width of 1.0, then there is no space between the bars. If you specify a width of 0.5, then the width of the bars is equal to the space between the bars.

  To access this option, click **Advanced Options** in the Assign Data dialog box.

  **TIP** This feature is also available as a plot property. You can also click and drag a bar edge to change the bar width.

- The **URL** role enables a URL link to be associated with each bar or bar segment. If the graph is saved as an HTML output file, then clicking on each bar navigates to the specified HTML page.

  You assign the variable that contains the URL values. Here is an example URL: http://www.sas.com/technologies/analytics/index.html

  For non-grouped data, the values of the variable are expected to be the same for each unique X.

- You can specify the statistic to be computed for the Y axis. When the response variable is selected, the default statistic is **MEAN**. When the response variable is not selected, the default statistic is **FREQ**.
- **Discrete Offset** enables you to specify an amount to offset all bars from the category midpoints. To access this option, click **Advanced Options** in the Assign Data dialog box. For more information, see “Appearance Options” on page 67.

**TIP** You can also select a plot element and drag it to the desired offset position.

For Bar Error charts, the category variable should not have repeated values. You can specify upper error and lower error limits.

**Box Plot Data**

For box plots, you specify variables for the analysis and category roles. The category role is optional. A box plot is created for each distinct value of the category variable. If you do not specify a variable for the category role, then one box is created for the analysis variable.

Here are additional options:

- The **Group** role creates a separate box segment for each unique group value in each category. You can also use the **Group Display** option to specify whether boxes are overlaid or clustered. For more information about group options, see “Group Options” on page 65.

- **Box Width** enables you to specify the width of the boxes as a ratio of the maximum possible width. Specify a value from 0.0 (narrowest) to 1.0 (widest).

  For example, if you specify a width of 1.0, then there is no space between the boxes. If you specify a width of 0.5, then the width of the boxes is equal to the space between the boxes.

  To access this option, click **Advanced Options** in the Assign Data dialog box.

**TIP** This feature is also available as a plot property. You can also click and drag a box edge to change the box width.

- **Discrete Offset** enables you to specify an amount to offset all boxes from the tick marks. To access this option, click **Advanced Options** in the Assign Data dialog box. For more information, see “Appearance Options” on page 67.
**TIP** You can also select a plot element and drag it to the desired offset position.

**Histogram Bin Data**
For histograms, you can specify these advanced options:

- **scale** specifies the scaling that is applied to the vertical axis (for a vertical histogram) or the horizontal axis (for a horizontal histogram).
  
  You can select one of the following:

  - **Percent (default)** the axis displays values as a percentage of the total.
  - **Count** the axis displays the frequency count.
  - **Proportion** the axis displays values as proportions (0.0 to 1.0) of the total.

- **bin width.** Changing the bin width can also result in a different number of bins.

- **bin starting position.** This value sets the X coordinate of the first bin for the histogram. The bin is drawn only if it contains data.

**Band Data**
For band plots, in addition to the X variable, you can specify the upper and lower limits for the band.

You can specify a numeric data variable for the limits by selecting the variable from the Limit Upper and the Limit Lower list boxes. Alternatively, to specify a constant value, select **Constant: <type value>** from the list box. Then enter the value.

**Vector Origin Data**
For vector plots, in addition to the X and Y variables, you can specify the vector origin.

You can specify a numeric data variable to use for the origin by selecting the variable from the XOrigin list box or the YOrigin list box. Alternatively, to specify a constant coordinate, such as 0.0, select **Constant: <type value>** from the list box. Then enter the coordinate value.

**Contour Data**
For a contour plot, you must specify grid data for the contour X and Y roles, with a Z value for each (X,Y) crossing.
The **Contour Type** list box enables you to specify how the contour is displayed as follows:

- **Line** displays contour levels as unlabeled lines.
- **Fill** displays the area between the contour levels as filled. Each contour interval is filled with one color.
- **Gradient** displays a smooth gradient of color to represent contour levels.
- **LineFill** combines the Line and Fill types. Each contour interval is filled with one color. Displays contour levels as unlabeled lines.
- **LineGradient** combines the Line and Gradient types. Displays contour levels as unlabeled lines.
- **LabeledLine** adds labels to the Line type. Displays contour levels as labeled lines.
- **LabeledLineFill** adds labels to the LineFill type. Each contour interval is filled with one color. Displays contour levels as lines with labels showing contour level values.
- **LabeledLineGradient** adds labels to the LineGradient type. Displays contour levels as lines with labels showing contour level values.

**Loess, Regression, PBSpline, and Model Band Data**

- You can select the **Fit an existing plot** check box to match the variables of an overlaid loess, regression, or PBSpline (penalized B-spline) plot to those of a scatter plot.

- You can also enable the following model band options:

  - **CLM** creates confidence limits. This option is available for all three plots. The confidence level is set by the alpha value.
CLI produces confidence limits for individual predicted values for each observation. This option is available for regression and PBSpline plots. The confidence level is set by the alpha value.

You can specify the following by clicking **Advanced Options**:

**Alpha value**
- specifies the confidence level to compute. The default is 0.05, which represents a 95% confidence level.

**Degree**
- specifies the degree of the polynomial that is computed. A degree of one produces a linear fit, a degree of two produces a quadratic fit, and so on. The available degrees are shown here:

<table>
<thead>
<tr>
<th>Plot</th>
<th>Degrees Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loess</td>
<td>one and two</td>
</tr>
<tr>
<td>PBSpline</td>
<td>one, two, and three</td>
</tr>
<tr>
<td>Regression</td>
<td>one through five</td>
</tr>
</tbody>
</table>

**Interpolation**
- specifies the degree of the interpolating polynomials that are used for blending local polynomial fits at the vertices. This value is used with loess plots. Possible choices are Linear (default) and Cubic.

**Reference and Drop Lines**
- You can specify the position and other information for horizontal, vertical, and sloped reference lines as well as for drop lines. For more information, see “Adding Reference Lines to Graphs” on page 70.

**Block, Stack Block Data**
- Block plots create one or more strips of rectangular blocks containing text values. The width of each block corresponds to specified numeric intervals along the X axis. The height of the blocks represents the value of the chart statistic for each category of data.
You select an X variable and a block variable. If the X variable is numeric, values are expected to be in sorted, ascending order.

You can assign a position for the plot. Most block plots are positioned in the center of the graph area. When you combine a block plot with another plot in an overlay, the block plot can be positioned in the top or bottom margin of the graph.

For a stacked block, you must also specify a group variable.

High-Low Data
High-low plots create a display of floating vertical or horizontal lines or bars that represent high and low values. When you create a high-low plot, the item that you choose from the **Elements** pane determines whether your data is presented as bars or as lines.

For high-low plots, you specify variables for the X (for vertical charts), Y (for horizontal charts), LOW, and HIGH roles.

You can also specify group options. For more information about group options, see “Group Options” on page 65.

When you click **More Variables**, you can specify the following:

- OPEN and CLOSE variables to be displayed as tick marks
- whether to use an arrow for the low and high caps (see the discussion that follows this list)
- variables to use for the LOW and HIGH labels

In the **Low Cap** and the **High Cap** list boxes, you can specify the type of cap used at the low and high end of the bar or line. You can select one of the keywords, or you can specify a character variable that contains one of the keywords.

- For bars, you can select the **ARROW** keyword. This places an arrow at the end of your bars.

- For lines, you can select one of the following keywords.
### Axis Table Data

An axis table displays data values at specific locations along the vertical or horizontal axis. The axis table is used with other charts to enhance the graph. The axis table must use the same type of data as the plot. A graph can have more than one axis table, and you can combine a horizontal and vertical table in the same graph.

**Note:** Axis tables are not available for classification panel graphs.

For an axis table, you specify a variable for the X role (for a horizontal table) or the Y role (for a vertical table). This variable identifies the locations along the axis. You also specify a variable for the VALUE role. This variable determines which values are displayed in the axis table.

You can specify a CLASS variable, which creates a separate row or column for each unique class value. This variable acts as a classification variable for the table.

The **Indent Weight** list box enables you to specify the indent weight (multiplier) for each observation. Select a variable from the list box to provide the multiplier. This option is used in conjunction with the **Indent** option in the axis table’s Properties dialog box. The values for the variable specified here are multiplied with the **Indent** value to compute the indent for each observation.

**TIP** The selected indent weight variable is typically a numeric variable that quantifies the VALUE role.

The **Position** list box enables you to place the axis table at the top or bottom (for a horizontal table) or to the right or left (for a vertical table) of the chart.

In the **Statistic** list box, you can specify the mean or sum for the values in the table.
The following example contains a horizontal axis table and a vertical axis table. The horizontal table, positioned below the plot, aligns with the X axis and shows the mean weight for a group of students. The vertical table, positioned to the right, aligns with the Y axis and provides the student names.

![Student Height and Mean Weight](image)

**Group Options**

A number of plots and charts support one or more of the group options listed here. These plots and charts include the following:

- bar
- needle
- box
- scatter
- density (normal and kernel)
- series
- high-low
- step
- histogram

**Note:** For density and histogram plots, the **Group** option was added in **SAS 9.4M3**.

The following list summarizes the options that are available for grouping data.

**Group Role**

Several types of plots enable you to specify a variable for grouping the data.
For example, in a scatter plot, you might specify a group variable of ORIGIN, where ORIGIN contains values for the country of origin. In this example, the plot marker colors and symbols are different for different countries of origin.

Group Display
When you group the data, you can also specify how the grouped plot elements appear in the graph.

Here are the options:

Cluster
- the plot elements are displayed adjacent to each other.

Overlay
- (all except bar charts) the plot elements for a given group value are drawn at the exact coordinate and might overlap. Each group is represented by unique visual attributes.

Stack
- (bar charts) groups are overlaid without any clustering.

This feature is applicable only when a variable has been assigned to the Group role. In addition, the feature is not available when a discrete offset other than 0 has been specified for the plot.

Cluster Width
For plots that use the CLUSTER group display option, you can assign a cluster width. The cluster width is specified as a ratio of the maximum midpoint spacing. Specify a value from 0.0 (narrowest) to 1.0 (widest).

To access the Cluster Width option, click Advanced Options in the Assign Data dialog box.

Group Order
When you group the data, you can also specify how the grouped plot elements are ordered.

Here are the options:

Data
- displays each group in data order of the group variable.
Ascending
displays each group in ascending group value.

Descending
displays each group in descending group value.

To access the Group Order option, click Advanced Options in the Assign Data dialog box.

Include Missing Group Values
This check box enables you to specify whether missing values of the group variable are included in the plot. The option is available for density (normal and kernel) and histogram plots.

To access this option, click Advanced Options in the Assign Data dialog box.

Note: This feature applies to SAS 9.4M3 and to later releases.

Appearance Options

The following list summarizes the data-driven options that are available for changing the appearance of your plots. Other options are available in a plot’s Properties dialog box.

Discrete Offset
For some plot types, you can specify an amount to offset all plot elements from the discrete tick marks. Specify a value from -0.5 (left offset) to +0.5 (right offset). Scatter plots, series plots, step plots, needle plots, box plots, and bar charts support this feature.

To access the Discrete Offset option, click Advanced Options in the Assign Data dialog box.

TIP You can also select a plot element and drag it to the desired offset position.

This feature is not available when the group display feature has been specified with a value of CLUSTER.
Data Label, Curve Label

You can display the data label for each observation in a scatter plot, and a curve label for a series or a step plot.

For series and step plots, you provide the text that you want to appear next to the plot curve. If you have specified a group variable, then you select a variable for the label.

For scatter plots, you assign the variable that you want to use for labels. If you click Advanced Options, then you can specify the marker position and size.

**TIP** You can replace the markers in a scatter plot with the character values for the specified data label variable. To do this, click Advanced Options. Select Center for the position and 0 for the marker size.

Error Upper, Error Lower

Some plots can display the upper and lower error (or confidence or prediction) limits for the data. You compute these error values in advance as variables in the data set. Then, you assign the variables to the appropriate role for the plot.

You can specify error upper and error lower variables for scatter plots, step plots, and bar error plots. For scatter plots, you can specify the variables for both the X axis and the Y axis. You might need to click the More Variables button to assign these variables to the appropriate roles.

Connect Order

This option is available for plots such as series or step plots. The connect order specifies how to connect the data points to form the step or line. Select X Axis to connect data points as they occur minimum-to-maximum along the X axis. Select X Values to connect data points in the order read from the X variable. X Axis is the default.

To access this option when assigning data for series or step plots, click the Advanced Options button.
Select a Plot

You can select a plot by clicking or right-clicking the plot. You right-click a plot to display a pop-up menu and perform operations on the selected plot, such as assigning data or changing the plot properties.

When you click or right-click a plot, the plot remains in full color. Any other plots in the cell appear dimmed. The following image shows a normal density curve that is selected. The histogram is dimmed.

*Figure 5.3  Normal Density Plot Selected*

If you right-click a plot and select **Plot Properties** from the pop-up menu, the Cell Properties dialog box appears and displays the selected plot in the **Plot** list box. The following display shows the Cell Properties dialog box with the normal density plot selected.
In the example, after you change the properties of the normal plot, you can select the histogram from the **Plot** list box and change the properties for that plot.

The **Assign Data** dialog box behaves in a similar way. When you open the dialog box from a particular plot, the selected plot is the active plot in the dialog box.

---

**Adding Reference Lines to Graphs**

**About Adding Reference Lines**

When you add a reference line to a graph, the line is placed in a location near the cursor. A dialog box appears in which you can specify the position value and other settings. After you add the reference line, you can reposition line.

**ODS Graphics Designer** provides the following types of lines. Each type is identified by a unique icon in the user interface:
### Icon | Description
--- | ---
| | Creates a horizontal reference line that is parallel to the X axis and perpendicular to the Y axis at a Y intercept.
| | Creates a vertical reference line that is parallel to the Y axis and perpendicular to the X axis at an X intercept.
| | Creates a horizontal or vertical drop line from a point to an axis.
| | Creates a straight line that is defined by a point and a slope.

### Add a Reference Line to a Graph

The graph cell in which you add a reference line must already contain at least one plot. The line is overlaid on the plot.

To add a reference line:

1. Add a reference line the same way you would add any other plot. For instructions, see "Add a Plot to a Graph" on page 48.

   **Note:** The line is placed in a location near the cursor.

   The Assign Data dialog box appears.

2. Specify the data parameters for the line. The parameters vary with the type of line that you are adding. Here are the parameters that are specific to each type of line:

   **Note:** The default X and Y settings depend on where the mouse button is released when you add the line.
Horizontal reference line

In the Y text box, specify the Y intercept for the line, or accept the default value.

Vertical reference line

In the X text box, specify the X intercept for the line, or accept the default value.
Drop line

In the X and Y text boxes, specify the coordinates for the point of reference.

From the Drop to list box, select the axis to which the line is dropped. A drop line is drawn perpendicular from the specified point to the X or Y axis.

Line with a specified slope

In the X and Y text boxes, specify the coordinates for the point of reference.

In the Slope text box, specify a slope for the line. A slope value of zero creates a horizontal line that is parallel to the X axis. A slope value of infinity creates a vertical line that is parallel to the Y axis. To create a vertical line, specify a decimal point (.) as the slope.
The line is drawn based on the specified point and the specified slope of the line that passes through that point.

**Note:** You cannot add this type of line to a plot if the plot's axis has date or time values.

3  (Optional) In the **Label** text box, specify a label for the line. This text box is available only for horizontal and vertical reference lines.

4  (Optional) In the **Name** text box, specify a descriptive name for the line.

5  If an X2 or Y2 axis has been associated with one or more plots in the cell, then select that axis from the **Axis** list box in order to associate the line with it.

6  Click **OK**.

---

**Reposition a Reference Line**

After you add a line, you can move the line to a different location. When you position the cursor over the line, the cursor changes to a two-headed arrow \(\uparrow\). You can then click and drag the line to the new location.

For a more precise position, you can use the Assign Data dialog box.

**Note:** You cannot move a sloped line by using the click-and-drag method. You must use the Assign Data dialog box.

To reposition a line by using the Assign Data dialog box:

1  Right-click the line that you want to move, and select **Assign Data**. The Assign Data dialog box appears.

   Alternatively, right-click anywhere in the plot area, and select **Assign Data**. Then, in the Assign Data dialog box, select the line that you want to move from the **Plot** list box.

2  Specify the parameters for the position that you want. For a description of these parameters, see “Add a Reference Line to a Graph” on page 71.
3 Click OK.

**Change the Length of a Drop Line**

When you position the cursor at the tip of a drop line, the cursor changes to a double arrow. You can then click and drag to lengthen or shorten the line.

For a more precise length, you can use the Assign Data dialog box.

1 Right-click the line that you want to modify, and select **Assign Data**. The Assign Data dialog box appears.

   Alternatively, right-click anywhere in the plot area, and select **Assign Data**. Then, in the Assign Data dialog box, select the line that you want to modify from the **Plot** list box.

2 Change the X parameter to modify a horizontal drop line, and the Y parameter to modify a vertical drop line. For a description of these parameters, see “Add a Reference Line to a Graph” on page 71.

3 Click OK.

---

**Remove a Plot from a Graph**

To remove a plot from a graph, right-click the plot that you want to remove and select **Remove Plot 'name'**, where *name* is replaced with the actual name of the plot.

If you remove the wrong plot, click the Undo toolbar button to undo your change.

**Note:** You can also remove a plot by using the Cell Contents dialog box. For more information, see “Manage the Plots and Insets in a Cell” on page 81.
Save a Graph to a File

You can save a graph as follows:

- If you have modified an existing graph and want to save your changes, select File ➤ Save, or click 🗂️ in the toolbar.

- If you have created a new graph that has not yet been saved, select File ➤ Save As, or click 🗂️ in the toolbar. Then, choose a location and file type for the graph that you want to save.

  You can also use this option to save an existing graph using a different filename or file format.

**Note:** To save a graph to a remote server location, select File ➤ Export to Server. This option is available only when you have a connection to a remote server.

You can save a graph as one of the following types of files:

- as an ODS Graphics Designer (SGD) file. The file can later be opened and edited in the ODS Graphics Designer.

  You can also specify the name of the template that is created for the graph. For more information, see “Working with the Graph Code ” on page 79.

- as an image file. Image files can be in TIF, JPG, BMP, GIF, SVG, and PNG file formats. The image file can then be opened in any graphics application that supports the file format.

  When you save the graph as a JPG or a PNG file, you can also select a resolution from the Resolution (in DPI) list box.

- as an Enhanced Metafile (EMF).

- as an HTML file.

  You can also select a target from the Target list box. This feature, used with bar charts that have a URL role specified, determines how to open the linked target. Here are the available targets:
Blank  
(Default) Open the linked document in a new window.

Self  
Open the linked document in the same frame as the graph. This option replaces the graph in the browser.

Top  
Open the linked document in the full body of the window. This option acts like the Self option when the document is already at the top.

Parent  
Open the linked document in the parent frame set. This option acts like the Self option when the document has no parent.

Search  
Open the linked document in the Search pane of the browser, if the Search pane has been enabled.

- as a PDF file.
- as a PostScript (PS) file.

**Add a Graph to the Graph Gallery**

After you have designed a graph, you can add that graph to the Graph Gallery for future reuse.

To add a graph to the Graph Gallery:

1. Select the graph that you want to add.

2. Select **File ➤ Save in Graph Gallery**. The Save in Graph Gallery dialog box appears.
3 From the **Group name** list box, select the name of the group into which you want to add the graph. Each group corresponds to a tab in the gallery.

The **Group name** list box contains the names of groups that have been created at your site. The list box does not contain the names of the default groups.

To create a new group, click the New icon 🚀. In the New Group dialog box, enter the name that you want for the group, and then click **OK**.

4 In the **Graph name** text box, enter the name that you want displayed in the gallery. If a graph exists with the name that you provide, you are prompted to overwrite the existing graph. The default name is NewGraph.

5 The **Icon** field shows a small icon that ODS Graphics Designer creates to represent the graph being added to the gallery. However, if you want to use a custom icon to identify the graph, click **Browse** and locate the image that you want to use. The image can be in BMP, GIF, JPEG, or PNG format. Regardless of its original size, the image is scaled to a fixed size in the gallery.
You can revert to the automatically created icon by clicking the Default button. Automatically generated icons do not show the axis labels, titles, footnotes, and legends; they show only the main part of the graph.

6 In the Tooltip text box, enter a short description of the graph. This description is displayed as a tooltip when you hold the mouse pointer over the graph's icon. If you do not enter a tooltip description, the graph name becomes the tooltip by default.

7 Click OK. The graph is added to the Graph Gallery.

See Also

“Change the Name, Icon, or Tooltip for a Graph in the Graph Gallery” on page 283

Open a Graph

There are three main ways to open a graph SGD file:

- Select File ➤ Open, and then select the file.
- Select File ➤ Open Recent, and then select one of the last few opened files.
  You can control the number of files that appear in the menu. For more information, see “Setting Preferences” on page 272.
- Click the Open button 📋 in the toolbar and then select the file.

Note: To open a graph from a remote server location, select File ➤ Import from Server. This option is available only when you have a connection to a remote server.

Working with the Graph Code

For each graph that you create, the designer provides the code that is used to generate the graph. The code contains the graph template and the SGRENDER procedure that renders the graph.
View, Copy, and Save the Code for a Graph

You can view the SAS code for any of your graphs. You can also copy and paste part or all of the code into a SAS program, and you can save the code as a SAS file.

1. To view the code, select the graph to make it active, and then select View ➤ Code. A window appears and displays the code for the graph.

2. To copy the code, select the portion of the code that you want, and then select Edit ➤ Copy.

   **TIP** To select the entire code, select Edit ➤ Select All.

   You can now paste the code into SAS or into a text editing application.

3. To save the code as a SAS program, select File ➤ Save As. Then specify the location and filename for the code.

4. Select View ➤ Code again to close the code window, or click the Close button in the window.

Change the Name of the Graph Template

The default name for the graph template is SGDESIGN when the graph is created from the Graph Gallery. The default name for new blank graph is GRAPH1, GRAPH2, and so on.

There are two ways to change the template name:

- change the name when you save the graph using the Save As function.
- change the name in the Graph Properties dialog box. To access this dialog box, right-click the graph and select Graph Properties.

The name must start with a letter or underscore. Subsequent characters can be letters, underscores, or numeric digits.
Copy and Paste a Graph to Another Application

You can copy and paste a graph from the ODS Graphics Designer to another application, such as Microsoft Excel or Word. The graph that you paste is an image object.

To copy and paste a graph:

1. Open the graph that you want to copy. If the graph is already open, select it to make it the active graph.

2. Select Edit ➤ Copy. The graph is copied to the system clipboard.

3. Paste the graph into an application by using the application’s paste command.

Manage the Plots and Insets in a Cell

Each cell can contain multiple plots and insets. Plots and insets are rendered in the order in which they are added to a cell as follows:

- Plots are stacked, with the last one added on top.
- Insets (legends and text entries) are always rendered on top of plots. Among themselves, insets and text entries are stacked, with the last one added on top.

You can change the order in which these items are stacked.

For example, suppose that you create a graph with two bar charts, and then add a line. The line was added last, so it appears in front of the bar charts.
Now suppose that you want the line to be in front of the City plot but behind the Highway plot. You can make this change by modifying the cell contents.

To change the order of plots and insets:

1. Right-click in the cell and select **Cell Contents**. The Cell Contents dialog box appears.

   **Note:** The contents of the Cell Contents dialog box vary depending on the plots and insets that are in the graph cell.
There are two main sections in the dialog box:

- The upper panel shows the list of plots that currently exist in the cell. The plots are ordered so that the plot that was added last appears at the top of the list.
- The bottom panel shows the list of insets such as legends and entries. These items are always rendered on top of the plots, but are ordered among themselves. The item that was added last appears at the top of the list.

2 To move an item up or down in the list, select the item and then click the Move Up \( \uparrow \) or Move Down \( \downarrow \) arrow.
   
   In the example, you would move the Highway item up so that it is on top.

3 To delete an item, select the item and then click the Delete \( \times \) icon.
4 If applicable, select the Top or Bottom tab and make changes there.

The Top or Bottom tab is available when the cell contains a block plot that is positioned in the top or bottom margin of the graph. On these tabs, you can move or delete plots.

5 When you are finished making changes, click OK.

In the example, the line is in front of the City plot but behind the Highway plot.

Figure 5.6  Line Is between the Plots
Generating Bulk Graphs Automatically

Overview of Auto Charts

About Auto Charts
The Auto Charts feature enables you to create graphs in bulk from a list of variables. Using the Auto Charts feature, you can easily generate a variety of graphs based on your data and the graph types that you specify. After generating the graphs, you can choose one or more graphs as the starting point for further enhancement. For example, you can modify the automatically generated titles and legends. You can also add more plots and other items to a graph.

The Auto Charts feature is ideal for exploring different visualizations of your data. You can generate a series of graphs and then choose the ones that best visualize the
information. If you are not satisfied with the graphs, you can change a few parameters and generate another set of graphs.

By default, these graphs are saved to a temporary file, which is available within the designer’s SAS session. The file is deleted when the SAS session terminates. However, you can set a preference to store the graphs permanently in a user-defined location. The graphs remain in that location until you delete them.

You can save any of the generated graphs as images, as HTML files, or as ODS Graphics Designer files (SGD) that you can later edit.

**The Auto Charts Window**

To display the Auto Charts window, select **Tools ➤ Auto Charts**.
The following example shows an Auto Charts window that has been populated with data and graphs.

**Figure 6.1** Example Auto Charts Window

The Auto Charts window contains three main panes in which you can perform the tasks that are associated with Auto Charts:

**Top pane**
- specify the SAS library and data set for your graphs.

**Left pane**
- select one or more variables for your graphs and specify the type of charts that you want to generate. Then you can generate the charts.
For more information, see “Generate Auto Charts” on page 88.

**TIP** The left and right panes are resizable.

Right pane

Displays the graphs that are generated by the tool. You can open and customize one or more graphs. You can modify various properties and make minor changes to the data. You can also add plots and cells to a graph. If you decide not to use the graphs, you can delete them and generate new ones. You can save any of the generated graphs as images or in other formats, including an ODS Graphics Designer file (SGD) that you can later edit.

For more information, see “Working with the Generated Graphs” on page 91.

---

**Generate Auto Charts**

To generate Auto Charts:

1. Select **Tools ▶ Auto Charts**. The Auto Charts window is displayed. For a brief overview of this window, see “The Auto Charts Window” on page 86.

   By default, the window displays the SAS library and data set that was last used in this session of the Designer.

2. If necessary, specify in the top pane the SAS library and data set that you want to use for the charts. Select the appropriate items from the **Library** and **Data Set** list boxes.

   If you have already generated charts for the specified data, the charts might be displayed in the right pane. (For more information, see “Saving the Auto Charts” on page 93.)

   The left pane displays information about the variables in the specified data set.
The left pane contains a columnar list with three columns, as shown in the following example:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Details</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>19</td>
<td>Discrete</td>
</tr>
<tr>
<td>SEX</td>
<td>2</td>
<td>Discrete</td>
</tr>
<tr>
<td>AGE</td>
<td>11 - 16</td>
<td>Continuous</td>
</tr>
<tr>
<td>HEIGHT</td>
<td>51.3 - 72</td>
<td>Continuous</td>
</tr>
<tr>
<td>WEIGHT</td>
<td>50.5 - 150</td>
<td>Continuous</td>
</tr>
</tbody>
</table>

The columns contain the following information:

- **Variable** displays the name of each variable in the data set.
- **Details** provides more detail about the variable values. Character variables and discrete numeric variables display the value count for the variable. Continuous numeric variables display the range of the value. Variables that have a TYPE=ANY setting display the count as well as the range.
- **Type** displays the data type. Data types include CONTINUOUS, DISCRETE, TIME, and ANY. The ANY value enables the variable to apply any of the data types that it supports.

3. Select the check box for each variable that you want to include in your graphs.

**TIP** It is helpful to start with three or four variables. Selecting more variables creates more graphs, and the combinations can grow rapidly.

4. If applicable, change the data type for a variable. You would change the data type if the current data type is not appropriate for the graphs that you want to generate.

You can change the data type if a small triangle appears next to the data type. Click the arrow and select the type that you want from the drop-down list box.
In the following example, the type for the variable HEIGHT is changed from CONTINUOUS to DISCRETE. After the change, the Details section changes to show the value count. In this case, HEIGHT has 17 different values.

### Selecting a Different Type

<table>
<thead>
<tr>
<th>Variable</th>
<th>Values</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGE</td>
<td>11 - 16</td>
<td>Continuous</td>
</tr>
<tr>
<td>HEIGHT</td>
<td>11.3 - 72</td>
<td>Continuous</td>
</tr>
<tr>
<td>WEIGHT</td>
<td>50.5 - 150</td>
<td>Continuous</td>
</tr>
</tbody>
</table>

### New Details for the Type

<table>
<thead>
<tr>
<th>Variable</th>
<th>Values</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGE</td>
<td>11 - 16</td>
<td>Continuous</td>
</tr>
<tr>
<td>HEIGHT</td>
<td>17</td>
<td>Discrete</td>
</tr>
<tr>
<td>WEIGHT</td>
<td>50.5 - 150</td>
<td>Continuous</td>
</tr>
</tbody>
</table>

---

5 Specify which types of graphs to create by selecting one or more check boxes.

- **Univariate**: generates frequency or distribution charts for the selected variables.
- **Bivariate**: generates plots for the different variable crossings.
- **Grouped**: generates plots or charts with grouped data. At least three variables must be selected in order to select the Grouped check box. One of those variables must be a character variable or a discrete numeric variable with a type of DISCRETE or ANY. The variable should have fewer than 10 unique values. If there are too many values, grouped graphs are not generated.
- **Advanced Plots**: generates more complex plots and charts. The graphics can include overlays, fit plots, and multi-cell graphs.

You can select any combination of check boxes. Selecting more check boxes increases the number of graphs that are generated.

6 Click **Generate Graphs**.

A status bar is displayed showing the progress of the process. You can interrupt the process at any time.
The graphs are generated, and their icons appear in the right pane.

You can open and customize one or more graphs. For more information, see “Working with the Generated Graphs” on page 91.

If you decide not to use these graphs, you can generate new ones. Follow these steps:

1. Repeat any of the previous steps to modify your input variables and graph types.
2. In the right pane, click **Delete All** to delete the existing graphs.
3. Click **Generate Graphs** to generate a new set of graphs.

---

**Working with the Generated Graphs**

Here is a partial view of the right pane of the Auto Charts window.

![Graph Examples](image)

From this pane, you can open, save, and delete graphs. To use the **Open**, **Save As**, and **Delete** buttons, you must first select one or more graphs.

To select multiple graphs:

- Press and hold the Ctrl key and select the graphs that you want.
- To select a block of contiguous graphs, select the first graph in the block, press the Shift key, and then select the last graph in the block.
You can use the following buttons to toggle between small and large graph icons. By default, large icons are displayed.

The graphs in the Auto Chart Gallery are like the graphs in the Graph Gallery. You can open any graph and customize it. For example, you can modify various properties and reassign the variables. You can also add plots and cells to a graph. When you are finished making changes, you can save the graph as you would any graph created in the Designer.

To customize a graph, right-click and choose an action from the pop-up menu.

For more information about the tasks that you can perform, see “High-Level Steps for Designing Graphs” on page 43.
Saving the Auto Charts

Automatically Storing Auto Charts

By default, the dynamically generated graphs are created and stored in a temporary folder. The Auto Charts feature creates a subfolder for each data set that is used to generate graphs.

For example, if you generate Auto Chart graphs using the SASHELP.CLASS data set, then a folder named SASHELP.CLASS is created within the temporary folder. The SASHELP.CLASS folder contains all of the SGD files for your generated graphs. If you close and later reopen the Auto Charts window and select the SASHELP.CLASS data set, those graphs are displayed in the window. The folder and graphs persist as long as the Designer session is active.

You can set a preference to store the graphs permanently in a user-defined location. The graphs remain in that location until you delete them.

See “Setting Preferences” on page 272 for the following information:

- the location of the temporary folder
- instructions about setting the preference

Saving Auto Charts to a Specified File Location

You can save any of the generated graphs as images or in other formats, including an ODS Graphics Designer file (SGD) that you can later edit. When you save a graph, you specify the file location as well as the file type.

1. Select one or more graphs that you want to save. All selected graphs are saved to the same location.

2. Click Save As. The Save As dialog box is displayed.
3 Specify the file type. Some types, such as PNG files, enable you to specify other parameters such as resolution. For descriptions of the different types, see “Save a Graph to a File” on page 76.

4 If necessary, click **Browse** and select a location for the graphs.

   If you have set a preference to store the graphs automatically in a user-defined location, then that location is shown by default in the dialog box. Or, if you have previously saved an automatically generated chart, then the dialog box displays that same location.

5 Click **OK**.
About Titles and Footnotes

You can add multiple titles and footnotes to a graph. The limit to the number of titles or footnotes that you can add depends on the size of your graph. As you add more titles or footnotes, the Y axis of the graph shrinks proportionally to the point where the graph is no longer visible.

When you add a long title or footnote to a graph, the text automatically wraps to the next line. If you re-align a title or footnote in the graph, all of the lines of a single title or footnote move as one unit.
Add a Title or a Footnote

If you created the graph from the Graph Gallery, then your graph might already have title and footnote placeholders. You can edit the title or footnote in order to change its text. See “Edit and Format a Title or Footnote” on page 96.

If you created the graph from a blank graph, or if you want to insert an additional title or footnote, follow these steps:

1. Select one of the following options:
   - To add a title, select **Insert ▶ Title**, or click in the toolbar. A new title text box is added above the graph. If one or more titles already exist, the new title is added below the others. Here is an example title that is added to the graph.
     
   ![Type in your title...](image)
   
   - To add a footnote, select **Insert ▶ Footnote**, or click in the toolbar. A footnote text box is displayed in the bottom left corner of the graph.
     
   ![Type in your footnote...](image)

2. In the title or footnote text box, enter the text that you want.

3. (Optional) Repeat the previous steps to add another title or footnote.

Edit and Format a Title or Footnote

If you want to edit only the text of a title or footnote, the ODS Graphics Designer provides a quick way to do this.

To edit the text of a title or footnote:
1 Double-click the existing text.

2 Enter the text that you want.

If you want to edit and format the text, you must use the Text Properties dialog box.

To edit and format a title or footnote:

1 Perform one of the following steps:
   - To edit a title, right-click the title and select **Title Properties**.
   - To edit a footnote, right-click the footnote and select **Footnote Properties**.

   The Text Properties dialog box appears. Here is an example dialog box for titles.

   ![Text Properties Dialog Box](image)

2 Select all or part of the text in the **Text entry** box. Then enter your changes.

3 You can format the text by applying a different style element or by setting explicit text properties. For more information, see “**Text Properties**” on page 147.

4 Click **OK**.
See Also

- “Specifying Style Elements for Text Properties” on page 113
- “Using the Color List Box” on page 115

## Align a Title or Footnote Horizontally

To align a title or footnote:

1. Perform one of the following steps:
   - To align a title, right-click the title, and select **Title Properties**.
   - To align a footnote, right-click the footnote, and select **Footnote Properties**.
     The Text Properties dialog box appears.

2. Select **Left**, **Center**, or **Right** from the **Position** list box.

3. Click **OK**.

## Remove a Title or Footnote from a Graph

To remove a title or footnote:

- Right-click the title and select **Remove Title**.
- Right-click the footnote and select **Remove Footnote**.

**Note:** To undo the change, select **Edit ▶️ Undo** from the main menu.

An alternative method is to double-click the title or footnote and press the Delete key.
Working with Legends

Adding Legends ................................................................. 99
  About Legends ................................................................. 99
  Add a Cell Legend ............................................................... 100
  Add a Global Legend to a Graph ........................................... 100

Change the Contents of a Legend .......................................... 102

Edit a Legend's Labels .......................................................... 103

Add a Title to a Legend ........................................................ 104

Change a Legend's Outline or Background Color ....................... 106

Arrange Legend Contents in a Row or Column ......................... 107

Reposition a Legend ............................................................ 108

Remove a Legend ................................................................. 108

Adding Legends

About Legends

A graph can have multiple legends. There are two main categories of legends:
Cell legend
applies to the plots within a cell. By default, a cell legend contains all plots in the cell. There are two types of cell legends:

- You can add a discrete legend to any of the cells in a graph. A discrete legend is created within the cell.
- If the plot is a contour plot with a contour type of fill or gradient, then you can add a gradient legend to the cell. A gradient legend appears alongside the contour plot.

Global legend
applies to all cells in a multi-cell graph. You specify which plots you want in the legend when you create the legend.

A global legend is a discrete legend. It does not display the legend for a gradient plot, such as a filled contour.

Add a Cell Legend
To add a legend to a cell, click and drag the appropriate legend icon from the \textbf{Insets} panel to the cell.

\begin{itemize}
  \item To add a discrete legend, click and drag the Discrete Legend icon to the cell. The legend is placed near the location where the icon was dropped. By default, all plots in the cell are displayed in the legend.
  \item If the plot is a contour plot with a contour type of fill or gradient, then click and drag a Gradient Legend icon to the cell. The gradient legend is displayed on the right side of the cell.
\end{itemize}

You can also right-click inside a graph cell and choose \textbf{Add an Element}. Then click the legend icon from the \textbf{Elements} pop-up window.

Add a Global Legend to a Graph
A global legend applies to all the cells in the graph. You specify which plots you want in the legend when you create the legend.
To add a global legend to a graph:

1. Select **Insert ➤ Global Legend**, or click in the toolbar. The Global Legend dialog box appears. The dialog box contains a list of all the plots and lines in all the cells of the graph.

![Global Legend dialog box](image)

2. Select the check box next to each plot that you want to include in the legend. If you have multiple plots and want to include all plots, select the check box in the heading of the first column.

3. To edit a label, do the following:
   
   a. Double-click the label.
   
   b. Enter the text that you want.

   You can edit a label if a small triangle 🔄 appears next to the label. When the **Edit Legend Label** contains the text *Group Values* for a plot, the values included in the legend come from a group variable and cannot be edited.

4. Specify the order in which plots appear in the legend as follows:
   
   a. Click a plot name to select it.
   
   b. To move the plot up or down in the list, click the Move Up ⬆️ or Move Down ⬇️ arrow.
5 Click **OK**. The legend appears at the bottom of the graph. To move the legend, see “Reposition a Legend” on page 108.

---

**Change the Contents of a Legend**

After you create a legend, you can change the contents of the legend. The procedure is the same for both global and discrete cell legends. This feature is not available for gradient legends.

To change the contents of a legend:

1. Right-click the legend, and then select **Legend Contents**. The Legend Contents dialog box appears.

   ![Legend Contents Dialog Box](image)

2. Select the check box next to each plot that you want to include in the legend. If you have multiple plots and want to include all plots, select the check box in the heading of the first column.

3. To edit a label, do the following:
   
   a. Double-click the label.

   b. Enter the text that you want.
You can edit a label if a small triangle ▶ appears next to the label. When the Edit Legend Label contains the text Group Values for a plot, the values included in the legend come from a group variable and cannot be edited.

4 Specify the order in which plots appear in the legend as follows:

a Click a plot name to select it.

b To move the plot up or down in the list, click the Move Up ▲ or Move Down ▼ arrow.

5 Click OK.

---

**Edit a Legend's Labels**

You can change the labels that identify the plots in a legend.

There are two ways to change legend labels:

- Change the label by using the Legend Contents dialog box.

  1 Right-click the legend, and then select **Legend Contents**. The Legend Contents dialog box appears.

    **Note:** This option is not available for gradient legends.

  2 To edit a label, do the following:

    a Double-click the label.

    b Enter the text that you want.

    You can edit a label if a small triangle ▶ appears next to the label.

  3 Click OK.

- Change the label by using the Cell Properties dialog box.
This option is useful when you are changing plot properties and want to edit the legend label for one or more plots at the same time.

1. Right-click a plot, and then select **Plot Properties**. The Cell Properties dialog box appears.

2. Make sure that the **Plots** tab is active.

3. In the **Plot** list box, make sure that the plot whose label you want to change is selected.

4. In the **Legend Label** text box, enter the text that you want.

5. To change the label for another plot, select the plot from the **Plot** list box and repeat the previous step.

6. Click **OK**.

---

**Add a Title to a Legend**

To add a title to a legend:

1. Right-click the legend, and then select **Legend Properties**. The Legend Properties dialog box appears.
2 In the **Legend Title** text box, enter the title that you want.

3 You can format the title text by selecting from the options available in the **Title Text Appearance** portion of the dialog box. You can apply a different style element or set explicit text properties.

4 Click **OK**.

See Also

- “Specifying Style Elements for Text Properties” on page 113
- “Using the Color List Box” on page 115
Change a Legend's Outline or Background Color

To change a legend's outline or background color:

1. Right-click the legend, and then select **Legend Properties**. The Legend Properties dialog box appears.
2 Select or clear the Fill and Outline check boxes to toggle the legend's fill and outline on and off. When a check box is selected, you can select a color from the drop-down list box. For more information, see “Using the Color List Box” on page 115.

3 Click OK.

---

**Arrange Legend Contents in a Row or Column**

To arrange a legend's contents in a row or a column:

1 Right-click the legend, and then select Legend Properties. The Legend Properties dialog box appears.

2 Select one of the following:

**Automatic**
- enables the designer to determine the best size and wrapping for the legend.

**Across**
- extends the legend across in a row. You might need to increase the wrap size for the legend to fit in the row.

**Down**
- extends the legend down in a column. You might need to increase the wrap size for the legend to fit in the column.

3 If you selected Across or Down, click the Wrap Size arrow control to expand or reduce the size of the legend row or column.

4 Click OK.
Reposition a Legend

To reposition a legend:

1 Right-click the legend, and then select **Legend Properties**. The Legend Properties dialog box appears.

2 Select a position for the legend from the **Position** list box.

   Here are the position choices for discrete legends. These choices refer to positions within the cell:

   - left  top right
   - right bottom left
   - center bottom right
   - top left automatic

   **Note:** The automatic option positions the legend where there is the most room.

   Here are the position choices for global legends:

   - left  top
   - right bottom

3 Click **OK**.

Remove a Legend

To remove a legend, right-click the legend, and then select **Remove Legend**.
Add a Text Entry to a Graph

You can annotate a graph by adding text entries. Each cell in a graph can have one or more text entries.

To add a text entry to a graph:

1. Click and drag the Text Entry icon from the Insets panel to the cell. Drag the icon to the approximate area within the cell where you want the text entry.

   The Text Entry icon looks like this: T

   You can also right-click inside a graph cell and choose Add an Element. Then click the Text Entry icon from the Elements pop-up window.

   The following text box is displayed within the cell.
2 In the text box, enter the text that you want.

3 (Optional) Repeat the previous steps to add additional text entries.

It is possible to add text entries on top of each other. When this happens, reposition one or more entries. For instructions about changing the position of a text entry, see “Reposition a Text Entry” on page 111.

---

**Edit and Format a Text Entry**

If you want to edit only the text of a text entry, the ODS Graphics Designer provides a quick way to do this.

To edit the text of a text entry:

1 Double-click the existing text.

2 Enter the text that you want.

If you want to edit and format the text, you must use the Text Properties dialog box.

To edit and format a text entry:

1 Right-click the entry and select **Entry Text Properties**.

   The Text Properties dialog box appears.
2 To change the text, select all or part of the text in the Text entry box. Then enter your changes.

3 You can format the text by applying a different style element or by setting explicit text properties.

4 Click OK.

See Also

- “Specifying Style Elements for Text Properties” on page 113
- “Using the Color List Box” on page 115

Reposition a Text Entry

You can position a text entry in one of several locations within the cell.

To reposition a text entry:
1 Right-click the entry and select **Entry Text Properties**.
   The Text Properties dialog box appears.

2 Select the position that you want from the **Position** list box.
   Here are the position choices:
   - top
top left
   - bottom
   - top right
   - bottom left
   - bottom right
   - center

3 Click **OK**.

---

**Remove a Text Entry from a Cell**

To remove a text entry, right-click the entry and select **Remove Text Entry**.

The text entry is removed from the cell.
Specifying Style Elements for Text Properties

The color schemes and visual attributes for a graph come from the active ODS Style. ODS styles consist of style elements, and each style element has its own attributes. When you format text properties, you often have the option to specify a style element. For example, you can select a style element when you change the properties of titles, footnotes, and other textual items.

The visual properties of the item that you format are obtained from the style element that you specify. The following display shows the default style element for a title.
The style element determines the specific attributes of the title, such as the font color and size. The default value for those attributes is Auto. The Auto setting indicates that the value is derived from the selected style element. If you select a different style element, the Auto attributes change.

In the example, you can select another style element from the list, or you can specify the font attributes explicitly. You specify explicit attributes by selecting a value other than Auto from the list boxes.

**Note:** When you explicitly change an item’s attributes, the change persists regardless of the style. If you later change the style element or the style applied to the graph, any explicit settings that you have specified override the new style element or style. You can revert to the original Auto setting if desired.

You can also create a custom style and modify the style elements that are contained in that style. The modified style elements are used every time you apply the custom style to a graph.

See Also

“Style Elements Used in ODS Graphics Designer” on page 206
Using the Color List Box

When you specify various graph, legend, or title properties, you might have the option to select a color. This option opens a Color list box.

The Color list box provides colors to choose from and the option to define your own color.

The Color list box contains the following items:
**Auto** or **Group** value
restores the default color. This option is useful when you have changed a color and want to restore the original color.

The **Auto** value indicates that the value is derived from a style element. This value is not available for legend fill and outline.

The **Group** value is used for plot properties. The **Group** value indicates that the value is derived from a group variable if one has been defined for the plot.

**Palette of colors**
selects a predefined color from the palette.

**Row of recently used custom colors**
selects a custom color. This row is populated with colors that you choose after you click the **More Colors** option.

**More Colors** option
enables you to locate a custom color. This option opens the More Colors dialog box, which contains two tabs:
In the Custom tab, choose a color by dragging the slider and then clicking inside the color preview box. Alternatively, you can specify the HSB, RGB, or hexadecimal color value.

Adding Dynamic Content to Text

About Dynamic Content

You can insert dynamic content into textual elements such as titles and footnotes. The dynamic content is substituted when you run the graph using the SGDESIGN procedure.

You can specify dynamic content in the following textual elements:

- titles
- footnotes
- text entries
- cell headers
- axis labels

Specify Dynamic Content

Here is the form that you use to specify dynamic content:
where \textit{DNAME} is a name that you want to associate with the text that is generated.

**Note:** \textit{DNAME} follows SAS naming conventions. The name cannot contain any special character other than “_”. In addition, \textit{DNAME} must start with an alphabetic character.

After you have saved the graph, you can generate the graph using the \texttt{SGDESIGN} procedure. In the \texttt{SGDESIGN} procedure, you specify the value for \textit{DNAME} with a \texttt{DYNAMIC} statement. When you generate the graph, the \texttt{SGDESIGN} procedure substitutes \texttt{dyn(DNAME)} with the value that you specified for \textit{DNAME}.

For example, suppose that you want the title of a graph to vary by year. In ODS Graphics Designer, you might specify the following title: “Revenues for \texttt{dyn(YEAR)}.”

When you run the graph using the \texttt{SGDESIGN} procedure, you can specify \texttt{DYNAMIC year=“2009”}. The entire string \texttt{“dyn(YEAR)”} is replaced with the specified value. In the resulting graph, the title becomes “Revenues for 2009”.

See Also

- “Example: Create a Shared-Variable Graph and Add a Dynamic Title” on page 317
- “About the \texttt{SGDESIGN} Procedure” on page 5
Part 3

Changing the Appearance of Graphs

Chapter 11
Changing Graph Properties .................................................. 121

Chapter 12
Changing Plot Properties ..................................................... 135

Chapter 13
Changing Axis Properties .................................................... 173

Chapter 14
Customizing Graph Styles ................................................... 193
Changing Graph Properties

About Graph Properties .................................................. 121

Change General Graph Properties .................................. 122

Change Group Attributes .................................................. 125

Understanding Attribute Priority ..................................... 128

Subpixel Rendering ......................................................... 129

Change the Style That Is Applied to a Graph ......................... 130

Resize a Graph .............................................................. 132

About Graph Properties

Graph properties control the overall appearance of your graph and affect all plots and cells in the graph. The Graph Properties dialog box organizes these properties into the following main categories.

- general properties, which include the ODS style, graph size, border and color of the graph's background, and other properties
- group attributes, which enable you to change the appearance of attributes for group values.
To change the general properties of a graph:

1. Right-click the graph and select **Graph Properties**. The Graph Properties dialog box appears.

2. Make the changes that you want for the graph. For more information, see the list that follows these steps.

3. Click **OK**.
Template

To change the template name, enter a different name in the text box. The name must start with a letter or underscore. Subsequent characters can be letters, underscores, or numeric digits.

This name identifies the underlying graph template that is used for the graph. (For each graph that you create, the designer provides the code that is used to generate the graph. The code contains the graph template and the SGRENDER procedure that renders the graph.)

The default name for the graph template is SGDESIGN when the graph is created from the Graph Gallery or by using the Auto Charts feature. The default name for a new blank graph is GRAPH1, GRAPH2, and so on.

**TIP** You can also change the name when you save the graph using the Save As function.

Style

To change the style, select a different style from the list box. This option is not available for new blank graphs or blank shared variable graphs.

**TIP** As an alternative to this method, you can select Format ➤ **Style**, and then select the style that you want from the cascading menu. For more information, see “Change the Style That Is Applied to a Graph” on page 130.

Data Skin

Select a data skin from the list box. The data skin applies a special effect for rendering the graphics elements. The following images show the skins that are available.

<table>
<thead>
<tr>
<th>Table 11.1</th>
<th>DATASKIN Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>NONE</td>
<td>CRISP</td>
</tr>
<tr>
<td><img src="image" alt="NONE" /></td>
<td><img src="image" alt="CRISP" /></td>
</tr>
</tbody>
</table>
The default data skin that is applied to your charts is determined by your preference. For more information, see “Setting Preferences” on page 272.

This option is not available for new blank graphs or blank shared variable graphs.

**Background**
You can control whether the border around a graph is displayed. You can also change the color of the graph’s background.

To change background color, select a color from the **Color** list box. For instructions, see “Using the Color List Box” on page 115.

**Note:** A value of **Auto** indicates that the color is derived from the current style. When you change the style, the background color changes accordingly. However, if you explicitly change the color, the color that you specify overrides any style that is applied to the graph.

Select or clear the **Outline** check box to turn the graph border on or off.

**Size**
To change the graph size, click the up and down arrows in the **Width** and **Height** list boxes. The width and height are measured in pixels. Clicking an arrow changes the value by 10 pixels. Your graph becomes larger or smaller depending on which values you select.

Alternatively, you can enter values in the boxes.

To resize the graph proportionally, make sure that the **Keep Aspect Ratio** check box is selected. If you want to specify the width and height independently without retaining the current aspect ratio, then clear the check box.

**TIP** To determine the size in inches, you can compute the value in pixels by using a default DPI of 100. For example, if you want a width of five inches, then specify a width of 500 pixels.
**Common Axis**

Select or clear a check box to share or unshare a common row or column axis. For more information, see “Sharing or Unsharing a Common External Axis” on page 231.

**Subpixel**

Select the check box in order to generate smooth curves and more precise bar spacing. Subpixel rendering is available for line-based plots and bar charts. For more information, see “Subpixel Rendering” on page 129.

---

**Change Group Attributes**

When you apply a group role to your graph, by default the designer rotates through the GraphData style elements for the presentation of each unique group value.

To change the default appearance, you can specify attributes for group values. You can also change the number of attributes that are rotated.

You can change the following attributes:

- **colors**: specify the fill colors for the graphics elements.
- **contrast colors**: specify the contrast colors for the graphics elements, such as lines and markers.
- **line patterns**: specify the list of line patterns for the graph data lines.
- **marker symbols**: specify the marker symbol for the graph data.

These changes override the corresponding defaults from the current style. The appearance options affect only the graph that you are modifying.

You can also change the attribute priority that determines the rotation pattern.

To change the group attributes of a graph:

1. Right-click the graph and select **Graph Properties**. The Graph Properties dialog box appears.
2. Click the **Group Attributes** tab.
3 To change the attribute priority attribute, select the attribute from the **Attr Priority** list box.

For more information, see “Understanding Attribute Priority” on page 128.

**Note:** You can specify the default attribute priority for all graphs when you change preferences. For more information, see “Setting Preferences” on page 272.

4 Select the graphics element that you want to modify from the **Type** list box.

5 Do any of the following

- Click **From Style**. A list of attributes from the current style is displayed. These are the default attributes that you want to change.
For example, if you are changing group attributes for fill colors, the list resembles the display here.

Every item in the list corresponds to a GraphData style attribute. You are not limited to the number of attributes that are displayed. You can remove or add attributes to obtain the desired rotation pattern.

- To change any attribute listed, select the value that you want from the list box.
- To add an attribute, click 🌟. A new attribute is added at the bottom of the list. You can change this attribute by selecting a different value from the list box.
- To delete an attribute, select the attribute and click ✗.
  
  To delete all of the attributes, click **Delete All**.

- To change the order in which the attributes are applied, select an attribute and click the ↑ or ↓ arrow to move the attribute up or down in the list.

6 Repeat steps 4 and 5 for every graphics element that you want to modify.

7 Click **OK**.
Understanding Attribute Priority

When you apply a group role to your graph, by default the designer rotates through the GraphData style elements for the presentation of each unique group value. You can change the attributes that are applied to your group values.

When the graph is rendered, the attributes for colors, line patterns, and marker symbols are cycled for the values in your group. Whether you change the attributes or keep the defaults, the manner in which the graphics elements are combined is determined by the attribute priority.

Note: You can change the attribute priority for a graph in the graph’s Properties dialog box. You can specify the default attribute priority for all graphs when you change preferences.

You have three options for the attribute priority.

- **Color** marker symbols and line patterns are held constant while each color in the list is applied to the marker symbol or line.
- **None** each attribute cycles through its own list to generate a unique combination for each group.
- **Auto** the attribute priority is determined by the active ODS style.

For example, suppose that you specify three contrast colors for markers and two line patterns. The colors are red, green, and blue (in that order). The line patterns are dotted and solid.

First, you specify **Color** for the attribute priority. The dotted-line pattern is held constant while the procedure applies red, green, and blue colors to the dotted lines for the consecutive group values. If there are more group values, the options apply the red, green, and blue colors to solid lines.
The following figure shows an example rotation for an age grouping.

![Age Grouping Example](image)

To change the rotation pattern in the previous example, specify **None** for the attribute priority. Now, the contrast colors and line patterns are cycled at the same time.

A red, dotted-line pattern is applied for the first group crossing, a green, solid-line pattern is applied for the second, a blue, dotted-line pattern is applied for the third, and so on.

The following figure shows the rotation for the age grouping with no priority rotation.

![Age Grouping Example](image)

### Subpixel Rendering

You can specify subpixel rendering in order to generate smooth curves and more precise bar spacing. Subpixel rendering is available for line-based plots and bar charts.

To enable subpixel rendering, select the **Subpixel** check box in the Graph Properties dialog box.

By default, curved lines can appear slightly jagged. The following partial graph images show the effect of applying subpixel rendering on curved lines.

<table>
<thead>
<tr>
<th>Table 11.2 Effect of Subpixel Rendering on Curves</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Subpixel Off" /></td>
</tr>
</tbody>
</table>

---
In the previous example, the subpixel rendering produces smoother lines.

Subpixel rendering is also available for bar charts. When charts have a large number of bars that are very close together, slight variations in spacing between the bars that occur due to integer rounding can become more obvious. For more precise bar spacing, enable subpixel rendering.

**Table 11.3  Effect of Subpixel Rendering on Spaces between Bars**

<table>
<thead>
<tr>
<th>Subpixel Off</th>
<th>Subpixel On</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Subpixel Off Chart]</td>
<td>![Subpixel On Chart]</td>
</tr>
</tbody>
</table>

---

**Change the Style That Is Applied to a Graph**

ODS styles control the default color schemes and visual attributes for a graph. You can change the overall appearance of a graph by changing the applied style.

To change the style:
1 Right-click the graph and select **Graph Properties**. The Graph Properties dialog box appears.

2 To change the style, select a different style from the available styles in the **Style** list box.

3 Click **OK**.

As an alternative to this method, you can select the graph, select **Format** ▶ **Style**, and then select the style that you want from the cascading menu.
Note the following about choosing a style from this menu:

- There is a check mark next to the current style.
- The menu lists the five most recently used style names.
- The default style is listed within < > brackets.
- You can select More Styles to choose from more styles.

Note: This option is not available for new blank graphs or blank shared variable graphs.

You can change the style that is applied to your graphs by default. For instructions, see “Setting Preferences” on page 272.

## Resize a Graph

To change the size of a graph:

1. Right-click the graph and select **Graph Properties**. The Graph Properties dialog box appears.
2 In the **Size** section of the dialog box, click the up and down arrows in the **Width** and **Height** list boxes. The width and height are measured in pixels. Clicking an arrow changes the value by 10 pixels. Your graph becomes larger or smaller depending on which values you select.

Alternatively, you can enter values in the boxes.

To resize the graph proportionally, make sure that the **Keep Aspect Ratio** check box is selected. If you want to specify the width and height independently without retaining the current aspect ratio, then clear the check box.
To determine the size in inches, you can compute the value in pixels by using a default DPI of 100. For example, if you want a width of five inches, then specify a width of 500 pixels.

3 Click **OK**.

**Note:** You can change the size that is used by default for all new graphs. For more information, see “Setting Preferences” on page 272.
Changing Plot Properties

About Plot Properties ........................................................................................................ 136
  Overview of Plot Properties ............................................................................................ 136
  Properties That Have Auto or Group Values .................................................................... 136

Change Plot Properties ................................................................................................... 137

Specifying Style Elements for Plot Properties ................................................................ 139

General Properties .......................................................................................................... 141
  About General Plot Properties ....................................................................................... 141
  Line Properties ............................................................................................................... 142
  Fill and Outline Properties ............................................................................................ 143
  Marker Properties .......................................................................................................... 145
  Text Properties ............................................................................................................... 147
  About Splitting Labels .................................................................................................... 148

Plot-Specific Properties .................................................................................................. 149
  About Plot-Specific Properties ....................................................................................... 149
  Scatter Properties .......................................................................................................... 150
  Series, Needle, and Step Properties ............................................................................... 151
  Histogram Properties ...................................................................................................... 153
  Box Properties ............................................................................................................... 154
  Bar and Bar Error Properties ......................................................................................... 155
  Band Properties .............................................................................................................. 157
  Vector Properties ........................................................................................................... 158
  Contour Properties ........................................................................................................ 159
### About Plot Properties

#### Overview of Plot Properties

ODS styles control the default appearance of the plots in a graph. The ODS styles are optimized to produce effective graphics without any changes to the default settings. However, you can override the default style settings by changing plot properties.

Plot properties determine features, such as lines and markers, that affect the appearance of the plots in a graph. These properties include the following items:

- lines, outlines, and fills
- markers
- text
- miscellaneous plot-specific properties
- the plot area (wall) color for the cell

#### Properties That Have Auto or Group Values

Depending on the plot, the initial value for a property might be shown as **Auto** or **Group**.
- **Auto** indicates that the value is derived from the selected style element. If you select a different style element, the Auto properties change. For more information, see “Specifying Style Elements for Plot Properties” on page 139.

- **Group** indicates that the value is derived from the group variable if one has been defined for the plot.

You can explicitly change these settings by selecting a value other than **Auto** or **Group** from the list boxes. The attributes that you specify override the attributes that are derived from the applied style element. After you change a value, you can later revert back to the original **Auto** or **Group** value if desired.

---

**Change Plot Properties**

1. Right-click anywhere within the plot area of the graph cell that contains the plot or plots that you want to modify. Select **Plot Properties**.

   **Note:** Alternatively, right-click directly on the plot to modify just that plot. When you click or right-click a plot, the selected plot remains in full color. Any other plots in the cell appear dimmed.

   The Cell Properties dialog box appears with the **Plots** tab displayed. This tab varies with the type of plot.

2. Make sure that the **Plot** list box displays the plot that you want to modify. If necessary, select a different plot from the list box.

   The **Plot** list box contains the names of all the plots in the cell. In the previous step, if you clicked directly on one of the plots, that plot is selected in the list box.

3. Select or clear the **Use Data Skin** check box, if it is available. The data skin applies a special effect to be used on filled graphics elements. The check box is selected by default.
The default data skin that is applied to your charts is determined by your preference. For more information, see “Setting Preferences” on page 272.

The data skin can be changed in the graph’s Properties dialog box. For more information, see “Change General Graph Properties” on page 122.

4 Use the **Transparency** slider to change a plot's transparency. Move the slider to the right to increase the transparency, and to the left to decrease the transparency.

   ![Transparency slider](image)

   You can also specify a transparency percentage in the text box next to the slider. Specify the percentage in integers.

5 To change the legend label for the plot, enter the label that you want in the **Legend Label** text box. When this plot is displayed in the legend, the plot is represented by this legend label, provided there is no GROUP variable in effect.

6 Change any plot-specific properties that are available.

   The types of properties that you see vary with the type of plot that you are modifying. In general, you can specify properties such as line colors, marker symbols, outlines, fills, and other attributes of plot features. These properties are described in the following topics:

   - “General Properties” on page 141
   - “Plot-Specific Properties” on page 149

7 To modify another plot, select the plot from the **Plot** list box and repeat steps 3–5.

8 When you are finished making changes, click **OK**.

You can also change the wall color of the cell. For instructions, see “Change the Wall Color and the Outline for a Cell” on page 171.
Specifying Style Elements for Plot Properties

ODS styles control the default color schemes and visual attributes for a graph. ODS styles consist of style elements, and each style element has its own attributes. When you modify graphics properties, you often have the option to specify a style element. For example, you can select a style element when you change the properties of plot lines, fills, and markers. The visual properties of the item that you modify are obtained from the specified style element.

The following display shows the default style element for a Loess plot.
The default style element for a Loess plot is GraphFit. The GraphFit style element contains a number of attributes that determine the appearance of the plot, such as the line color, pattern, and thickness. The default value for those attributes is Auto, which indicates that the value is automatically derived from the selected style element. If you select a different style element, the automatic attributes change.

Note: Plot elements might have a Group value instead of an Auto value. The Group value indicates that the value is derived from the group variable if one has been defined for the plot.
In the example, you can change the plot’s appearance in two ways:

- select a different style element from the list box.
- specify the attributes explicitly by selecting a value other than Auto from the list boxes.

**Note:** When you explicitly change an item’s attributes, the change persists regardless of the style. If you later change the style element or the graph's style, your explicit settings override the new style element or style.

After you change attributes, you can later revert to the original Auto or Group value if desired.

You can also create a custom style and modify the style elements that are contained in that style. The modified style elements are used every time you apply the custom style to a graph.

See Also

- “About Styles and Style Elements” on page 194
- “Style Elements Used in ODS Graphics Designer” on page 206

---

### General Properties

#### About General Plot Properties

In the **Plots** tab of the Cell Properties dialog box, you can change properties that affect the appearance of the plots in a graph.

The types of properties that you see vary with the type of plot that you are modifying. In general, you can specify colors, marker symbols, line attributes, and outlines and fills. These general plot properties are described in the following sections.

For instructions on changing plot properties, see “Change Plot Properties” on page 137.
Line Properties

Line properties apply to many of the plots, including series, needle, step, reference lines, box, contour, and density plots.

Here is an example of line properties for a step plot.

Figure 12.2   Line Properties

The default style element varies by plot. You can select a different style element from the list box. For more information about style elements, see “Specifying Style Elements for Plot Properties” on page 139.

You can specify the following line attributes:

- line color. For more information about selecting colors, see “Using the Color List Box” on page 115.
- line pattern.
- line thickness.

The attributes that you specify here override the attributes that are derived from the applied style element.

In the example shown here, the step plot contains upper and lower error limits for the data. In the Error Bar tab, you can set line properties for the error limits.

Figure 12.3  Line Properties for Error Limits

Fill and Outline Properties

Plots such as bar charts and histograms use graphics elements that have a fill color.

Here is an example of fill properties for a bar chart.
Figure 12.4  Fill and Outline Properties

You can select or clear the check boxes to toggle the fill and outline on and off.

- When the Fill check box is selected, you can specify the style element and the fill color from the list boxes.
- When the Outline check box is selected, you can specify the style element. You can also specify the color, pattern, and thickness of the outline from the list boxes.

The style element varies by plot. For more information about style elements, see “Specifying Style Elements for Plot Properties” on page 139. If you explicitly specify the color, pattern or thickness, the attributes that you specify override the attributes that are derived from the applied style element.

For information about using the Color list box, see “Using the Color List Box” on page 115.

The default settings also vary by plot type. For example, by default some plots have no outline, and only Fill is selected, as shown in the following display. If you select Outline,
then the **Fill** check box can be cleared. (**Fill** and **Outline** cannot both be cleared at the same time.) You can change the fill or outline properties even if the check box is dimmed.

**Figure 12.5  No Outline by Default**

![Figure 12.5](image)

**Marker Properties**

Marker properties apply to several plots, including scatter, series, needle, and box plots.

Here is an example of marker properties for a scatter plot.
You can specify the style element from the list box. The style element varies by plot. For more information about style elements, see “Specifying Style Elements for Plot Properties” on page 139.

You can specify the following marker attributes:

- marker color. For information about using the **Color** list box, see “Using the Color List Box” on page 115.

- marker symbol.

- marker size.

  **TIP** To hide markers in a scatter plot, select 0 for the size.

- marker weight (normal or bold). This attribute does not derive its value from the style element. Therefore, it does not have a value of **Auto**.
The attributes that you specify here override the attributes that are derived from the applied style element.

For some plots, such as series and needle, there is a Markers check box. You can select or clear the check box to toggle the markers on and off.

**Text Properties**

Text properties apply to contour and block plots as well as other graphics elements such as axis labels, titles, footnotes, and legends.

Here is an example of text properties for the labels of a contour plot.

*Figure 12.7  Text Properties*

You can change the format of the text by applying a different style element. The default style element varies for different graphics elements. For more information, see “Specifying Style Elements for Text Properties” on page 113.
You can specify the following text attributes:

- color of the text. For more information about selecting colors, see “Using the Color List Box” on page 115.
- font family of the text. For example, you can select Arial or some other font.
- point size of the text.
- style (normal, bold, italic) of the text.

The attributes that you specify here override the attributes that are derived from the applied style element.

### About Splitting Labels

Scatter plots include the ability to split the text for those labels when there is not enough room to display the text normally. The labels can split at one or more characters that you specify.

**Note:** The split option is one of the plot properties for scatter plots. For instructions on changing plot properties, see “Change Plot Properties” on page 137.

In the following example, the scatter plot is improved by splitting the labels. The label is split for each state that has a blank space in its name.

<table>
<thead>
<tr>
<th>Before</th>
<th>After</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Before Image" /></td>
<td><img src="image2.png" alt="After Image" /></td>
</tr>
</tbody>
</table>

Here are some noteworthy features and guidelines for splitting labels:

- When you split labels, you provide one or more split characters. If you do not provide a split character, an empty space is used as the split character.
When multiple split characters are specified, each character is treated separately as a split character. For example, if you specify this combination “-a”, then labels are split at each occurrence of “-” and at each occurrence of “a”. If “-” and “a” occur consecutively in a label, the split occurs once.

The order of the characters is not significant. If you leave a space between the characters, then the space is considered a split character.

The label is split at every occurrence of the specified split character or characters, even when splitting is not necessary to fit the label within its space.

If the label does not contain any of the specified split characters, a split does not occur.

When the text is split, the split characters are not included in the displayed label.

The split characters are case sensitive.

---

**Plot-Specific Properties**

**About Plot-Specific Properties**

The following sections summarize the properties that are specific to each type of plot.

You change plot properties on the **Plots** tab of the Cell Properties dialog box. For instructions on changing plot properties, see “Change Plot Properties” on page 137.

**See Also**

“General Properties” on page 141
Scatter Properties

Figure 12.8 Scatter Plot Properties

Marker tab

You can change the marker properties for the scatter plot. See “Marker Properties” on page 145.

TIP To hide markers in a scatter plot, select 0 for the size.

Error Bar tab

The Error Bar tab is available only if you specify error upper and lower limits in the Assign Data dialog box. Here you can specify line properties. See “Line Properties” on page 142.
Data Label tab

If the Data Label tab is available, then you can specify text properties for the labels. The Data Label tab is available only if you specify a data label role in the Assign Data dialog box.

You can select a position for the data label with respect to the marker. The default value of Auto automatically determines the best label position for each marker.

If you specify a data label position, then you can also specify a split character for the label. Select the Split check box and enter the split character in the Split Characters text box. For more information, see “About Splitting Labels” on page 148.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

Series, Needle, and Step Properties

The properties for series, needle, and step plots are similar. The following display shows the properties for a step plot.
Figure 12.9  Step Plot Properties

**Line tab**
On this tab, you can specify line properties for the step plot. See “Line Properties” on page 142.

**Markers tab**
Select the **Markers** check box to display markers and specify marker properties. See “Marker Properties” on page 145.

**Error Bar** tab (Step plot only)
The **Error Bar** tab is available only if you specify error upper and lower limits in the Assign Data dialog box. Here you can specify line properties.

**Curve Label** tab (Step and series plots only)
If you have specified a label for the series or step plot, you can specify the text properties of the labels. For more information, see “Text Properties” on page 147.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

**Histogram Properties**

These properties apply to vertical and horizontal histograms.

*Figure 12.10  Histogram Properties*

Select **Prefer Binned Axis** to specify that the category axis tick marks coincide with the midpoint of each bin.

You can change the fill and outline properties. See “Fill and Outline Properties” on page 143.
For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

Box Properties

These properties apply to vertical and horizontal box plots.

Figure 12.11  Box Plot Properties

General tab
Select the check box for each item that you want displayed. An item must be selected in order to change its properties.

All items except connect lines are selected by default. A connect line joins a statistic from box to box.

From the Shape list box, you can select a different shape for the caps that appear at the ends of the whiskers.
**Box Width** enables you to specify the width of the boxes as a ratio of the maximum possible width. Specify a value from 0.0 (narrowest) to 1.0 (widest).

**TIP** You can also select a box edge and drag it to the desired width.

**Interval Box Width** enables you to specify the box width when an interval category role is specified. The category variable must be numeric, and the axis type must be linear. Width values are measured in pixels. The designer interprets the specified number as an absolute value, so you can enter a negative number. The default value is −1, which is equivalent to 1 pixel.

**Box** tab
Here you can specify outline and fill properties. See “Fill and Outline Properties” on page 143.

The **Outline** check box is selected but dimmed. You can clear the **Fill** check box, but you cannot clear the **Outline** check box.

**Connect, Median, and Whisker** tabs
In these tabs, you can specify line properties for the connect, median, and whisker lines. See “Line Properties” on page 142.

**Mean** and **Outlier** tabs
You can change the marker properties for the mean and outlier markers. See “Marker Properties” on page 145.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

**Bar and Bar Error Properties**
These properties apply to vertical and horizontal bar and bar error charts.
Figure 12.12  Bar Error Plot Properties

**Area tab**
You can change the fill and outline properties. See “Fill and Outline Properties” on page 143.

**Bar tab**

**Bar Width** enables you to specify the width of the bars as a ratio of the maximum possible width. The maximum width is equal to the distance between the center of each bar and the centers of the adjacent bars. Specify a value from 0.0 (narrowest) to 1.0 (widest).

**TIP** You can also select a bar edge and drag it to the desired width.

(Bar charts only) To display a label at the top of the vertical bars or to the right of the horizontal bars, select the **Bar Label** check box.
When you select **Bar Label**, you have the option to change the text properties of the labels. For more information, see “Text Properties” on page 147.

**Error Bar** tab
(Bar error charts only.) The **Error Bar** tab is available only if you specify error upper and lower limits in the Assign Data dialog box. Here you can specify line properties. See “Line Properties” on page 142.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

**Band Properties**

*Figure 12.13  Band Plot Properties*

You can change the fill and outline properties. See “Fill and Outline Properties” on page 143.
By default there is no outline, and the Fill check box is selected but dimmed. If you select the Outline check box, then the Fill check box can be cleared. You can change the fill properties even if the check box is dimmed.

For information about specifying the transparency or legend label, see “Change Plot Properties” on page 137.

**Vector Properties**

*Figure 12.14  Vector Plot Properties*

**Arrow tab**

Select or clear the *Arrow* check box to toggle arrows on and off.

You can select the arrow direction and shape from the list boxes. Arrows can point outward from the origin, inward toward the origin, or in both directions.
Line tab
Here you can specify line properties for the vectors. See “Line Properties” on page 142.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

Contour Properties

Figure 12.15  Contour Plot Properties

General tab
You can specify the legend label.

Line tab
If the Line tab is available, you can specify line properties. See “Line Properties” on page 142.
The **Line** tab is available for the following types of contour plots:

- Line
- LineGradient
- LabeledLine
- LabeledLineFill
- LabeledLineGradient

**Fill** tab

If the **Fill** tab is available, you can select a different style element from the list box.

To reverse the color gradient of the fill, select the **Reverse color model** check box.

The **Fill** tab is available for the following types of contour plots:

- Fill
- Gradient
- LineFill
- LineGradient
- LabeledLineFill
- Labeled LineGradient

**Label** tab

If the **Label** tab is available, then you can specify text properties for the contour labels. See “Text Properties” on page 147.

The **Label** tab is available for the following types of contour plots:

- LabeledLine
- LabeledLineFill
- LabeledLineGradient
Fringe Properties

Figure 12.16  Fringe Plot Properties

You can specify line properties for the plot. See “Line Properties” on page 142.

Use the Height control to adjust the height of the fringe lines. You can also enter a height.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

Normal and Kernel Properties

These properties apply to vertical and horizontal normal and kernel plots.
You can specify line properties for the plot. See “Line Properties” on page 142.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.
Loess, Regression, PBSpline, and Model Band Properties

Figure 12.18  Loess Plot Properties

You can specify line properties for the plot. See “Line Properties” on page 142.

If you specified model band confidence limits, then select the model band plot from the Plot list box to specify its fill and outline properties. See “Fill and Outline Properties” on page 143.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.
Ellipse Properties

Figure 12.19  Ellipse Properties

You can change the fill and outline properties. See “Fill and Outline Properties” on page 143.

By default there is no fill, and the Outline check box is selected but dimmed. If you select the Fill check box, then the Outline check box can be cleared. You can change the outline properties even if the check box is dimmed.

For information about specifying the transparency or legend label, see “Change Plot Properties” on page 137.
Line Properties

These properties apply to point-and-slope lines, drop lines, and vertical and horizontal reference lines.

Figure 12.20   Reference Line Properties

You can specify line properties for the line. See “Line Properties” on page 142.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.
Block and Stack Block Properties

**Figure 12.21  Block Plot Properties**

**Display tab**
Select the check box for each item that you want displayed. An item must be selected in order to change the properties of the item.

By default, the **Fill** and **Outline** check boxes are selected. You can select the following:

- **Value** check box to display a value on the fill blocks
- **Label** check box to display an external label for the plot

**Fill tab**
Select the **Multicolor** radio button to specify multi-color fills.
Select **Alternate** to specify the appearance of alternate block fills. When you select **Alternate**, you can change the style element and color of the fill and the alternate fill. See “Fill and Outline Properties” on page 143.

**Outline tab**
You can change the outline properties of the blocks. See “Fill and Outline Properties” on page 143.

**Value tab**
You can change the text properties of the values that appear on the blocks. See “Text Properties” on page 147.

You can also select the following alignment properties of the text:

- **Horizontal**  The options are left-aligned, right-aligned, center, and start. The start value centers the text at the starting value of the block.
- **Vertical**    The options are top, center, and bottom.

**Label tab**
You can change the text properties of the external label. See “Text Properties” on page 147.

You can also select the position with respect to the plot: options are left, right, top, and bottom.

For information about specifying the transparency or legend label, see “Change Plot Properties” on page 137.

**High-Low Properties**
These properties apply to vertical and horizontal high-low plots.
The plot shown here presents the data as bars. A plot that uses lines has fewer properties than shown here.

**Figure 12.22** High-Low Bar Properties

---

**Bar tab**

If your plot presents data as bars, then the **Bar** tab is displayed.

Selecting the **Clip Cap** check box reduces the high and low caps when either extends beyond the axis range. If this check box is clear, then you might not see the cap for those particular bars.

**Bar Width** enables you to specify the width of the bars as a ratio of the maximum possible width. The maximum width is equal to the distance between the center of each bar and the centers of the adjacent bars. Specify a value from 0.0 (narrowest) to 1.0 (widest).
**TIP** You can also select a bar edge and drag it to the desired width.

**Interval Bar Width** enables you to specify the bar width when an interval variable is specified for the X role. The X variable must be numeric, and the axis type must be linear. Width values are measured in pixels. The designer interprets the specified number as an absolute value, so you can enter a negative number. The default value is −1, which is equivalent to 1 pixel.

You can change the fill and outline properties. See “Fill and Outline Properties” on page 143.

**Line tab**

If your plots present data as lines, then the **Line** tab is displayed.

Selecting the **Clip Cap** check box reduces the high and low caps when either extends beyond the axis range. If this check box is clear, then you might not see the cap for those particular lines.

You can change the line properties. See “Line Properties” on page 142.

**Label tab**

If you specified labels for the plots, then you can specify the text properties of the labels. For more information, see “Text Properties” on page 147.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

**Axis Table Properties**

These properties apply to vertical and horizontal axis tables.
Value tab

Use the **Indent** list box to specify an indent value. This value is used in conjunction with the **Indent Weight** option in the axis table’s Assign Data dialog box. The value that you specify here is multiplied by the values for the **Indent Weight** variable to compute the indent for each observation.

You can specify the text properties for the axis table values. For more information, see “Text Properties” on page 147.

Label tab

To display a label for the axis table, select the **Label** check box. Select the position for the label from the **Position** list box. The **Min** position precedes the lowest data value on the axis. The **Max** position follows the highest data value on the axis.
You can specify the text properties of the labels. For more information, see “Text Properties” on page 147.

For information about specifying the data skin, transparency, or legend label, see “Change Plot Properties” on page 137.

---

**Change the Wall Color and the Outline for a Cell**

If your graph contains multiple cells, you can control whether a border is displayed around the cell walls. You can also change the wall color for a cell.

**Note:** For more information about cells, see “Components of a Graph” on page 39.

To change the wall color for a cell and turn its border on or off:

1. Right-click in the plot area of the cell that you want to modify. Select **Plot Properties**.
   The Cell Properties dialog box appears with the **Plots** tab displayed.

2. Click the **General** tab.
3 In the Wall section, select a background color from the Fill list box. For instructions, see “Using the Color List Box” on page 115.

4 Select or clear the **Outline** check box to turn the border on or off.

5 Click **OK**.
Changing Axis Properties

About Axis Properties ................................................................. 173

Change an Axis Label ............................................................... 174

Change Axis Properties .............................................................. 175
  Basic Changes ........................................................................ 175
  General Tab ........................................................................... 177
  Label Tab ............................................................................... 180
  Value Tab ............................................................................... 181
  Grid Tab ............................................................................... 181
  Range Tab ............................................................................... 182

About the Axis Data Range ......................................................... 188

About Axis Properties

You can modify the properties of your axes as follows:

- specify general display attributes, such as whether to display a grid and tick marks
- change the text for axis labels
- change the font properties for labels and axis values
- choose the axis type, such as discrete, linear, or logarithmic
- customize the range of values that are displayed on the axis
specify the tick sequence for a linear axis

reverse the axis

in multi-cell graphs, set a uniform scale on the axis for rows, columns, or both

**Note:** In some cases, these properties are dimmed. For example, some plots require a particular type of axis, and the axis type cannot be changed for those plots. In addition, you cannot reverse a common axis.

For multi-cell graphs, you can also specify whether to use a common row or column axis. For more information, see “Sharing or Unsharing a Common External Axis” on page 231.

---

### Change an Axis Label

There are two main ways to change the text of an axis label:

- Double-click the label if you want to modify the existing text. This action places the cursor in the label text box. You can move the cursor with the system arrow keys and use the Delete key to delete characters. You can also double-click again to select the entire label.

  **TIP** If you do not want a label for the axis, you can double-click the label and delete the text. This action hides the label.

- Enter the new text on the **Axis** tab of the Cell Properties dialog box. In the dialog box, you can also do the following:
  
  - change the text properties of the label
  - hide the label

For more information, see “Change Axis Properties” on page 175.
Change Axis Properties

Basic Changes

To change axis properties:

1. Right-click an axis and select **Axis Properties**. The Cell Properties dialog box appears and displays the **Axes** tab. The axis that you clicked is selected for editing.

   ![Cell Properties dialog box with the Axes tab selected](image)

   **Note:** In paneled plots, the Cell Properties dialog box does not open. Instead, an **Axis Properties** dialog box appears and displays the tabs shown here.

2. Make sure that the axis that you want to change is selected in the **Axis** list box.
3 If the **Type** list box is available, then you can select a different data type for the axis. Here are the possible types:

- **Discrete**: The axis contains independent data values rather than a range of numeric values. Each distinct value is represented by a tick mark. Discrete is the default axis type for character data. Some plots require a discrete axis. For example, bar charts use a discrete axis for the category variable.

- **Linear**: The axis contains a linear range of numeric values. Linear is the default axis type for numeric data. Some plots require a linear axis. For example, bar charts use a linear axis for the response variable.

- **Logarithmic**: The axis contains a logarithmic range of values. The logarithmic axis type is not used as a default.

  You might want a logarithmic axis type depending on the nature of the data. For example, suppose that you plot your growth data with a linear axis and, based on the values, you suspect that the growth rate is exponential. If the data contains a very large range of values (orders of magnitude apart), you can display the values on a logarithmic scale. You can choose a logarithmic scale with base 10 or base 2.

  **Note**: The data range on a log axis must be positive. In addition, needle plots and bar charts, which have an implicit baseline equal to zero, cannot have a logarithmic axis.

- **Time**: The axis contains a range of date, time, or date-time values. Time is the default axis type for data that uses a SAS date, time, or date-time format.

  You can change the default axis type if the **Type** list box is available. For example, if you create a scatter plot based on numeric data, you can change the X axis from linear to discrete. A bar chart, however, uses a discrete axis for the category (X) axis and a linear axis for the response (Y) axis. Neither of these axis types can be changed and, accordingly, the **Type** list box is dimmed.

4 Select the check box for each item that you want to appear on the axis. You can select check boxes to display labels, values, tick marks, and a grid.
If the **Data Range** list box is available, then you can select a different data range for the axis. For more information, see “About the Axis Data Range” on page 188.

6 Make changes on any of the following tabs that are available.

- General tab
- Label tab
- Value tab
- Grid tab on page 181
- Range tab on page 182

7 Click **OK**.

**General Tab**

You can make the following changes on the **General** tab:

**Label**

To change the label, specify the text that you want in the text box.

If you do not want the label to appear, you can delete all the text so that the text box is blank. Effectively, this is the same as clearing the **Label** check box. If you later want to restore the label, select the **Label** check box.

**Axis offset**

Specify a value between 0 and 1 in the **Min** text box, the **Max** text box, or both text boxes. The value represents the offset as a proportion to the total length of the axis.

The **Min** offset precedes the lowest data value on the axis. For a continuous axis, the offset precedes the lowest data value or lowest tick value, whichever is less. For a discrete axis, the offset is applied to the end of the axis nearer to the origin.

The **Max** offset follows the highest data value on the axis. For a continuous axis, the offset follows the highest data value or highest tick value, whichever is greater. For a discrete axis, the offset is applied to the end of the axis farther from the origin.
Minor ticks
To enable minor tick marks, select the check box.

This option is available only if the Tick check box is selected.

This option is not available for discrete axes.

Reverse
To reverse the axis, select the check box.

Discrete Color Bands
To enable alternating wall-color bands, select the check box. This option is available only for discrete axes.

The full width of a color band is the distance between midpoints. When no axis offsets are specified, the first band begins at one-half of the midpoint distance, and the last band ends at one-half of the midpoint distance. When axis offsets are specified, the first and last color bands on the axis might extend into their adjacent offsets by as much as half the color-band width.

The following options are available when you specify color bands:

Even or odd
Specify whether the bands should start at the first even or odd interval.

The following images show the results of the Even and Odd selections:

Table 13.1 Color Bands Specified for a Y Axis
Element
You can modify the style element that is applied to the bands. For more information about style elements, see “Specifying Style Elements for Text Properties” on page 113.

Color
You can also specify the color of the bands. The color that you specify overrides any style that is applied to the graph.

For information about using the Color list box, see “Using the Color List Box” on page 115.

Transparency
Use the slider to change the transparency of the color bands. Move the slider to the right to increase the transparency, and to the left to decrease the transparency. You can also specify a transparency percentage in the text box next to the slider. Specify the percentage in integers.

Tick Value
Specify the method that is used to fit tick mark values on the axis when there is not enough room to draw them normally. This option is available only for discrete axes.

The following options are available.

Fit Policy
Specify the method that is used to fit tick mark values on the axis. The available options vary depending on which axis you are changing.
The following options are available for the X axis and the Y axis:

<table>
<thead>
<tr>
<th>X axis</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SplitRotate</strong></td>
<td>(default) attempts to fit the tick mark values by splitting the text at blank space characters. If splitting does not create a good fit, then rotation is used instead.</td>
</tr>
<tr>
<td><strong>Rotate</strong></td>
<td>rotates the value text using the rotation scheme specified in the Rotation list box. The default rotation is Diagonal (45 degrees).</td>
</tr>
<tr>
<td><strong>RotateThin</strong></td>
<td>attempts to fit the tick mark values by rotating them. If rotation does not create a good fit, then rotation and thinning are used together. Thinning removes some of the values from the axis.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y axis</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>None</strong></td>
<td>(default) displays all of the tick values.</td>
</tr>
<tr>
<td><strong>Thin</strong></td>
<td>removes some of the values from the axis to avoid overlapping.</td>
</tr>
</tbody>
</table>

**Note:** No splitting occurs on the Y axis.

**Rotation**

Specify the rotation to use for the tick values. You can specify either **Diagonal** (default) or **Vertical**. Diagonal rotates the text 45 degrees.

This option is available only for the X axis.

---

**Label Tab**

The **Label** tab is available if the **Label** check box is selected.

You can make the following changes on the **Label** tab:

**Style element**

You can modify the style element that is applied to the label. For more information about style elements, see “Specifying Style Elements for Text Properties” on page 113.
Color and font attributes

You can also specify the color, font family, size, and style (bold, italic) of the text from the list boxes. If you change these properties, the settings that you specify override any style that is applied to the graph.

For information about using the Color list box, see “Using the Color List Box” on page 115.

Value Tab

The Value tab is available if the Value check box is selected.

You can make the following changes on the Value tab:

Style element

You can modify the style element that is applied to the axis values. For more information about style elements, see “Specifying Style Elements for Text Properties” on page 113.

Color and font attributes

You can also specify the color, font family, size, and style (bold, italic) of the text from the list boxes. If you change these properties, the settings that you specify override any style that is applied to the graph.

For information about using the Color list box, see “Using the Color List Box” on page 115.

Grid Tab

The Grid tab is available if the Grid check box is selected. This feature creates grid lines at each tick on the axis.

You can make the following changes on the Grid tab:

Style element

You can modify the style element that is applied to the grid lines. For more information about style elements, see “Specifying Style Elements for Text Properties” on page 113.
Color and line attributes
You can also modify the color, the pattern (such as dotted or dashed), and the thickness of the grid lines. If you change these properties, the settings that you specify override any style that is applied to the graph.

For information about using the Color list box, see “Using the Color List Box” on page 115.

Minor grid
To enable minor grid lines, select the check box. Minor grid lines are displayed at the minor tick values.

This option is not available for discrete axes.

Range Tab

About the Range Tab
The data-entry fields on the Range tab vary depending on the axis type.

For a linear, date, or logarithmic axis, you can do the following:

- specify a custom range for the axis
- change the tick values and the text that is displayed. You can also add and delete ticks.
- (linear axis only) customize the tick sequence

For more information, see “Linear, Date, and Logarithmic Axes” on page 183.

For a discrete axis, the custom range feature is not available. You can use a tick values list to customize the range. This tick values list enables you to change the tick values and the text that is displayed. You can also remove ticks from the axis and change the order of ticks. For more information, see “Discrete Axis” on page 187.
Linear, Date, and Logarithmic Axes

This display is for a linear axis. The Range tab is similar for time and logarithmic axes, but does not include the Tick Sequence option. Instead, the tab contains only a Tick Values List option.

Figure 13.1 Range Tab for a Linear Axis

You can make the following changes on the Range tab:

**Custom Axis Range**

Select the check box to adjust the view of an axis by specifying minimum and maximum data values to include in the display. By default, the axis range is determined by the data.

When you select the check box, you can enter integer values, including negative values, in the Min and Max boxes.
For example, the following scatter plot shows the distribution of weight by age. By default, the Y axis ranges from 60 to 140 pounds.

If you want to focus on students above 100 pounds, you could enter 100 in the Min text box. This change yields the following plot:

The value specified for the Min text box is greater than the data minimum value. This setting acts like a “zoom in” operation, reducing the range of values represented on the axis and possibly excluding markers, lines, or fills that would normally appear. You could further zoom in by setting the Max value to be less than the data maximum value.

Conversely, if you specify a Min value that is less than the data minimum value (for example, 30), you achieve a “zoom out” effect. You can further zoom out by setting
the Max value to be greater than the data maximum value. This change yields the following plot:

![Class Weight Distribution](image)

**Custom Tick values**

You can customize either the tick sequence or the tick values that are displayed. Choose **Tick Sequence** or **Tick Values List**.

**Note:** The Min and Max values define the range of the data that is displayed. **Tick Sequence** and **Tick Values List** control what to display in the axis. If you provide tick values that are out of order (5, 2, 7, 9, and so on), the tick values are ordered correctly at display time.

**Tick Sequence**

This option is available only for linear axes.

Select the button to specify the tick values for a linear axis by start, end, and increment. The following three settings control the major tick values.

- **Start** specifies the value for the first tick mark.
- **End** specifies the value for the last tick mark.
- **Increment** specifies the increment for intermediate tick marks between the first and last tick marks. The end value always controls the last tick mark. The interval between the last tick mark and the previous tick mark might not necessarily be the increment value.

**Tick Values List**
This option is available for linear, time, and logarithmic axes.

- To change the value for a tick mark, double-click the current value in the **Tick Value** column and enter the new value.

For example, the following images show an axis in which the tick mark at data value 55 is changed to 57.

![Image showing tick changes](image1)

- To change the text that is displayed for your tick values, check **Custom Tick Display List**.

You can double-click the text boxes in the **Tick Display** column and enter the new display text. You must provide the display text for all the tick values. Any display value left blank here appears blank for the respective tick mark on the axis.

The following images show tick marks with custom display values.

**Default tick values:**

![Default tick values](image2)

**Custom tick values:**

![Custom tick values](image3)

- To add a new tick value, click `+`.

A new row is created at the top of the list.

Enter the tick value and press Enter. The new tick is inserted into the axis according to its value.

- To delete a tick value, select the row for the tick value and click `×`. 

![Delete tick value](image4)
Discrete Axis

Figure 13.2  Range Tab for a Discrete Axis

For a discrete axis, you can change the tick values and the text that is displayed. You can also remove ticks from the axis and change the order of ticks.

Note: The tick values and order are displayed as specified. For example, suppose the data contains values for A, B, C, and D, and you specify C, A, and D as tick values. Data points for B are removed from the output, and the axis contains tick values C, A, and D in that order.

To change the tick values:

1. Select **Tick Values List**.

2. To change the text that is displayed for a tick value, double-click the text box in the **Tick Display** column and enter the new display value.
3 To remove a tick mark from the axis, clear the **Visible** check box for the tick value. When a tick mark is removed, the plot data aligns with the nearest sequential tick.

4 Use the ↑ and ↓ arrows to move a tick up or down in the list.

In the following example, several ticks were removed from the axis, and the text for the remaining ticks was changed to Small, Medium, and Large.

![Tick marks with different text](image)

---

**About the Axis Data Range**

On the **Axes** tab of the Cell Properties dialog box, the **Data Range** list box specifies how the plot axes in multi-cell graphs are scaled. This option enables you to control the uniformity of the axes across cells in multi-cell graphs and classification panels. You can specify a uniform scale on the X axes for the columns of a lattice or on the Y axes for the rows of the lattice. This feature facilitates the visual comparison of the data cells.
Figure 13.3  Axes Tab of the Cell Properties Dialog Box

For instructions about changing axis properties, see “Change Axis Properties ” on page 175.

Here are the values for the Data Range list box:

Data
  scales the axes independently for each cell. This is the default.

  The following graph shows the Y axis with a data range of type Data.
In the example, the cells in each row have independent scales for their Y axes.

**Union**

finds the minimum data point and the maximum data point on a per-row or per-column basis, and specifies this range on the appropriate axis for the row or column. This option computes the axis range separately for each row (if modifying a Y axis) or column (if modifying an X axis).

The axes must be of the same type for all the cells in a row or column.

The following graph shows the Y axis with a data range of type Union.
In the example, the cells in each row have a uniform Y-axis scale within their respective row.

**Union All**

finds the minimum data point and the maximum data point over all rows (if modifying a Y axis) or all columns (if modifying an X axis). The option then specifies this range on the appropriate axis for each cell.

The axes must be of the same type for all the cells in all rows or in all columns.

The following graph shows the Y axis with a data range of type Union All.
In the example, the cells in both rows have a uniform Y-axis scale.
Customizing Graph Styles

About Styles and Style Elements ........................................ 194
   Overview of Styles and Style Elements ............................ 194
   Main Tasks Related to Styles ........................................ 195

About the Graph Style Editor ........................................... 196
   Introduction to the Graph Style Editor ......................... 196
   Open the Graph Style Editor ....................................... 196
   The Graph Style Editor's User Interface ......................... 197

Use the Sample Graphs to Identify Style Elements ............ 198

Create a Custom Style .................................................... 200

Modify a Custom Style .................................................... 202

Modify and Apply the Current Style ................................. 203

Export a Custom Style .................................................... 205

Delete a Custom Style ..................................................... 205

Style Elements Used in ODS Graphics Designer ............... 206
   About This Topic ....................................................... 206
   Style Elements, and Which Parts of a Graph They Affect .... 207
   Graphics Elements, and Which Style Elements Affect Them ... 211
About Styles and Style Elements

Overview of Styles and Style Elements

ODS styles control the default color schemes and visual attributes for a graph. The style contains information about the various fonts used for different textual parts for the graph, such as titles, footnotes, and axis labels. The style also contains information about colors, marker shapes and sizes, line patterns, and so on. Styles are designed to create an aesthetic and effective graph that conveys information clearly and without clutter.

SAS supplies a set of predefined styles that can be used with the graphs. You can apply different styles to your graph to achieve different effects. You can also create your own custom styles. In ODS Graphics Designer, you can create styles by using the interactive Graph Style Editor.

ODS styles consist of style elements, and each style element has its own attributes. Within a given style, the style elements give you more granular control of a graph's visual elements.

You can change the style element that is assigned to a graph component in a particular graph. For example, GraphTitleText is the default style element for a title. To change the properties of a title, you can assign a different style element. This feature enables you to obtain a different look for the title without changing the applied style. For more information, see “Specifying Style Elements for Text Properties” on page 113 and “Specifying Style Elements for Plot Properties” on page 139.
You can override an attribute of a style element. For example, if you want the title text to be blue for your graphs, you can explicitly set the color to blue. However, you must make this change for every graph. Instead, you can change the definition of the style element itself and set its color to blue. To do this, use the Graph Style Editor to make the change and save your change as a custom style. Then you can apply the custom style to your graphs, or make the custom style the default style for all new graphs.

See Also

- “About the Graph Style Editor” on page 196
- “Create a Custom Style” on page 200

Main Tasks Related to Styles

- Change the style that is applied to a graph. For instructions, see “Change the Style That Is Applied to a Graph” on page 130.
Change the style that is applied to new graphs by default. For instructions, see “Setting Preferences” on page 272.

Create a new style. For instructions, see “Create a Custom Style” on page 200. When you create a style, you can do the following:

- set the font attributes for titles, footnotes, and other text elements
- set the attributes of style elements that are used for plots, backgrounds, gradients, lines, and other plot features

Edit a style that you created. For instructions, see “Modify a Custom Style” on page 202.

Export a style to a SAS file. For instructions, see “Export a Custom Style” on page 205.

Delete a style that you created. For instructions, see “Delete a Custom Style” on page 205.

---

**About the Graph Style Editor**

**Introduction to the Graph Style Editor**

The ODS Graphics Designer includes an interactive Graph Style Editor that you can use to create your own custom styles. You base custom styles on existing styles. When you create custom styles, you change the attributes for various style elements. The Graph Style Editor shows the association between the style elements and the different parts of the graph.

**See Also**

“About Styles and Style Elements” on page 194

**Open the Graph Style Editor**

To open the Graph Style Editor, select **Tools ▶ Style Editor**.
As an alternative, open a graph whose style you want to change, and select **Format ▶ Style ▶ Edit Current Style**. When opened this way, the Graph Style Editor enables you to modify the style of the graph and immediately apply the modified style to the graph. For more information, see “Modify and Apply the Current Style” on page 203.

### The Graph Style Editor's User Interface

The Graph Style Editor organizes style components using the following hierarchy:

- **element groups ▶ elements ▶ attributes**

Style elements are organized into groups, and each element has its own particular attributes.

The following display shows how the Graph Style Editor represents these style components.

**Figure 14.2  Graph Style Editor**

1  Style element groups
a list of style element groups. In the Graph Style Editor, style elements are organized into element groups. The Plot group is selected by default.

2 Style elements

the list of style elements that are in the selected element group. When the Plot group is selected, these include all the style elements that are used to draw the bars, markers, or lines of a plot. The GraphDataDefault element is selected by default.

3 Style element attributes

the list of attributes for each style element. You can use the controls to change the values for the attributes, such as the color, marker symbol, text attributes, and so on.

4 Sample graphs

visual representations that show the relationships between various plot elements and the style elements. You can click on a part of the graph, such as the title, footnote, or marker, to see which style element controls a particular plot element. For example, click on the title and the GraphTitleText style element is selected. You can then change the style element's attributes.

---

Use the Sample Graphs to Identify Style Elements

You can use the samples in the right pane of the Graph Style Editor to help identify style elements.
You can click a part of the graph, such as the title, footnote, or marker, to see which style element controls a particular plot element. For example:

- To see the attributes for title text, click the title of a sample plot. The GraphTitleText element is selected. You can then change the element's attributes.

- To see the attributes for fills, markers, and lines, click a bin in the sample histogram. The GraphDataDefault element is selected.

  The fill attributes are used for plots such as histograms and bar charts. The line attributes are used for plots such as series or step. The marker attributes are used for scatter plots.

- To see the same attributes for plots in which grouped variables are applied, click the different colored bins in the sample bar chart.

- To see other sample plots, select a plot from the Select sample plot list box.
Create a Custom Style

You cannot change the predefined SAS ODS styles. However, you can edit a SAS style, customize various style elements and attributes, and save your changes using a new style name.

To create a new custom style:

1. Select Tools ► Style Editor. The Graph Style Editor appears.

2. From the Style list box, select the style that you want to use as the basis for the new style. When you select a style, the samples on the right side of the dialog box change to reflect the style.

3. Select an element group in the left pane of the dialog box. Element groups include plots, backgrounds, gradients, lines, and other groupings. The Plot group is selected by default.

The style elements for the selected group appear in the top middle pane.

For a description of the Graph Style Editor, see “About the Graph Style Editor” on page 196.
You can use the samples in the right pane to help identify style elements. For more information, see “Use the Sample Graphs to Identify Style Elements” on page 198. For descriptions of the style elements, including which graphics elements they control, see “Style Elements Used in ODS Graphics Designer” on page 206.

4 Modify the style elements in the selected element group.

a Select a style element in the top middle pane. Attributes for the selected element appear in the bottom middle pane.

b To change an attribute, click the attribute. Then either select or specify the value that you want for the attribute.

For example, when you click the Fill Color attribute, the attribute changes to a list box from which you can select a color.

![Fill Color Attribute](image)

For some attributes, you enter one or more values. For example, to change the display options for an attribute, you enter the new display option or options.

| Display Options | fill outline |

Note:

- If you specify more than one value, leave a blank space between the values.
- When you specify the value of an attribute, you must press Enter before the new value takes effect.

c Continue changing attributes as appropriate to modify the style element.

d Repeat these steps to modify another style element and change its attributes.
Note: Your style settings are ignored when the style is applied to a graph that has style element overrides. For example, if you have explicitly changed the marker color for a graph, then that explicit plot property setting overrides style settings for the graph.

5 To make more changes, select a different element group. Then repeat the previous step to modify the style elements in the group.

6 To save the new style, click **Save as** and provide a name for the style. If a custom style exists with the name that you provide, a message box asks whether you want to replace the style. If you click **Yes**, the custom style is overwritten.

   The Graph Style Editor remains open. To close the editor, click the Close icon in the top right corner of the editor.

After you have created a style, you can apply the style to your graphs. For instructions, see “Change the Style That Is Applied to a Graph” on page 130.

Note: You can also modify the current style of a graph and immediately apply the modified style to the graph. For more information, see “Modify and Apply the Current Style” on page 203.

---

**Modify a Custom Style**

You can modify any user-defined, custom style by changing its style elements and attributes.

To modify a custom style:

1 Select **Tools ▶ Style Editor**. The Graph Style Editor appears.
For a description of the Graph Style Editor, see “About the Graph Style Editor” on page 196.

2 From the **Style** list box, select the style that you want to modify. When you select a style, the samples on the right side of the dialog box change to reflect the style.

3 Modify the style. For more information about the changes that you can make to a style, see “Create a Custom Style” on page 200.

4 To save your changes, click **Save**.

**Note:** You can also modify the current style of a graph and immediately apply the modified style to the graph. For more information, see “Modify and Apply the Current Style” on page 203.

---

**Modify and Apply the Current Style**

The ODS Graphics Designer enables you to modify the current style of a graph and immediately apply the modified style to the graph. This feature is useful when you want to create and apply a new style based on the current style.

To modify and apply the current style:
1. Open the graph whose style you want to change. The style can be a custom style or a SAS predefined style. (You cannot change the predefined SAS styles. However, you can edit a SAS style, customize various style elements and attributes, and save your changes using a new style name.)

Note: If you have multiple graphs open that use the current custom style, these graphs will all change if the current style is changed.

2. Select Format ➤ Style ➤ Edit Current Style. The Graph Style Editor appears. The Style list box contains only the current style that you are modifying.

For a description of the Graph Style Editor, see “About the Graph Style Editor” on page 196.

3. Modify the style. For more information about the changes that you can make to a style, see “Create a Custom Style” on page 200.

4. To save your changes, click one of the following buttons:

- **Save/Apply** to save and apply the changes in the current style. If the current style is a SAS predefined style, then this button is dimmed, and you must use the **Save As/Apply** option.

- **Save As/Apply** to save the current style as a new style and apply the new style. The Graph Style Editor saves your changes and then closes.
Export a Custom Style

You can export the template code for any user-defined style that has been created in ODS Graphics Designer. This feature is useful when you want to generate graphs outside of ODS Graphics Designer.

For example, suppose that you want to generate a graph by running the SGDESIGN procedure against an SGD file. To apply a custom style to the graph, export the custom style and run the exported code to create the style in SAS. Then, specify the custom style in your ODS statement when you run the SGDESIGN procedure.

To export the template code for a style:

1. Select File ➤ Export Style. The Export Style dialog box appears.
2. From the Style list box, select the style that you want to export. Only custom styles are listed in the list box.
3. Specify a name and location for the SAS program, and then click Save.

Delete a Custom Style

You cannot delete a SAS predefined style, but you can delete any custom style that you have created.

Any graphs that currently use the style that you delete are changed to the Listing style. In addition, if you delete a style that is set up as your default style in the preferences, then the Listing style becomes the new default.

To delete a custom style:

1. Make sure that at least one graph is open.
2 Select **Format ▶ Style ▶ More Styles**. The More Styles dialog box appears.

3 In the **My Styles** list, select the style to delete and then click the Delete \( \times \) icon. The style is deleted from the list.

4 Click **OK**.

**Note:** After you click **OK**, you cannot undo the delete action.

---

**Style Elements Used in ODS Graphics Designer**

**About This Topic**

This topic shows the relationship between the ODS style elements and the graphics elements that they affect.

In order to help you understand this relationship, the information is presented from two different perspectives:

- **“Style Elements, and Which Parts of a Graph They Affect” on page 207**
  
  lists style elements along with their associated graph elements. This mapping is useful when you are working in the Graph Style Editor and want to know which portions of the graph are affected by a particular style element.

- **“Graphics Elements, and Which Style Elements Affect Them” on page 211**
  
  lists graph components along with their associated style elements. This mapping is useful when you know which portions of the graph you want to change, but need to know which style elements to modify.

For more information about the style elements, see the *SAS ODS Graphics: Procedures Guide*. 
Style Elements, and Which Parts of a Graph They Affect

The following tables list style elements and their associated graphics elements. The tables here reflect the style element groups that appear in the Graph Style Editor.

Note:

- The tables give you a general guide, but changes to a style element might affect graph elements not listed here.
- Fill areas generally use the Color attribute of a style element. Markers and lines use the Contrast Color attribute.

**Table 14.1 Text Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>What the Element Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>GraphDataText</td>
<td>text font and color for point labels</td>
</tr>
<tr>
<td>GraphFootnoteText</td>
<td>text font and color for footnotes</td>
</tr>
<tr>
<td>GraphLabelText</td>
<td>text font and color for axis labels and legend titles</td>
</tr>
<tr>
<td>GraphTitleText</td>
<td>text font and color for titles</td>
</tr>
<tr>
<td>GraphValueText</td>
<td>text font and color for cell headings, text entries, contour labels, axis tick values, and legend values</td>
</tr>
</tbody>
</table>
### Table 14.2  Plot Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>What the Element Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>GraphDataDefault</td>
<td>visual attributes related to non-grouped data items</td>
</tr>
<tr>
<td></td>
<td>color for filled regions such as bars, histogram bins, and band areas</td>
</tr>
<tr>
<td></td>
<td>marker and line color</td>
</tr>
<tr>
<td></td>
<td>marker symbol and size</td>
</tr>
<tr>
<td></td>
<td>line pattern and thickness</td>
</tr>
<tr>
<td>GraphData1–GraphData12</td>
<td>visual attributes related to grouped data items for up to 12 group values</td>
</tr>
<tr>
<td></td>
<td>color for filled regions such as bars, histogram bins, and band areas</td>
</tr>
<tr>
<td></td>
<td>line and marker color</td>
</tr>
</tbody>
</table>

### Table 14.3  Special Plot Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>What the Element Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>GraphBox</td>
<td>display options for box plots</td>
</tr>
<tr>
<td></td>
<td>(the display options are listed in the element's text box; options should be separated</td>
</tr>
<tr>
<td></td>
<td>with a blank space)</td>
</tr>
<tr>
<td>GraphBoxMean</td>
<td>marker for the mean in box plots</td>
</tr>
<tr>
<td>GraphBoxMedian</td>
<td>line for the median in box plots</td>
</tr>
<tr>
<td>GraphBoxWhisker</td>
<td>whiskers and serifs in box plots</td>
</tr>
</tbody>
</table>

### Table 14.4  Background Elements

<table>
<thead>
<tr>
<th>Element</th>
<th>What the Element Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>GraphBackground</td>
<td>fill color for the background of the graph</td>
</tr>
<tr>
<td>GraphHeaderBackground</td>
<td>fill color for the background of the cell headings in classification panels</td>
</tr>
<tr>
<td>Element</td>
<td>What the Element Affects</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GraphLegendBackground</td>
<td>fill color for the background of the global legend</td>
</tr>
<tr>
<td>GraphWalls</td>
<td>visual attributes for the background and border of the walls that are bounded by the axes</td>
</tr>
</tbody>
</table>

**Table 14.5  Gradient Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>What the Element Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>ThreeColorAltRamp</td>
<td>line contours, markers, and data labels with a segmented range three-color response</td>
</tr>
<tr>
<td></td>
<td>(not used by default in the designer, though you can change the properties of a filled contour to point to this element)</td>
</tr>
<tr>
<td>ThreeColorRamp</td>
<td>gradient contours, surfaces, markers, and data labels with continuous three-color response</td>
</tr>
<tr>
<td>TwoColorAltRamp</td>
<td>line contours, markers, and data labels with a segmented range two-color response</td>
</tr>
<tr>
<td></td>
<td>(not used by default in the designer, though you can change the properties of a filled contour to point to this element)</td>
</tr>
<tr>
<td>TwoColorRamp</td>
<td>gradient contours, surfaces, markers, and data labels with continuous two-color response</td>
</tr>
<tr>
<td></td>
<td>(not used by default in the designer, though you can change the properties of a filled contour to point to this element)</td>
</tr>
</tbody>
</table>

**Table 14.6  Line Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>What the Element Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>GraphAxisLines</td>
<td>axis lines and tick marks</td>
</tr>
<tr>
<td>Element</td>
<td>What the Element Affects</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GraphBorderLines</td>
<td>graph border</td>
</tr>
<tr>
<td></td>
<td>legend borders</td>
</tr>
<tr>
<td></td>
<td>other borders</td>
</tr>
<tr>
<td>GraphFit</td>
<td>primary fit line, such as a normal density curve (fill, marker, and text attributes have the same effect as the marker or line color attributes)</td>
</tr>
<tr>
<td>GraphFit2</td>
<td>secondary fit line, such as a kernel density curve (fill, marker, and text attributes have the same effect as the marker or line color attributes)</td>
</tr>
<tr>
<td>GraphGridLines</td>
<td>horizontal and vertical grid lines that are drawn at major tick marks</td>
</tr>
<tr>
<td></td>
<td>display options (auto, on, off)</td>
</tr>
<tr>
<td>GraphOutlines</td>
<td>outline properties for fill areas, such as bars, box plots, and histograms</td>
</tr>
<tr>
<td>GraphPrediction</td>
<td>prediction lines (not currently used by ODS Graphics Designer)</td>
</tr>
<tr>
<td>GraphReference</td>
<td>horizontal and vertical reference lines</td>
</tr>
<tr>
<td></td>
<td>drop lines</td>
</tr>
</tbody>
</table>

**Table 14.7 Other Elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>What the Element Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>GraphAltBlock</td>
<td>alternate fill color for block plots</td>
</tr>
<tr>
<td>GraphBand</td>
<td>display options for confidence bands (fill outline)</td>
</tr>
<tr>
<td>GraphBlock</td>
<td>fill color for block plots</td>
</tr>
<tr>
<td>GraphConfidence</td>
<td>primary confidence lines and bands (marker and text attributes have the same effect as the marker or line color attributes)</td>
</tr>
<tr>
<td>Element</td>
<td>What the Element Affects</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GraphConfidence2</td>
<td>secondary confidence lines and bands</td>
</tr>
<tr>
<td></td>
<td>(marker and text attributes have the same effect as the marker or line color attributes)</td>
</tr>
<tr>
<td>Contour</td>
<td>display options for contour plots</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The display options are set for this style element when the plot is created. The display options cannot be changed in the Graph Style Editor.</td>
</tr>
<tr>
<td>GraphControlLimits</td>
<td>not used by ODS Graphics Designer</td>
</tr>
<tr>
<td>GraphEllipse</td>
<td>display options for confidence ellipses (outline, fill)</td>
</tr>
<tr>
<td>GraphError</td>
<td>error line or error bar fill</td>
</tr>
<tr>
<td></td>
<td>(marker and text attributes have the same effect as the marker or line color attributes)</td>
</tr>
<tr>
<td>GraphHistogram</td>
<td>display options for histograms (fill, outline)</td>
</tr>
<tr>
<td>GraphOutlier</td>
<td>outlier data for the graph</td>
</tr>
<tr>
<td>GraphPredictionLimits</td>
<td>fills for prediction limits (not currently used by ODS Graphics Designer)</td>
</tr>
<tr>
<td>UnicodeText</td>
<td>text font for Unicode values</td>
</tr>
</tbody>
</table>

**Graphics Elements, and Which Style Elements Affect Them**

The following table lists parts of a graph (components) and their associated style elements.

**Note:**

- In the table, GraphDataDefault applies fill, marker, and line attributes for non-grouped data items. For data items that are grouped (up to 12 groupings), the editor uses the GraphData1–GraphData12 style elements.
Fill areas generally use the Color attribute of a style element. Markers and lines use the Contrast Color attribute.

<table>
<thead>
<tr>
<th>Graph Component</th>
<th>Style Attributes</th>
<th>Corresponding Style Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>scatter plot</td>
<td>markers</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>series plot</td>
<td>lines and markers</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>needle plot</td>
<td>lines and markers</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>step plot</td>
<td>lines and markers</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>histogram</td>
<td>bin fill and outline</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td></td>
<td>outline</td>
<td>GraphOutlines</td>
</tr>
<tr>
<td>box plot</td>
<td>fill and outline</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td></td>
<td>marker for the mean</td>
<td>GraphBoxMean</td>
</tr>
<tr>
<td></td>
<td>line for the median</td>
<td>GraphBoxMedian</td>
</tr>
<tr>
<td></td>
<td>whiskers</td>
<td>GraphBoxWhisker</td>
</tr>
<tr>
<td></td>
<td>display options</td>
<td>GraphBox</td>
</tr>
<tr>
<td>bar plot</td>
<td>fill</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td></td>
<td>outline</td>
<td>GraphOutlines</td>
</tr>
<tr>
<td>error bar (used with various plots)</td>
<td>lines</td>
<td>GraphError</td>
</tr>
<tr>
<td>band plot</td>
<td>fill and outline</td>
<td>GraphConfidence</td>
</tr>
<tr>
<td>vector plot</td>
<td>lines</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>Graph Component</td>
<td>Style Attributes</td>
<td>Corresponding Style Element</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>contour plot</td>
<td>lines appl...resents: Line, LabeledLine, LabeledLineFill, LineGradient, LabeledLineGradient</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>fill</td>
<td>appl...es: Fill, Gradient, LineFill, LineGradient, LabeledLineFill, LabeledLineGradient</td>
<td>ThreeColorRamp</td>
</tr>
<tr>
<td>labels</td>
<td>appl...es: LabeledLine, LabeledLineFill, LabeledLineGradient</td>
<td>GraphValueText</td>
</tr>
<tr>
<td>fringe plot</td>
<td>lines</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>normal and kernel plots</td>
<td>line</td>
<td>GraphFit</td>
</tr>
<tr>
<td>loess, regression, PBspline</td>
<td>line</td>
<td>GraphFit</td>
</tr>
<tr>
<td></td>
<td>model band fill and outline (CLM and CLI)</td>
<td>GraphConfidence</td>
</tr>
<tr>
<td>ellipse</td>
<td>outline and markers</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>reference and drop lines</td>
<td>line</td>
<td>GraphReference</td>
</tr>
<tr>
<td>line (point-and-slope)</td>
<td>line</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td>Graph Component</td>
<td>Style Attributes</td>
<td>Corresponding Style Element</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>block, stack block plots</td>
<td>alternate fill colors</td>
<td>GraphBlock, GraphAltBlock</td>
</tr>
<tr>
<td></td>
<td>outline</td>
<td>GraphDataDefault</td>
</tr>
<tr>
<td></td>
<td>values</td>
<td>GraphValueText</td>
</tr>
<tr>
<td></td>
<td>labels</td>
<td>GraphLabelText</td>
</tr>
<tr>
<td>title</td>
<td>text</td>
<td>GraphTitleText</td>
</tr>
<tr>
<td>footnote</td>
<td>text</td>
<td>GraphFootnoteText</td>
</tr>
<tr>
<td>text entry</td>
<td>text</td>
<td>GraphValueText</td>
</tr>
<tr>
<td>cell heading</td>
<td>text</td>
<td>GraphValueText</td>
</tr>
<tr>
<td>legend</td>
<td>title text</td>
<td>GraphLabelText</td>
</tr>
<tr>
<td></td>
<td>title background color</td>
<td>GraphHeaderBackground</td>
</tr>
<tr>
<td></td>
<td>legend background color</td>
<td>GraphLegendBackground</td>
</tr>
<tr>
<td></td>
<td>values</td>
<td>GraphValueText</td>
</tr>
<tr>
<td>graph</td>
<td>fill color for the background of the graph</td>
<td>GraphBackground</td>
</tr>
<tr>
<td></td>
<td>graph border</td>
<td>GraphBorderLines</td>
</tr>
<tr>
<td></td>
<td>color for the background and border of the walls</td>
<td>GraphWalls</td>
</tr>
<tr>
<td>Graph Component</td>
<td>Style Attributes</td>
<td>Corresponding Style Element</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>axis</td>
<td>text for the axis label</td>
<td>GraphLabelText</td>
</tr>
<tr>
<td></td>
<td>text for the axis tick values</td>
<td>GraphValueText</td>
</tr>
<tr>
<td></td>
<td>axis lines and tick marks</td>
<td>GraphAxisLines</td>
</tr>
<tr>
<td></td>
<td>horizontal and vertical grid lines that are drawn at major tick marks</td>
<td>GraphGridLines</td>
</tr>
<tr>
<td></td>
<td>display options (auto, on, off)</td>
<td></td>
</tr>
</tbody>
</table>
Part 4

Multi-Cell Graphs

Chapter 15
Overview of Multi-Cell Graphs ........................................ 219

Chapter 16
Creating Heterogeneous Panels ...................................... 223

Chapter 17
Working with Cell Headers ............................................. 237

Chapter 18
Creating Classification Panels ....................................... 241

Chapter 19
Creating Scatter Plot Matrices ...................................... 251
Overview of Multi-Cell Graphs

About Multi-Cell Graphs in ODS Graphics Designer

A graph can contain multiple cells, and the cells can have one or more plots. For a visual depiction of graphs and cells, see “Components of a Graph” on page 39.

In ODS Graphics Designer, you can create the following types of multi-cell graphs:

- Heterogeneous panel
  a paneled graph in which each cell is defined independently and can contain different types of plots.
Classification panel

A panel that uses data-driven layouts (such as a data lattice or a data panel) and creates a grid of cells based on a graph prototype and one or more classification variables. The number of the cells is determined by the values of the classification variables.

Scatter plot matrix

A grid of scatter plots showing pairwise combinations of multiple numeric variables.
Summary of the Main Differences among Multi-Cell Graphs

The following table summarizes how the various multi-cell graphs differ from each other. For more details about a particular type of graph, see the chapter for that graph.

<table>
<thead>
<tr>
<th>Heterogeneous Panel</th>
<th>Classification Panel</th>
<th>Scatter Plot Matrix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cells are added to the graph as needed. Cells are added as full rows and columns.</td>
<td>The number of cells is determined by the unique values of one or more classification variables.</td>
<td>The number of cells is determined by the matrix variables.</td>
</tr>
<tr>
<td>Each cell can be based on a different data set.</td>
<td>Each cell shows data from the same data set, but for a different crossing of one or more classification variables.</td>
<td>The cells use data from the same data set, but with different combinations of variables.</td>
</tr>
<tr>
<td>Each cell can contain different plots.</td>
<td>All cells contain the same plot types.</td>
<td>The non-diagonal cells contain only scatter and ellipse plots. No other type is allowed.</td>
</tr>
<tr>
<td>Heterogeneous Panel</td>
<td>Classification Panel</td>
<td>Scatter Plot Matrix</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Plot properties can be modified separately for each cell.</td>
<td>Plot property changes made to any cell are applied to all the cells of the graph.</td>
<td>Plot property changes made to any non-diagonal cell are applied to all non-diagonal cells of the graph.</td>
</tr>
<tr>
<td>Titles, footnotes, cell headers, and discrete and global legends can be added to the graph.</td>
<td>Titles, footnotes, and global legends can be added to the graph.</td>
<td>Titles and footnotes can be added to the graph.</td>
</tr>
</tbody>
</table>
Creating Heterogeneous Panels

About Heterogeneous Panels .................................................. 223
Creating a Heterogeneous Panel ............................................. 225
Create a Heterogeneous Panel from the Graph Gallery .......... 225
Create a Heterogeneous Panel from a Blank Graph Window .... 226
Adding Rows and Columns to a Graph ................................. 227
Overview of Adding Rows and Columns ......................... 227
Add a Row or Column ........................................................... 229
Move a Row or Column ......................................................... 229
Resize a Row or Column ....................................................... 230
Sharing or Unsharing a Common External Axis ................. 231
About Shared Axes ............................................................... 231
Share or Unshare a Common External Axis .................... 233
Remove a Row or Column from a Graph ......................... 234

About Heterogeneous Panels

A heterogeneous panel contains multiple cells. Each cell is defined independently and can contain different types of plots. Here is an example of a simple heterogeneous panel:
Here are the characteristics of heterogeneous panels:

- Cells are added to the graph as needed in rows and columns.
- Each cell can be based on a different data set.
- You populate each cell explicitly with the plots that you want.
- Rows and columns can be added, deleted, and repositioned.
- The designer supports only rectangular cells. In addition, cells cannot span multiple rows or columns.
- Rows and column axes can be independent or common.
- You can modify plot properties separately for each cell.
- Axis data ranges can be uniform or independent.
Creating a Heterogeneous Panel

Create a Heterogeneous Panel from the Graph Gallery

To create a heterogeneous panel from the Graph Gallery:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2. Select the heterogeneous panel that you want. Examples of heterogeneous panels include the Data Profile 1 graph and the Time Series graph, both on the Analytical tab.

3. Click OK.

   A message box informs you that you must change the data for each cell independently. Click OK to dismiss the message box. (You can check the Don't show this dialog again check box to prevent the message from appearing again.)

4. Change the data that is assigned to the plots in a cell. For instructions, see “Change the Data Assignment for a Plot in a Graph” on page 53.

   Repeat this step for each cell.

Note: As an alternative to this procedure, you can select a single-cell graph from the Graph Gallery and assign data to the graph. Then you can add rows and columns to create a heterogeneous panel.

After you have created the graph, you can add or remove cells and plots and make other changes. For example, you can add titles, footnotes, and legends to the graph. You can also change the sizes of the rows, columns, or both. For instructions, see “Resize a Row or Column” on page 230.
Create a Heterogeneous Panel from a Blank Graph Window

To create a heterogeneous panel from a blank graph window:

1. Select **File ▶ New ▶ Blank Graph**. An empty graph appears.

2. Perform the following sequence:

   a. Add a row or column to the graph. For instructions, see “Adding Rows and Columns to a Graph” on page 227.
   
      The graph now contains two cells, either in two rows or in two columns.

   b. Add a plot to one of the empty cells. For instructions, see “Add a Plot to a Graph” on page 48.
   
      The Assign Data dialog box appears.

   c. Assign data to the plot. For instructions, see “Assign Data to a New Plot” on page 50.

   d. Repeat the previous two steps for the other cell.

   e. (Optional) Add more plots to either cell, and assign data to the plots.

3. (Optional) Add more rows or columns to the graph. For each new cell that is created, add one or more plots and assign data to the plots.

After you have created the graph, you can customize the graph. For example, you can add titles, footnotes, and legends to the graph. You can also change the sizes of the rows, columns, or both. For instructions, see “Resize a Row or Column” on page 230.
Adding Rows and Columns to a Graph

Overview of Adding Rows and Columns

In a heterogeneous panel, the cells in a graph are arranged in rows and columns. Each cell is defined independently and can contain different types of plots. For more information about cells, see “Components of a Graph” on page 39.

You can add multiple rows and columns to a graph. The limit to the number of rows and columns that you can add depends on the size of your graph. As you add more rows and columns, the individual cells shrink proportionally.

Here is an example of a heterogeneous panel that has one column and two rows, for a total of two cells:
You can add only complete rows and columns to the graph. In addition, cells cannot span across multiple rows or columns. For example, suppose that you have a graph layout with two rows and two columns.

**Figure 16.2  Example Layout**

![Example Layout]

You cannot have two cells in the first row and a merged single cell in the second row.

**Figure 16.3  Unsupported Layout**

![Unsupported Layout]

However, you can leave a cell blank as shown here.

**Figure 16.4  Modified Layout**

![Modified Layout]
Add a Row or Column

To add a row or column to a graph:

1  Create a new graph or open an existing graph.
   
   **Note:** The graph cannot be a classification panel or a scatter plot matrix. You cannot add rows and columns to those types of graphs.

2  Right-click anywhere within the plot area of the graph and choose one of the following:
   
   - **Add a Row**
   - **Add a Column**

   **Note:** You can also access these commands from the **Insert** menu and from the toolbar.

   Depending on your choice, a row or column is added to the graph. The row or column contains one or more empty cells.

3  (Optional) Repeat the previous step to add another row or column to the graph.

After you add cells to a graph, you must manually add plots to the new cells and assign data to those plots. For more information, see these topics:

- “Add a Plot to a Graph” on page 48
- “Assign Data to a New Plot” on page 50

Move a Row or Column

In a heterogeneous panel, you can move a column left or right and a row up or down.

To move a column:

1  Right-click within a cell in the column that you want to move.
Choose one of the following as applicable:

- **Move Column ➤ Right**
- **Move Column ➤ Left**

Depending on the number of columns and the position of the selected column, your menu might display only one of these options.

To move a row:

1. Right-click within a cell in the row that you want to move.

2. Choose one of the following as applicable:
   - **Move Row ➤ Down**
   - **Move Row ➤ Up**

Depending on the number of rows and the position of the selected row, your menu might display only one of these options.

---

**Resize a Row or Column**

You can change the width of the columns and the height of the rows in a heterogeneous panel. For example, you might want a particular column to be wider than the others.

To resize a column:

1. Position the cursor between the column that you want to change and an adjacent column. A dashed line appears between the columns and the cursor changes to a horizontal two-headed arrow ↔.

2. Click and drag the dashed line left or right to change the width of the column.

   If you widen the column, the adjacent column becomes narrower. If you narrow the column, the adjacent column becomes wider.
To resize a row:

1. Position the cursor between the row that you want to change and an adjacent row. A dashed line appears between the rows and the cursor changes to a vertical two-headed arrow \(\uparrow\downarrow\).

2. Click and drag the dashed line upward or downward to change the height of the row. If you make the row taller, the adjacent row becomes shorter. If you make the row shorter, the adjacent row becomes taller.

---

Sharing or Unsharing a Common External Axis

About Shared Axes

In a heterogeneous panel, the cells can share a common axis if the cells have the same axis type. In the graph shown here, the cells can share a common column axis because both cells in the column have the same data type (Date) for the X axis.
When you share an X axis, you replace the X axes of all cells in the column with one external column axis. Similarly, when you share a Y axis, you replace the Y axes of all cells in the row with one external row axis.

Here is the result of creating a common column axis:
Note:

- The axes that you intend to share must be the same type. For example, you cannot share a discrete axis with a linear axis.

- The axes must be on the same side of the graph. The axes can be either primary or secondary, but both axes must be the same.

- If the axes have the same variable name, then the new common axis label uses that existing name. However, if the axes use different variable names, the axis label displays the text Type in your axis label.

- A common axis implies a data union. If the data ranges of the individual axes are not the same, the common axis uses the union of the data from all axes to be shared as its data range. All the graphs are redrawn appropriately. For more information about data ranges, see “About the Axis Data Range” on page 188.

Share or Unshare a Common External Axis

To share or unshare a common axis:

1 To share an axis, right-click the axis that you want to share.
2 Select one of the following, depending on whether you selected an X or Y axis:

- **Common Column Axis** (X axis)
- **Common Row Axis** (Y axis)

A check mark appears next to the menu item that you select. The check mark indicates that the column or row axis has been shared and is now a common external axis.

**Note:** You can also make these selections in the Graph Properties dialog box.

3 To unshare a common axis that has been shared, right-click the axis and select the menu item with the check mark. The check mark disappears, indicating that the column or row axis is no longer shared.

---

### Remove a Row or Column from a Graph

When you remove a row or column from a heterogeneous panel, all cells in the row or column are removed.

You cannot remove a row or column under the following conditions:

- The cells in the row or column share a common axis. You must first unshare the common axis. For instructions, see “Share or Unshare a Common External Axis” on page 233.
- The row or column that you want to remove is the only row or column in the graph. For example, if a graph has two rows and one column, you can remove one of the rows, but you cannot remove the column.

To remove a row or column from a heterogeneous panel:

1 Right-click within a cell in the row or column that you want to remove.

2 Choose one of the following:

- **Remove Row**
Remove Column

Depending on your choice, the row or column is removed from the graph.
Working with Cell Headers

Add a Header to a Cell ................................................................. 237
Edit and Format a Cell Header .................................................. 238
Change the Position of a Cell Header ....................................... 240
Remove a Header from a Cell .................................................... 240

Add a Header to a Cell

You can add one or more headers to the individual cells in a heterogeneous panel.

Note: Headers are specific to cells. If you want to add header text to the graph as a whole, add a title.

To add a header to a cell:

1  Click and drag the Cell Header icon from the Insets panel to the cell.

   The Cell Header icon looks like this:  

   ![Cell Header Icon]

   You can also right-click inside a graph cell and choose Add an Element. Then click the Cell Header icon from the Elements pop-up window.

   The following text box is displayed above the cell.

   ![Type in your header...]

237
2 In the text box, enter the text that you want for the header.

3 (Optional) Repeat the previous steps to add additional headers.

After you create the header, you can format or move the header.

---

**Edit and Format a Cell Header**

If you want to edit only the text of a cell header, the ODS Graphics Designer provides a quick way to do this.

To edit the text of a cell header:

1 Double-click the existing text.

2 Enter the text that you want.

To edit and format the text, you must use the Text Properties dialog box.

To edit and format a cell header:

1 Right-click the header and select **Cell Header Properties**.
   
   The Text Properties dialog box appears.
2 To change the text, select all or part of the text in the **Text entry** box. Then enter your changes.

3 You can format the text by applying a different style element or by setting explicit text properties as follows:

   - Apply a different style element to the text. For more information, see “Specifying Style Elements for Text Properties” on page 113.

   - Change the color of the text. For more information about selecting colors, see “Using the Color List Box” on page 115.

   - Change the font family of the text.

   - Change the size of the text.

   - Change the style (bold, italic) of the text.

4 Click **OK**.
Change the Position of a Cell Header

You can position a cell header in the center, left, or right side of the cell.

To position a cell header:

1. Right-click the header and select **Cell Header Properties**.
   The Text Properties dialog box appears.

2. Select the position that you want from the **Position** list box.

3. Click **OK**.

Remove a Header from a Cell

To remove a cell header, right-click the header and select **Remove Cell Header**.

The header is removed from the cell.
Creating Classification Panels

**About Classification Panels** .......................................................... 241

**Creating a Classification Panel** ..................................................... 243
  Methods for Creating a Classification Panel .............................. 243
  Create a Classification Panel By Using the Graph Gallery ........... 244
  Create a Classification Panel from a Blank Graph Window .......... 246
  Change a Single-Cell Graph to a Classification Panel .............. 248
  About Data Lattices and Data Panels ................................. 249

**About Classification Panels**

A classification panel can be defined using a lattice or a panel layout. Both layouts are data-driven layouts that create a grid of cells based on one or more panel (or classification) variables. The number and layout of the cells is determined by the unique values of the panel variables.

Here is an example of a simple classification panel:
Here are the characteristics of classification panels:

- You can define up to two panel variables in the designer.
- All panel and plot variables must come from a single data set.
- Plots can be added to a classification panel the same way they are added to cells in other graphs. When you add a plot to any cell of the panel, the plot is displayed in every cell. The plot is displayed with the appropriate subset of the data for the combination of the panel variables.

**Note:** Ellipse plots cannot be added to classification panels.

- When you change the plot data or properties in one cell, the change is applied to all the cells of the graph.
Creating a Classification Panel

Methods for Creating a Classification Panel

The ODS Graphics Designer enables you to create classification panels in several ways:

- If the classification panel that you want to create exists in the Graph Gallery (in the Panels tab), then you can create the graph by opening the predefined graph from the gallery. For more information, see “Create a Classification Panel By Using the Graph Gallery” on page 244.

- You can start from a blank graph window and then add one or more plots to create your graph. When you assign data to the plot, you specify both plot and panel variables. For more information, see “Create a Classification Panel from a Blank Graph Window” on page 246.

- If you have an existing single-cell graph that you want to use as the basis for your classification panel, you can convert the single-cell graph to a panel. Most single-cell graphs can be converted to classification panels. For more information, see “Change a Single-Cell Graph to a Classification Panel” on page 248.

Note:

- Multi-cell heterogeneous panels cannot be converted to classification panels.
- Graphs that contain an ellipse plot cannot be converted to classification panels.

The following sections describe these methods of creating classification panels.
Create a Classification Panel By Using the Graph Gallery

The Panels tab of the Graph Gallery contains several predefined classification panels. For graphs that are created from the Graph Gallery, placeholder data is assigned to the graph. You typically will change the data as appropriate for your graph.

To create a classification panel:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2. Click the Panels tab.

   Note: If you have created a classification panel and saved it to the Graph Gallery in a custom tab, then you can select your custom tab instead.

3. Select the classification panel that you want to use, and click OK. The Assign Data dialog box appears and displays the Panel Variables tab.
4 Specify the SAS library and data set you want to use by selecting the appropriate items from the **Library** and **Data Set** list boxes.

5 In the **Variables** section, assign a data variable to a classification role. To assign a variable, select the variable from the list box next to the role's label. You can assign up to two classification roles.

6 Click the **Plot Variables** tab and assign variables for the plot. For more information, see “Change the Data Assignment for a Plot in a Graph” on page 53.

   If the graph contains more than one plot, select each plot from the **Plot** list box and assign variables.

7 Click **OK**.
After you have created a graph, you can perform additional steps to customize your graph. For example, you might add another plot to the graph or change plot properties. You can also add titles, footnotes, and make other changes to the graph. For more information about the tasks that you can perform, see “High-Level Steps for Designing Graphs” on page 43.

**Create a Classification Panel from a Blank Graph Window**

To create a classification panel from a blank graph window:

1. Select **File ➤ New ➤ Blank Graph**, or click the New Blank Graph toolbar button.

2. Add a plot to the blank graph. For more information, see “Add a Plot to a Graph” on page 48.

   The Assign Data dialog box appears.

3. In the Assign Data dialog box, assign the data for the plot in the graph. For more information, see “Assign Data to a New Plot” on page 50.

4. Click the **Panel Variables** tab.
5 Select the **Data Lattice** or the **Data Panel** check box. For more information, see “About Data Lattices and Data Panels” on page 249.

6 In the **Variables** section, assign a data variable to a classification role. To assign a variable, select the variable from the list box next to the role's label. You can assign up to two classification roles.

   The dialog box displays the number of cells for the panel based on the values of the classification variables.

7 Click **OK**.

After you have created a graph, you can perform additional steps to customize your graph. For example, you might add another plot to the graph. You can also add titles,
footnotes, and make other changes to the graph. For more information about the tasks that you can perform, see “High-Level Steps for Designing Graphs” on page 43.

**Change a Single-Cell Graph to a Classification Panel**

To change an existing single-cell graph to a classification panel:

1. Open the single-cell graph that you want to change. A single-cell graph contains one row and one column.

   **Note:** Not all single-cell graphs can be changed to classification panels. For example, you cannot change single-cell graphs that have any of these characteristics:
   - contain a (confidence) ellipse
   - use both the X and X2 axes or both the Y and Y2 axes
   - contain cell legends

2. Right-click an existing plot and select **Assign Data**. The Assign Data dialog box appears.

3. If you want to change the SAS library or data set, select the appropriate items from the **Library** and **Data Set** list boxes.

   After you change the library or data set, the plot labels might appear red. This color indicates that required variables do not exist in the new data set, and that you must reassign variables for the plots. When you reassign variables, the plot name changes to black.

4. If necessary, assign variables to the plot roles. For more information, see “Change the Data Assignment for a Plot in a Graph” on page 53.

5. Click the **Panel Variables** tab.

6. Select the **Data Lattice** or the **Data Panel** check box. For more information, see “About Data Lattices and Data Panels” on page 249.
In the **Variables** section, assign a data variable to a classification role. To assign a variable, select the variable from the list box next to the role’s label. You can assign up to two classification roles.

The dialog box displays the number of cells for the panel based on the values of the classification variables.

Click **OK**.

After you have modified the graph, you can perform additional steps to customize your graph. For example, you might add another plot to the graph or change plot properties. You can also add titles, footnotes, and make other changes to the graph. For more information about the tasks that you can perform, see “High-Level Steps for Designing Graphs” on page 43.

### About Data Lattices and Data Panels

When you change the data assignment for a classification panel, you can select one of the following layout options:

**Data Lattice**

Headers appear along the top (for column classification variables) and the side (for row classification variables).

If there are no observations for a particular crossing of the classification variables, the designer creates a blank cell for the crossing. For example, suppose that you create a graph with two classification variables: gender and year. Now suppose that there is no data for females in the year 2005. The designer creates a cell for females in 2005, but leaves the cell blank.

**Data Panel**

Headers appear in each cell.

If there are no observations for a particular crossing of the classification variables, the designer might not create the cell. The designer creates blank cells only to complete the panel grid. For example, suppose that your graph contains 10 columns and 10 rows, and only 40% of the cells have data. Instead of having blank cells (as with the lattice) for 60 of the 100 cells, the designer creates a smaller graph. In this example, the graph contains eight rows and five columns.
Creating Scatter Plot Matrices

About Scatter Plot Matrices .......................................................... 251
Create a Scatter Plot Matrix ......................................................... 253

About Scatter Plot Matrices

You can create a multi-cell graph that has a scatter plot matrix layout. Here is an example of a scatter plot matrix:
Here are the characteristics of scatter plot matrices:

- The matrix is a data-driven graph based on matrix variables.
- The diagonal cells can be populated with a histogram and up to two density plots.
- The non-diagonal cells contain a scatter plot for the crossing variables with an optional mean or prediction ellipse.
- You can change the properties of a scatter plot matrix as follows:
  - You cannot change the properties of the histograms, density plots, and ellipses.
  - You can change the marker properties for the scatter plots. When you change the marker properties, the change is applied to all non-diagonal cells.
  - You can change the transparency of all plots.
  - You can change the outline and background properties of the graph.

For more information, see the sections on changing graph and plot properties.
Create a Scatter Plot Matrix

To create a scatter plot matrix:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2. Select the Matrix tab.

3. Select the predefined matrix graph that you want to use. You can choose from two different types:
   - NxN matrix: The first four predefined matrix graphs in the Graph Gallery create an NxN matrix. This matrix uses one list of variables. It creates a square grid of cells using the list of N variables along the rows and columns.
   - MxN matrix: The last two graphs in the Graph Gallery create an MxN matrix. This type of matrix crosses two lists of variables and creates a rectangular matrix without any diagonal cells.

4. Click OK. The Assign Data dialog box appears.
5 Specify the SAS library and data set you want to use for the plot by selecting the appropriate items from the **Library** and **Data Set** list boxes.

6 In the **Roles** section, select the check box for each variable that you want in the graph. If you want to select all items, then select the check box in the heading.

   For an MxN matrix, select the variables from two lists, one for column variables and another for row variables.

7 (NxN matrices only) In the **Diagonal Cells** section, select the plot types for the diagonal cells. You can choose a histogram and up to two density plots.

8 If you want an ellipse to appear in the cells, do the following:

   a Check the **Ellipse** check box.
b Select either Mean or Predicted.

c You can either change the Alpha value or keep the default value.

For anNxN matrix, the ellipse appears in the non-diagonal cells.

9 If you want a more descriptive name for the plot, enter the name in the Name text box. This name identifies the plot in the Assign Data dialog box, in the Cell Properties dialog box, and other places within the application.

By default, the designer uses generic names for each plot. It is good practice to assign a descriptive name that indicates a response variable or some identifying characteristic of the plot.

10 Click OK.

Here is an MxN rectangular matrix:
Using Shared Variables in Graphs

About Shared Variables .......................................................... 259
Main Features of Shared Variables ............................................. 261
Requirements for Creating Shared-Variable Graphs .................. 261
Create a Shared-Variable Graph ............................................. 262
Change the Data That Is Used in a Shared-Variable Graph ...... 265

About Shared Variables

ODS Graphics Designer enables you to create graphs that use shared variables. Shared variables provide these benefits:

- They enable the reuse of a plot that uses one or more common shared variables.
- They enable the reuse of different plots in a graph that use one or more common shared variables.

For example, suppose that you have created the following graph:
This example involves a multi-cell graph with three cells that each contain one or more plots. All plots use the same variable: HORSEPOWER. The example is based on SASHELP.CARS data.

This graph is very effective for visualizing the distribution of a measure. After you have created this graph, you might want to reuse it to view the distribution of some other variable in the same or different data set.

For example, you might want to use the example graph to visualize the distribution of the MPG_CITY variable. In graphs that are not created with shared variables, you must change the variable for each cell individually. Because the X axis is shared, during the changes the X axis might briefly display data from both HORSEPOWER and MPG_CITY. However, when graphs are created with shared variables, you can change one or more variables for all plots simultaneously in a single step. Shared variables facilitate the reuse of graphs, and are especially effective in graphs that have multiple plots.
Main Features of Shared Variables

Here are the main features of shared variables:

- Shared variables enable you to easily reuse a graph with different data.
- Shared variables can be used in single-cell graphs and in multi-cell graphs, including classification panels.
- You can change one or more variables for all plots at one time, including plots that are in different cells of a multi-cell graph.
- Shared variables are most effective for creating graphs that have many plots and that use very few (one or two) variables. The graph shown in Figure 20.1 on page 260 is a good example because it has several plots and uses just one variable.
- You can run shared-variable graphs in batch mode by using the SGDESIGN procedure. You can specify different variables in the same or in a different data set by using the DYNAMIC option.

You can also use the DYNAMIC option to generate dynamic text, such as a title, that changes depending on the data that is used to generate the graph. For more information about dynamic content in text, see “Adding Dynamic Content to Text” on page 117.

See Also

“About the SGDESIGN Procedure” on page 5

Requirements for Creating Shared-Variable Graphs

Shared-variable graphs are created the same way as other graphs in the designer, but have the following additional requirements:
The entire graph must be created from one data set. You assign the data set when you create the shared-variable graph.

You also define the shared variables when you first create the graph, before you add any plots. (You can later add shared variables and remove unused shared variables.)

All plots are created using only the shared variables that have been defined for the graph.

Create a Shared-Variable Graph

To create a shared-variable graph, you first define one or more shared variables. Then, you add one or more plots and assign the shared variables to the plot roles.

To create a shared-variable graph:

1. Select File ➤ New ➤ Blank Shared Variable Graph. The following occur:

   - A blank shared-variable graph is created. The graph is identified by a shared-variable icon 📊 in the top left corner.

   - The Assign Data dialog box appears and displays the Shared Variables tab. The other tabs are present but are dimmed.
2 In the Assign Data dialog box, specify the SAS library and data set that you want to use for the graph. Select the appropriate items from the **Library** and **Data Set** list boxes.

3 Assign data variables to one or more shared variables:

   a Select a data variable from the **Variable** list box.

   b Select a variable type from the **Type** list box.

      Though you can leave the default Any type, it is good practice to specify a variable type. Some plots, such as histograms, require that the variable be a particular type.

      Once you specify a variable type, the **Variable** list box contains only the variables of that type.

   c To add another shared variable, click the Add a Variable icon 🔄 and then repeat the previous two steps for the new variable. Shared variables are identified as V1, V2, and so on.
When you are finished assigning shared variables, click OK.

Add a plot to the graph. For instructions, see “Add a Plot to a Graph” on page 48. The Assign Data dialog box appears and displays the Plot Variables tab.

In the Variables section, assign a shared variable to each plot role that is listed. (Some roles might be optional.)

For example, in the following display, you would assign a variable to the X and Y roles. For more information about plot roles, see “About Plot Roles” on page 50.

Note:

- Only predefined shared variables are available from the list boxes.
- Some plots require a variable of a specific type.

For example, the analysis variable for a histogram must be a numeric type. If the shared variable used has a type of Any in the Shared Variable tab, then the ODS Graphics Designer displays a warning message and changes the type to numeric.
You cannot change the library or data set at this time. Their respective list boxes are dimmed.

The **Fit an existing plot** check box is not available for plot overlays, such as the normal plot. This check box is available only for non-shared-variable graphs.

The procedure for assigning shared variables is similar to the procedure for assigning data variables. For more information, see “Assign Data to a New Plot” on page 50.

6 Click **OK**.

Perform additional steps as needed to customize your graph. For example, you might add another plot or more cells to the graph, or specify panel variables. You can also add titles, footnotes, and make other changes to the graph. For more information about the tasks that you can perform, see “High-Level Steps for Designing Graphs” on page 43.

---

**Change the Data That Is Used in a Shared-Variable Graph**

After you have created a shared-variable graph, you can specify different data variables in the same or in a different data set. You make this change in the Assign Data dialog box for any of the plots in the graph, and the change is propagated to all plots in the graph.

To change the shared variables:

1 Right-click inside the plot area of a cell in the graph, and select **Assign Data**.
   
   The Assign Data dialog box appears.

2 Click the **Shared Variables** tab.

3 If you want to change the SAS library or data set, select the appropriate items from the **Library** and **Data Set** list boxes.
If you change the library or data set, the labels for one or more shared variables might appear red. This color indicates that a shared variable is being used in a plot and that you must reassign a data variable. In this display, the labels for V1 and V2 are red.

4 To reassign a data variable to a shared variable:
   a. For each shared variable that you want to reassign, select the data variable from its **Variable** list box.
   
   The variables available in the list box depend on the variable type. For example, if the type is **Numeric**, then only numeric variables are listed. For a type of **Any**, all variables are listed.

   b. Select a variable type from the **Type** list box.
   
   You cannot change the data type if the variable is being used by any plot in the graph. The **Type** list box is dimmed to restrict assignment to like variables. For example, if V2 is being used in a histogram, then only a numeric variable can be chosen.

   c. Repeat the previous steps for each shared variable.

5 To add a new shared variable, click the Add a Variable icon 📈 and then assign a data variable and type to the new shared variable.

6 To remove a shared variable that you have added, click the variable to select the row. For example, click **V3** to select a shared variable named V3.
Then click the Delete a Variable icon \(\times\).

**Note:** You cannot delete a shared variable that is currently used by any of the plots in the graph.

7 Click **OK**.

**Note:** If you want to assign different shared variables to the variable roles in a plot, you can make this change in the **Plot Variables** tab of the Assign Data dialog box for the plot. If the cell contains more than one plot, select each plot from the **Plot** list box and assign shared variables. Assigning shared variables is similar to assigning data variables. For more information, see “Change the Data Assignment for a Plot in a Graph” on page 53.
Part 6

Managing Preferences and the Graph Gallery

Chapter 21

Setting Preferences .......................................................... 271

Chapter 22

Managing Graphs in the Graph Gallery ............................. 281
Overview of the Preferences

ODS Graphics Designer enables you to enter your personal preferences for displaying graphs. For example, you can specify the default ODS style and whether the Graph Gallery is displayed when you start the application. You can also make changes that affect how a graph is rendered.

Here is a summary of the preferences that you can set. For more detailed descriptions of these preferences, see “Setting Preferences” on page 272.

- general preferences, which include the default size of a graph, the default data skin, and more
- rendering preferences, such as whether to use anti-aliasing for some text elements, and more
- a preference for storing graphs that were generated with the Auto Charts feature
Setting Preferences

Set Preferences

To set your preferences:

1. Select **Tools ▶ Preferences**. The Preferences dialog box appears.

2. Change the settings for the preferences. Your changes take effect immediately after you click **OK**.

   The Preferences dialog box contains the following tabs in which you can change preferences:
   - **Graph tab on page 273**
   - **Render tab on page 277**
   - **Auto Chart tab**
Settings on the Graph Tab

Figure 21.1  Graph Tab of the Preferences Dialog Box

The following sections describe the fields in this dialog box.

Graph size
To change the size that is used for graphs, click the up and down arrows in the **Width** and **Height** list boxes. The width and height are measured in pixels. Clicking an arrow changes the value by 10 pixels. Alternatively, you can enter values in the boxes. By default, graphs are created with a width of 640 pixels and a height of 480 pixels.
To determine the size in inches, you can compute the value in pixels by using a default DPI of 100. For example, if you want a width of five inches, then specify a width of 500 pixels.

To size the graph proportionally, make sure that the **Keep aspect ratio** check box is selected. If you want to specify the width and height independently without retaining the current aspect ratio, then clear the check box. (This check box facilitates setting the width and height check boxes and is not itself a preference. If you clear the check box and later reopen the Preferences dialog box, the check box is still selected.)

The size setting applies to all new graphs, including graphs that you create from the Graph Gallery.

**Default style**

By default, graph SGD files use the ODS Listing destination style. You can select another style from the list box, including a custom style that has been created by using the designer.

The style setting applies only to newly created, blank graphs. Any existing SGD files or graphs that are opened from the Graph Gallery retain their current style.

To see a representative sample for any of the styles, open the Graph Style Editor and select the style. An image of the style is displayed in the right side of the editor. To open the editor, select **Tools ▶ Style Editor**.

**Default Attr Priority**

Select the attribute priority that determines the rotation pattern that is used by default for group values when you apply a group role to your graph. For more information, see “**Understanding Attribute Priority**” on page 128.

**Default Data Skin**

The data skin affects the appearance of the fill for particular charts. The following images show the skins that are available.
Recently used files
Specify the number of recently used files to display (when you select File ▶ Open Recent). You can use the up and down arrow or enter a value in the box. The value that you specify must be greater than one.

Graph Gallery at start-up
Select or clear the check box to show or hide the Graph Gallery when the designer is started. This setting takes effect the next time you start the designer.

Use skin
Select the check box to show an embellished interface for the Elements pane and the Add an Element pop-up window. If you clear the check box, then a simpler interface is used. The check box is selected by default.

For displays that show both the embellished interface and the simple interface, see “About the Elements Pane” on page 16.

Show all information dialogs
Select this button to restore any information dialog boxes in which you might have selected the Don't show this dialog again option.

For example, if you open a multi-cell graph from the Analytical tab of the Graph Gallery, by default the designer displays the following dialog box:
If you choose not to show this dialog box again, you can later reverse that decision by clicking **Show all information dialogs** in the Preferences dialog box.

**Preference File location**
This file location is for informational purposes only. If you delete this file, either accidentally or intentionally, the designer regenerates the preferences with their default values the next time you start the designer.
### Settings on the Render Tab

**Figure 21.2  Render Tab of the Preferences Dialog Box**

The following sections describe the fields on this tab of the Preferences dialog box.

**Rendering options**

Select or clear the check boxes to enable or disable anti-aliasing of data labels, axis text, or both. When you select the **Axis** check box, the setting applies to axis labels and tick values. The settings have no effect on titles and footnotes.
When you enable anti-aliasing, the designer produces smooth-edged type by partially filling the edge pixels. The following letters show the difference between anti-aliasing and not anti-aliasing.

<table>
<thead>
<tr>
<th>Anti-aliased</th>
<th>Not Anti-aliased</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>A</td>
</tr>
</tbody>
</table>

Anti-aliasing creates higher quality graphs, but consumes more resources. For graphs with a very large number of observations, this option can increase the rendering time.

**Note:** These settings have no effect when the graph is re-created in SAS by using the SGDESIGN procedure.

**Data limit**
Specify the maximum number of values to display when a graph contains a group variable or a classification variable. Select or enter the number for the group variable, the classification variable, or both variables.

If a graph exceeds the number that you specify, the designer issues a warning similar to the one shown here. You can cancel the operation or continue and override the preference setting.

You can also specify the maximum number of observations in the data set to be rendered by selecting or entering a different value in the **Size** list box. If a data set exceeds the specified size, a warning message is displayed. You can then cancel
the operation or continue and override the preference setting. The minimum value that you can enter is 1,000.

These limits are in place to mitigate situations in which you select a very large data set or a classifier variable that has a large number of levels, such as a ZIP code that is used for a group variable.

**Settings on the Auto Chart Tab**

The following sections describe the fields on the Auto Chart tab of the Preferences dialog box.

**Folder Type**

By default, SAS stores graphs that are generated with the Auto Chart feature in a temporary folder. The location of that folder is displayed in the **Location** field. The folder and its contents persist as long as the Designer session is active.

To store the graphs permanently in a user-defined location, click **User**. Then navigate to the target folder. Any person who generates Auto Chart graphs must have Write permissions for the folder. The graphs remain in the specified location until the graphs are deleted.

The Auto Charts feature creates a subfolder for each data set that is used to generate graphs.
Managing Graphs in the Graph Gallery

Add a Graph to the Graph Gallery ................................................................. 282

Change the Name, Icon, or Tooltip for a Graph in the Graph Gallery ....................................................... 283

Managing the Graphs in the Graph Gallery .................................................. 285
  Main Steps for Managing Graphs .............................................................. 285
  Copy a Graph to a Custom Group .............................................................. 286
  Change the Order in Which the Graphs Appear in the Custom Tabs .................. 286
  Rename a Graph in a Custom Group ......................................................... 287
  Delete a Graph from a Custom Group ....................................................... 287

Managing the Groups in the Graph Gallery .................................................. 288
  Main Steps for Managing Groups .............................................................. 288
  Create a New Group ................................................................................. 289
  Change the Order in Which the Groups Appear in the Graph Gallery .............. 289
  Rename a Group ...................................................................................... 289
  Hide or Delete a Group ........................................................................... 290
Add a Graph to the Graph Gallery

After you have designed a graph, you can add that graph to the Graph Gallery for future reuse.

To add a graph to the Graph Gallery:

1. Select the graph that you want to add.

2. Select **File ➤ Save in Graph Gallery**. The Save in Graph Gallery dialog box appears.

3. From the **Group name** list box, select the name of the group into which you want to add the graph. Each group corresponds to a tab in the gallery.

   The **Group name** list box contains the names of groups that have been created at your site. The list box does not contain the names of the default groups.
To create a new group, click the New icon 🎨. In the New Group dialog box, enter the name that you want for the group, and then click OK.

4 In the **Graph name** text box, enter the name that you want displayed in the gallery. If a graph exists with the name that you provide, you are prompted to overwrite the existing graph. The default name is NewGraph.

5 The **Icon** field shows a small icon that ODS Graphics Designer creates to represent the graph being added to the gallery. However, if you want to use a custom icon to identify the graph, click **Browse** and locate the image that you want to use. The image can be in BMP, GIF, JPEG, or PNG format. Regardless of its original size, the image is scaled to a fixed size in the gallery.

You can revert to the automatically created icon by clicking the **Default** button. Automatically generated icons do not show the axis labels, titles, footnotes, and legends; they show only the main part of the graph.

6 In the **Tooltip** text box, enter a short description of the graph. This description is displayed as a tooltip when you hold the mouse pointer over the graph's icon. If you do not enter a tooltip description, the graph name becomes the tooltip by default.

7 Click **OK**. The graph is added to the Graph Gallery.

See Also

“Change the Name, Icon, or Tooltip for a Graph in the Graph Gallery” on page 283

---

**Change the Name, Icon, or Tooltip for a Graph in the Graph Gallery**

You can change the name, icon, and tooltip for any of the following types of graphs:

- graphs that you have added to the Graph Gallery
- graphs that you have copied to a custom group in the Graph Gallery
To change the name, icon, and tooltip for any of these graphs:

1. In the Graph Gallery, select the graph that you want to modify.

2. Right-click the graph and select **Properties**, or click **Properties** at the bottom of the gallery. The Properties dialog box appears.

3. In the **Graph name** text box, enter the name that you want to display next to the graph icon in the gallery.

4. To change the icon, click **Browse** and locate the image that you want to use to represent the graph. The image can be in BMP, GIF, JPEG, or PNG format. Regardless of its original size, the image is scaled to a fixed size in the gallery.

   You can revert to the automatically created icon by clicking the **Default** button. Automatically generated icons do not show the axis labels, titles, footnotes, and legends; they show only the main part of the graph.

5. In the **Tooltip** text box, enter a short description of the graph. This description is displayed as a tooltip when you hold the mouse pointer over the graph's icon. If you do not enter a tooltip description, the graph name becomes the tooltip by default.
6 Click OK.

Managing the Graphs in the Graph Gallery

Main Steps for Managing Graphs

Here are the main steps for managing the graphs that appear in the Graph Gallery:

1 Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2 Click Organize, and then Graphs. The Organize Graphs dialog box appears.

3 Perform management tasks as described in the following topics:
   - “Copy a Graph to a Custom Group” on page 286
   - “Change the Order in Which the Graphs Appear in the Custom Tabs” on page 286
When you are finished with your management tasks, click OK to close the Organize Graphs dialog box.

Copy a Graph to a Custom Group

You can copy a graph from one of the predefined or custom groups to a custom group that you have created.

To copy a graph to a custom group:

1. In the From Groups area of the Organize Graphs dialog box, select the group that contains the graph that you want to copy. Then select the graph in the list. To select multiple graphs, press Ctrl and make your selections. To select a block of contiguous graphs, select the first graph in the block, press Shift, and then select the last graph in the block.

2. In the To Groups area of the Organize Graphs dialog box, select the target group for the graph(s).

   Note: To create a new group, click the New icon 🗂️. In the New Group dialog box, enter the name that you want for the group, and then click OK.

3. Click the Copy arrow 🔄️ to copy the graph to the To Groups list.

Change the Order in Which the Graphs Appear in the Custom Tabs

Each group of graphs is represented as a tab in the Graph Gallery. Graphs are ordered in rows and columns on the tabs. A custom tab can contain custom graphs that you created as well as predefined graphs that have been moved to the tab.

To change the order in which the graphs appear on a custom tab:
1 In the To Groups area of the Organize Graphs dialog box, select the custom group that you want to reorder. (Only custom groups are listed.) Then select a graph in the list.

2 Click the up arrow ↑ or the down arrow ↓ to move the graph up or down in the list. The first graph in the list corresponds to the upper left corner of the tab in the gallery. Graph order starts in the upper left corner, continues across the first row, and wraps around to the second row.

3 Repeat the previous step with other graphs in the list until the graphs are in the order that you want.

**Rename a Graph in a Custom Group**

You can change the names of graphs that appear in the tabs for your custom groups.

To rename a graph:

1 In the To Groups area of the Organize Graphs dialog box, select the group that contains the graph that you want to rename. Then select the graph in the list.

2 Click the Rename icon 📝. The graph name box becomes editable.

3 Enter the name that you want for the graph.

**Delete a Graph from a Custom Group**

You can remove graphs that you have added to your custom groups.

To remove a graph:

1 In the To Groups area of the Organize Graphs dialog box, select the group that contains the graph that you want to delete. Then select the graph in the list.

2 Click the Delete icon ✗. The graph name is removed from the list.
As an alternative to this procedure, you can right-click the graph icon in the Graph Gallery and select **Delete**.

---

**Managing the Groups in the Graph Gallery**

**Main Steps for Managing Groups**

Here are the main steps for managing the groups that appear as tabs in the Graph Gallery:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2. Click **Organize**, and then **Groups**. The Organize Groups dialog box appears.

3. Perform management tasks as described in the following topics:
   - “Create a New Group” on page 289
Change the Order in Which the Groups Appear in the Graph Gallery” on page 289
“Rename a Group” on page 289
“Hide or Delete a Group” on page 290

4 When you are finished with your management tasks, click OK to close the Organize Groups dialog box.

Create a New Group

Each group that you create is represented as a tab in the Graph Gallery.

To create a new group:

1 In the Organize Groups dialog box, click Create New Group. The New Group dialog box appears.

2 In the Name text box, enter a name for the group.

3 Click OK.

Change the Order in Which the Groups Appear in the Graph Gallery

To change the order in which the groups appear in the gallery:

1 In the Organize Groups dialog box, click the name of a group to highlight it in the list.

2 Click the up arrow ↑ or the down arrow ↓ to move the group up or down in the list.
   The first group in the list appears as the first tab in the Graph Gallery.

Rename a Group

You can change the names of groups that you have created.
To rename a group:

1. In the Organize Groups dialog box, click the name of a group to highlight it in the list.
2. Click the Rename icon. The group name box becomes editable.
3. Enter the name that you want for the group.

**Hide or Delete a Group**

You can delete a group that you have created. You can also temporarily hide a group's tab in the Graph Gallery.

To remove a group:

1. In the Organize Groups dialog box, click the name of a group to highlight it in the list.
2. Click the Delete icon. The group name is removed from the list.

To hide a group, clear the check box next to the name of the group that you want to hide. When you want the group's tab to appear again in the gallery, select the check box for the group.
Part 7

Examples

Chapter 23

*Examples for Creating Single-Cell Graphs* .......................... 293

Chapter 24

*Examples for Creating Multi-Cell Graphs* .......................... 307
Examples for Creating Single-Cell Graphs

**Example: Create a Grouped Series Plot** ................................................................. 294
  About This Example ............................................................................................... 294
  Step One: Create the Graph and Assign Data ....................................................... 295
  Step Two: Change a Plot Line Property .................................................................. 295
  Step Three: Customize the Title and Remove the Footnote ................................. 296
  Step Four: Add and Reposition a Discrete Legend ................................................. 296

**Example: Create a Scatter Plot with Modified Axis Labels and Two Titles** ........ 297
  About This Example ............................................................................................... 297
  Step One: Create the Graph and Assign Data ....................................................... 298
  Step Two: Modify the Axis Labels ........................................................................ 298
  Step Three: Add Two Titles and Customize the Second Title .............................. 299
  Step Four: Change the Graph's Style .................................................................... 299

**Example: Add a Regression Overlay and Set Plot Properties** ............................ 300
  About This Example ............................................................................................... 300
  Step One: Create the Graph and Assign Data ....................................................... 301
  Step Two: Remove the Title and Footnote .......................................................... 302
  Step Three: Change Plot Properties ..................................................................... 302
  Step Four: Change the Graph's Style .................................................................... 304
  Step Five: Restore the Automatic CLI Plot Color ............................................... 305
Example: Create a Grouped Series Plot

About This Example

In this example, you create a series plot with grouped data. You also do the following:

- change a plot line property
- customize the title and remove the footnote
- add and reposition a discrete legend

Here is the graph that you create in this example:

Figure 23.1  Grouped Series Plot

There are several ways to create and customize this graph. The following steps show one way to create the graph.
Step One: Create the Graph and Assign Data

To create the graph and assign data:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2. On the Basic tab, double-click the SeriesPlot icon. The Assign Data dialog box appears.

3. In the Assign Data dialog box, complete these steps:
   - Select SASHELP from the Library list box.
   - Select STOCKS from the Data Set list box.
   - Select DATE from the X list box.
   - Select CLOSE from the Y list box.
   - Select STOCK from the Group list box.

4. Click OK.

Step Two: Change a Plot Line Property

Change the line properties of the plot so that all the lines are solid. The lines obtain their appearance from the style element for the group. By changing the line properties, you override that style element.

To change the line properties:

1. Right-click anywhere within the plot area and select Plot Properties. The Cell Properties dialog box appears and displays the Plots tab.

2. From the Plot list box, select series if it is not already selected.

3. From the Pattern list box, select the solid line.
By default, **Group** is selected. This selection indicates that the value is derived from the group variable. When you explicitly change the pattern, you override the default value.

4 Click **OK**.

**Step Three: Customize the Title and Remove the Footnote**

To customize the title and remove the footnote:

1 Double-click the placeholder title. The placeholder text is highlighted:

   **Type in your title...**

2 In the text box, enter **Stock Trend**.

3 In the bottom left corner of the graph, right-click the placeholder footnote and select **Remove Footnote** from the pop-up menu.

**Step Four: Add and Reposition a Discrete Legend**

To add and reposition a discrete legend:

1 Click and drag the **Discrete Legend** icon from the **Insets** panel to the bottom of the plot area. The legend is placed near the X axis (where you dragged it).

2 Right-click the legend and select **Legend Properties**. The Legend Properties dialog box appears.

3 From the **Position** list box, select **Top Left**, and then click **OK**.
   The legend is moved to the top left corner of the graph.
Example: Create a Scatter Plot with Modified Axis Labels and Two Titles

About This Example

In this example, you create a scatter plot from a blank graph window. You also do the following:

- modify the axis labels
- add two titles and apply a different style element to the second title
- change the style that is applied to the graph

Here is the graph that you create in this example:

*Figure 23.2  Scatter Plot*
There are several ways to create and customize this graph. The following steps show one way to create the graph.

**Step One: Create the Graph and Assign Data**

To create the graph and assign data:

1. Click the New Blank Graph toolbar button.

2. Click and drag the **Scatter** plot icon from the **Plot Layers** panel to the blank graph window. The Assign Data dialog box appears.

3. In the Assign Data dialog box, complete these steps:
   - Select **SASHELP** from the **Library** list box.
   - Select **IRIS** from the **Data Set** list box.
   - Select **PETALLENGTH** from the **X** list box.
   - Select **PETALWIDTH** from the **Y** list box.

4. Click **OK**.

**Step Two: Modify the Axis Labels**

Change the axis labels by removing “(mm)” from the labels.

To modify the axis labels:

1. Right-click the X-axis label and select **Axis Properties**. The Cell Properties dialog box appears and displays the **Axes** tab.

2. In the **Label** text box, remove **(mm)**.

3. From the **Axis** list box, select **Y**. Then repeat the previous step for the Y axis.

4. Click **OK**.
Step Three: Add Two Titles and Customize the Second Title

Add two titles and apply a different style element to the second title.

To add and modify titles:

1. Click ☐ in the toolbar. A new title text box is added above the graph.
2. In the title text box, enter Iris Petal Dimensions.
3. To add the second title, repeat the previous steps and enter Units in Millimeters for the title text.
4. Right-click the second title and select Title Properties from the pop-up menu. The Text Properties dialog box appears.
5. From the Style Element list box, select GraphFootnoteText. Then select OK. The title now has a different appearance.

A style element is a component of an ODS style. Changing the style element enables you to obtain a different look for the title without overriding the style. In the next step, when you change the style that is applied to the graph, the appearance of the title suits the new style.

Step Four: Change the Graph's Style

To change the graph's style:

1. Right-click the graph and select Graph Properties. The Graph Properties dialog box appears.
2. From the Style list box, select Analysis.
3. Click OK.
Example: Add a Regression Overlay and Set Plot Properties

About This Example

In this example, you overlay a regression plot with confidence limits on a scatter plot. You also do the following:

- remove the title and footnote
- change the style element for one section of the plot, and explicitly override a style attribute for a different section
- change the graph's style and examine the appearance of the modified sections
- restore the style attribute override to its automatic value

Here is the graph that you create in this example:
Figure 23.3  Scatter Plot with Confidence Limits

There are several ways to create and customize this graph. The following steps show one way to create the graph.

**Step One: Create the Graph and Assign Data**

To create the graph and assign data:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2. On the **Basic** tab, double-click the **ScatterPlot** icon. The Assign Data dialog box appears.

3. In the Assign Data dialog box, keep the default values. These are as follows:
   - **SASHELP** is selected from the **Library** list box.
   - **CLASS** is selected from the **Data Set** list box.
HEIGHT is selected from the X list box.

WEIGHT is selected from the Y list box.

4 Click OK.

5 Click and drag the Regression plot icon from the Plot Layers panel to the scatter plot. The Assign Data dialog box appears.

6 In the Assign Data dialog box, do the following:

   ■ Keep the Fit an existing plot check box selected.
   ■ Select the CLM and CLI model band check boxes.

7 Click OK.

Step Two: Remove the Title and Footnote

This example is concerned primarily with plot properties. You do not need the title or footnote.

To remove the title and footnote:

1 At the top of the graph, right-click the placeholder title and select Remove Title from the pop-up menu.

2 In the bottom left corner of the graph, right-click the placeholder footnote and select Remove Footnote from the pop-up menu.

Step Three: Change Plot Properties

First, you change the style element that is assigned to one section of the plot. Then you explicitly override the style attribute for a different section.
To change the plot properties:

1. Right-click anywhere within the plot area and select **Plot Properties**. The Cell Properties dialog box appears and displays the **Plots** tab.

2. From the **Plot** list box, select **modelband** if it is not already selected. This selection corresponds to the CLM band. By default, the **Fill** check box is selected.

3. From the **Style Element** list box, select **GraphConfidence2**. The CLM band fill changes color.

4. From the **Plot** list box, select **modelband2**. This selection corresponds to the CLI band. By default, the **Outline** check box is selected.

5. From the **Color** list box (in the Outline section), select the bright green color (■). The CLI band outline changes color.

6. Click **OK**.

Your graph looks similar to the following display.
Step Four: Change the Graph's Style

To change the graph's style:

1. Right-click the graph and select **Graph Properties**. The Graph Properties dialog box appears.

2. From the **Style** list box, select **Statistical**.

3. Click **OK**.

Your graph looks like the following display.
The CLM band suits the new style, whereas the CLI outline clashes with the style. The CLI clash occurs because you earlier overrode the style element that is associated with the CLI outline. In the next step, you restore the automatic value for the style element.

**Step Five: Restore the Automatic CLI Plot Color**

To restore the automatic value for the CLI color:

1. Right-click anywhere within the plot area and select **Plot Properties**. The Cell Properties dialog box appears and displays the **Plots** tab.

2. From the **Plot** list box, select **modelband2** if it is not already selected. This selection corresponds to the CLI band.

3. From the **Color** list box, select **Auto**. The CLI band outline changes color.
4 Click **OK**.

Your graph looks like the following display.

**Figure 23.6**  Scatter Plot with Confidence Limits
Examples for Creating Multi-Cell Graphs

Example: Create a Classification Panel ........................................... 308
  About This Example ................................................................. 308
  Step One: Create the Graph and Assign Data .............................. 309
  Step Two: Change Plot Properties .............................................. 310
  Step Three: Add a Global Legend ............................................. 311
  Step Four: Customize the Title and Footnote ............................... 311
  Step Five: Remove the Axis Labels .......................................... 312

Example: Create a Heterogeneous Panel ......................................... 312
  About This Example ................................................................. 312
  Step One: Create the First Cell and Assign Data ......................... 313
  Step Two: Add Normal and Kernel Plots to the Graph .................... 314
  Step Three: Change the Style Element of the Kernel Plot ............. 314
  Step Four: Add and Customize a Discrete Cell Legend ................. 315
  Step Five: Create the Second Cell and Add a Plot ...................... 315
  Step Six: Widen the Cell in the First Column .............................. 316
  Step Seven: Customize the Title and Footnote ............................ 316
  Step Eight: Change the Graph's Style ...................................... 317

Example: Create a Shared-Variable Graph and Add a Dynamic Title .... 317
  About This Example ................................................................. 317
  Step One: Create a Shared-Variable Graph and Assign Data .......... 318
  Step Two: Create the Second Cell and Add a Plot ...................... 319
Example: Create a Classification Panel

About This Example

In this example, you create a classification panel based on two bar charts. You also do the following:

- change the color and transparency for one of the bar charts
- add a global legend
- customize the title and footnote
- remove the axis labels

Here is the graph that you create in this example:
There are several ways to create and customize this graph. The following steps show one way to create the graph.

**Step One: Create the Graph and Assign Data**

To create the graph and assign data:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2. On the Basic tab, double-click the Vertical Bar icon. The Assign Data dialog box appears.

3. In the Assign Data dialog box, complete these steps:
   - Select SASHELP from the Library list box.
   - Select PRDUAL from the Data Set list box.
Select COUNTRY from the Category list box.

Select PREDICT from the Response list box.

4 Click the Panel Variables tab.

5 Select PRODTYPE from the Column list box.

6 Click OK.

7 From the Plot Layers panel, click and drag the Bar icon to the graph. The Assign Data dialog box appears.

8 In the Assign Data dialog box, complete these steps:
   - Select COUNTRY from the Category list box.
   - Select ACTUAL from the Response list box.

9 Click OK.

Step Two: Change Plot Properties

Change the color and transparency of the second bar chart so that it can more easily be distinguished from the first bar chart.

To change the plot properties:

1 Right-click anywhere within the plot area and select Plot Properties. The Cell Properties dialog box appears and displays the Plots tab.

2 From the Plot list box, select bar2 if it is not already selected.

3 In the Fill section, select a different color from the Color list box. For this example, select the peach color ( ).

4 Click and drag the Transparency slider to the right to increase the transparency to 50%.
5 Click the **Bar** tab.

6 Select **0.65** from the **Bar Width** list box.

7 Click **OK**.

**TIP** The bar width can also be changed when you assign data to the plot. To access this option, click **Advanced Options** in the Assign Data dialog box.

### Step Three: Add a Global Legend

To add a global legend to a graph:

1 Click ![Global Legend](image) in the toolbar. The Global Legend dialog box appears. The dialog box contains a list of all the plots and lines in the graph.

2 Select the check box next to the **Select Plot** column heading. Both plots are automatically selected.

3 Click **OK**. The legend appears at the bottom of the graph.

### Step Four: Customize the Title and Footnote

Most graphs that are opened from the Graph Gallery contain a placeholder title and footnote. For this example, you replace the title text and remove the footnote.

To customize the title and the footnote:

1 Double-click the placeholder title. The placeholder text is highlighted:

   ![Type in your title...](image)

2 In the text box, enter **Predicted and Actual Sales Figures**.

3 In the bottom left corner of the graph, double-click the placeholder footnote. The placeholder text is highlighted.
4 In the text box, enter \textbf{Data: 1993, 1994}.

**Step Five: Remove the Axis Labels**

The axis labels occupy graph space and are not necessary to understand the graph. You can remove them from the graph.

1 Triple-click the Y-axis label (“Predicted Sales”) and press Delete. The axis label is removed.

2 Triple-click the X-axis label (“Country”) and press Delete. The axis label is removed.

The labels are not permanently deleted. If you want to restore a label for an axis, right-click the axis and select \textbf{Axis Properties}. Then select the \textbf{Label} check box.

---

**Example: Create a Heterogeneous Panel**

**About This Example**

In this example, you create a paneled graph with two cells. Each cell contains different types of plots. You also do the following:

- add and customize the contents of a cell legend
- change the style element of the kernel plot
- resize the two cells
- customize the title and footnote
- change the graph's style

Here is the graph that you create in this example:
There are several ways to create and customize this graph. The following steps show one way to create the graph.

**Step One: Create the First Cell and Assign Data**

To create the first cell and assign data:

1. Open the Graph Gallery if it is not already open. For instructions, see “Open and Use the Graph Gallery” on page 14.

2. On the **Basic** tab, double-click the **Histogram** icon. The Assign Data dialog box appears.

3. In the Assign Data dialog box, complete these steps:
   - Select **SASHELP** from the **Library** list box.
   - Select **CARS** from the **Data Set** list box.
Select HORSEPOWER from the Analysis list box.

4 Click OK.

**Step Two: Add Normal and Kernel Plots to the Graph**

To add normal and kernel plots to the graph:

1 From the **Plot Layers** panel of the **Elements** pane, click and drag the **Normal** icon to the graph. The Assign Data dialog box appears.

2 In the Assign Data dialog box, keep the default selections. These are as follows:
   - The **Fit an existing plot** check box is selected.
   - **histogram** is selected from the **Plot** list box.
   Keep all other defaults and click **OK**. A normal plot is added to your graph.

3 From the **Plot Layers** panel, click and drag the **Kernel** icon to the graph. The Assign Data dialog box appears.

4 In the Assign Data dialog box, keep the default selections. These are as follows:
   - The **Fit an existing plot** check box is selected.
   - **histogram** is selected from the **Plot** list box.
   Keep all other defaults and click **OK**. A kernel plot is added to your graph.

**Step Three: Change the Style Element of the Kernel Plot**

In the example, both the normal and the kernel density plots have the same visual properties, and you cannot distinguish between the two. In this step, you change the style element of the kernel plot so that you can distinguish the kernel plot from the normal plot.
1 Right-click anywhere within the plot area and select **Plot Properties**. The Cell Properties dialog box appears and displays the **Plots** tab.

2 From the **Plot** list box, select **kernel** if it is not already selected.

3 From the **Style Element** list box, select **GraphFit2**.

4 Click **OK**.

The kernel plot now has a different appearance from the normal plot. This change makes it easier to distinguish the two plots from each other.

**Step Four: Add and Customize a Discrete Cell Legend**

In this step, you first add a legend to the graph cell. Then you remove the histogram from the legend. Finally, you capitalize the normal and kernel labels in the legend.

To add and customize a legend:

1 Click and drag the **Discrete Legend** icon from the **Insets** panel to the upper right corner of the cell. By default, all plots in the cell are displayed in the legend.

2 Right-click the legend, and then select **Legend Contents**. The Legend Contents dialog box appears.

3 Clear the check box next to the histogram plot.

4 Double-click the label for the normal plot and change the first letter to a capital \( N \).

5 Double-click the label for the kernel plot and change the first letter to a capital \( K \).

6 Click **OK**.

**Step Five: Create the Second Cell and Add a Plot**
1 Right-click anywhere within the plot area and select **Add a Column**. A new column cell is added to the right of the histogram.

2 From the **Plot Layers** panel, click and drag the **Box** icon to the new cell. The Assign Data dialog box appears.

3 In the Assign Data dialog box, complete these steps:
   - Select **SASHELP** from the **Library** list box.
   - Select **CARS** from the **Data Set** list box.
   - Select **HORSEPOWER** from the **Analysis** list box.
   - Select **ORIGIN** from the **Category** list box.

4 Click **OK**.

### Step Six: Widen the Cell in the First Column

Both cells in the graph currently have the same width. You can widen the cell that contains the histogram so that the histogram has more space.

To change the width of the two columns:

1 Position the cursor between the two cells of the graph. A dashed line appears between the cells and the cursor changes to a two-headed arrow ↔.

2 Click and drag the dashed line toward the right. The cell with the histogram becomes wider and the cell with the box plot becomes narrower.

### Step Seven: Customize the Title and Footnote

To customize the title and the footnote:

1 Double-click the placeholder title. The placeholder text is highlighted:
2 In the text box, enter **Distribution of Horsepower for Vehicles**.

3 In the bottom left corner of the graph, double-click the placeholder footnote. The placeholder text is highlighted.

4 In the text box, enter **Data: 2012**.

---

**Step Eight: Change the Graph's Style**

To change the graph's style:

1 Right-click the graph and select **Graph Properties**. The Graph Properties dialog box appears.

2 From the **Style** list box, select **HTMLBlue**.

3 Click **OK**.

---

**Example: Create a Shared-Variable Graph and Add a Dynamic Title**

**About This Example**

In this example, you create a graph that is similar to the previous example. The graph has two cells with different types of plots. The main distinction is that this example uses a shared variable. Shared variables make it easy to change the data that is used in the graph.

You also do the following:

- specify that the plots share a common axis
- change the height of the cells
- add a generic title, and change the graph’s style
modify the graph to use a different variable and data set
modify the title to include dynamic content
generate the graph by using the SGDESIGN procedure

Here is the graph that you create in this example:

**Figure 24.3  Shared-Variable Graph**

There are several ways to create and customize this graph. The following steps show one way to create the graph.

**Step One: Create a Shared-Variable Graph and Assign Data**

To create a shared-variable graph:

1. Select **File  ➤ New  ➤ Blank Shared Variable Graph**. The Assign Data dialog box appears. A **Shared Variables** tab is active in the dialog box. The other tabs are present but are dimmed.
2 In the Assign Data dialog box, complete these steps:
   - Select SASHELP from the Library list box.
   - Select CARS from the Data Set list box.
   - For the V1 shared variable, complete these steps:
     - Select HORSEPOWER from the Variable list box.
     - Select Numeric from the Type list box.

3 Click OK.

4 From the Plot Layers panel, click and drag the Histogram icon to the graph cell. The Assign Data dialog box appears and displays the Plot Variables tab.

5 In the Variables section, select V1 (HORSEPOWER) from the X list box.

6 Click OK.

7 From the Plot Layers panel, click and drag the Normal icon to the graph. The Assign Data dialog box appears and displays the Plot Variables tab.

8 In the Variables section, select V1 (HORSEPOWER) from the X list box.

9 Click OK. The shared-variable graph has a histogram and a normal plot.

Step Two: Create the Second Cell and Add a Plot

1 Right-click anywhere within the plot area and select Add a Row. A new row cell is added beneath the histogram.

2 From the Plot Layers panel, click and drag the Box(H) icon to the new cell. The Assign Data dialog box appears and displays the Plot Variables tab.

3 In the Variables section, select V1 (HORSEPOWER) from the Y list box.
4 Click OK.

**Step Three: Share a Common Column Axis**
To share a common axis, right-click the Horsepower axis in either cell and select Common Column Axis.

**Step Four: Change the Height of the Cells**
You can increase the height of the cell that contains the histogram. This action decreases the height of the cell that contains the box plot.

To change the height of the cells:

1. Position the cursor between the two rows. A dashed line appears between the rows and the cursor changes to a vertical two-headed arrow $\uparrow\downarrow$.

2. Click and drag the dashed line downward. The box plot becomes shorter, and the histogram becomes taller.

**Step Five: Add a Generic Title**
In this step, you add a title to the graph. You need to keep the title generic because later you will change the data.

To add a title to the graph:

1. Click $\square$ in the toolbar. A new title text box is added above the graph.

2. In the text box, enter Distribution Chart.
Step Six: Change the Graph’s Style

To change the graph's style:

1. Right-click the graph and select **Graph Properties**. The Graph Properties dialog box appears.

2. From the **Style** list box, select **HtmlBlueCML**.

3. Click **OK**.

Step Seven: View the Result of the Initial Graph

Here is the result of the shared-variable graph that you have created.

*Figure 24.4  Initial Shared-Variable Graph*
Step Eight: Change the Graph Variable from Horsepower to Engine Size

Normally, if you want to change the variable that is used in a multi-cell graph, you would need to make the change in the individual plots. In a shared-variable graph, you can change the variable for all plots at one time.

1. Right-click inside the plot area of a cell in the graph, and select **Assign Data**.
   The Assign Data dialog box appears.

2. Click the **Shared Variables** tab.

3. To reassign a data variable to the V1 shared variable, select **ENGINESIZE** from the **Variable** list box.

4. Click **OK**.

Both cells of the graph change to reflect the new variable.
Step Nine: Change the Data Set

In the previous step, you reassigned a different variable to the shared variable. Suppose that you want to use the same graph with a different data set. This is easy to do when you use shared variables.

1. Right-click inside the plot area of a cell in the graph, and select Assign Data. The Assign Data dialog box appears.

2. Click the Shared Variables tab.

3. Change the following:
   - Select CLASSFIT from the Data Set list box.
   - For the V1 shared variable, select WEIGHT from the Variable list box.

4. Click OK.
The graph changes to reflect the new data set.

**Figure 24.6**  *Shared-Variable Graph That Uses a Different Data Set*

---

**Step Ten: Add Dynamic Content to the Title**

So far this example has used a generic title. Suppose that you want the title to more accurately reflect the data this is used for the graph. You can use dynamic content in the title.

1. Double-click the title. The title enters Edit mode.

2. In the text box, enter `Distribution of dyn(EXAMPLESV)`.

Here is an example of the graph.
You must generate the graph by using the SGDESIGN procedure to replace the dynamic content in the title with actual text.

See Also
“Adding Dynamic Content to Text” on page 117

Step Eleven: Generate the Graph By Using the SGDESIGN Procedure

In this step, you use the SGDESIGN procedure to generate the graph.

In the SGDESIGN procedure, you use the DYNAMIC option to provide the text to substitute for the $\text{dyn(EXAMPLESV)}$ expression.

To generate the graph:

1. Save the graph so that you can reference it in the SGDESIGN procedure.

   a. Select File ➤ Save As.
Save the file to the desired location. Then complete these steps:

- Enter the name `svExample` in the **Filename** text box.
- Select **SGD Files (*.sgd)** from the **File type** list box. (This should be selected by default.)

**c** Click **Save**.

2 In SAS, enter and submit the following program:

```sas
proc sgdesign sgd="file-name-and-path"
   dynamic EXAMPLESV="Class Weight";
run;
```

Replace `file-name-and-path` with the path to the graph. For example, the path might be "C:\SGDFiles\svExample.sgd".

**Note:** In this example, you do not need to specify the value for the V1 shared variable. The example uses the default value WEIGHT.

For more information about the SGDESIGN procedure, see “SGDESIGN Procedure” in *SAS ODS Graphics: Procedures Guide*.

Here is the SAS output.
Figure 24.8  Shared-Variable Graph Output

Distribution of Class Weight

Percent

Weight

25 50 75 100 125 150 175
Recommended Reading


For a complete list of SAS publications, go to sas.com/store/books. If you have questions about which titles you need, please contact a SAS Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-0025
Fax: 1-919-677-4444
Email: sasbook@sas.com
Web address: sas.com/store/books
cell
in ODS graphics, a distinct rectangular subregion of a graph that can contain plots, text, or legends.

classification panel
a multi-cell graph in which the cell data is driven by the values of one or more classification variables. The number of the cells is determined by the unique values of the classification variables. Each cell of the panel has the same types of plots.

classification variable
a variable whose values are used to group (or classify) the observations in a data set into different groups that are meaningful for analysis.

graph
a visualization created by SAS software that can contain any of the following: a title, footnotes, legend, and multiple cells.

Graph Gallery
in ODS Graphics Designer, a gallery of predefined, commonly used graphs. Users can add their own custom graphs to the gallery.

Graph Template Language
an extension to the Output Delivery System (ODS) that enables users to create sophisticated analytical graphs. Short form: GTL.

GTL
See Graph Template Language.
heterogeneous panel
   a multi-cell graph in which each cell is defined independently and can contain different types of plots.

marker
   a symbol such as a diamond, a circle, or a triangle that is used to indicate the location of a data point in a plot.

ODS
   See Output Delivery System.

ODS Graphics
   an extension to ODS that is used to create analytical graphs using the Graph Template Language.

ODS style
   a template that specifies instructions for the presentation aspects (color, font face, font size, and so on) of your SAS output. This template determines the overall appearance of the documents that use it. Each style consists of style elements.

ODS template
   a description of how output should appear when it is formatted. ODS templates are stored as compiled entries in a template store (item store). Common template types include STATGRAPH, STYLE, CROSSTABS, TAGSET, and TABLE.

Output Delivery System
   a component of SAS software that can produce output in a variety of formats such as markup languages (HTML, XML), PDF, listing, RTF, PostScript, other formats, and SAS data sets. Short form: ODS.

panel
   a graph with multiple cells.
plot
  a visual representation of data such as a scatter plot, a series line, or a histogram. Multiple plots can be overlaid in a cell to create a graph.

scatter plot matrix
  a grid of scatter plots showing pairwise combinations of multiple numeric variables.

SGD file
  an ODS Graphics Designer file. Users can open this file in the designer and change the graph. Users can also render the graph to an ODS destination by using the SGDESIGN procedure.

shared variable
  a feature of ODS Graphics Designer that enables users to reuse graphs and specify different variables from the same or from a different data set.

style attribute
  a visual property, such as color, font properties, and line characteristics, that has a reserved name and value defined in ODS. Style attributes are collectively referenced by a style element within a style.

style element
  a named collection of style attributes that affects specific parts of ODS output. For example, a style element might specify the color and font properties of title text or other text in a table or graph.
Index

A

Add an Element pop-up window 17
attribute priority
default 274
Auto Chart tab
preference settings on 279
Auto Charts
about 85
generating 88
modifying 91
saving 93
axes
color bands 177
customize ticks 182
labels 180
minor ticks 177
offset 177
properties 175
shared 231
sharing or unsharing a common external axis 231
axis tables
data 64
properties 169

B

background color
changing for legends 106
band plots
data 60
properties 157
bar chart
data 58
properties 155
bar error chart
See bar chart
blank graph windows
creating classification panels 246
creating graphs 48
creating heterogeneous panels 226
block plots
data 62
properties 166
box plot
data 59
properties 154

C

CAS data 5
cell 39

cell headers 237
  changing position of 240
  editing and formatting 238
  removing 240

cell legends 100
  adding 100

cells
  adding headers to 237
  multi-cell graphs 219
  removing text entries from 112

classification panels 220, 221, 241
  changing single-cell graphs to 248
  creating 243
  creating from blank graph window 246
  creating with Graph Gallery 244

data lattices and data panels 249
  example 308
  layout options 249
  methods for creating 243
  cluster width options 66

code for graphs
  viewing, copying, and saving 80

color
  changing legend outline or background color 106
  specifying 115
  color bands 177
  Color list box 115

columns
  adding to graphs 227
  arranging legend contents in 107
  removing 234
  resizing 230

components of a graph 39
  connect order 68
  contour plots
    data 60
    properties 159
  copy and paste graphs to another application 81
  copying code for graphs 80
  creating graphs 46

 curve labels 68

data
  assigning to new plots 50
  assigning to plots 49
  changing data assignment for a plot in a graph 53

data labels 68

data lattices 249

 data limit 278

data panels 249

data skin
  default 274
  default attribute priority 274
  default skin 274
default style 274
discrete offset option 67
drop lines
  changing length of 75
data 70
properties 165
dynamic content 117
  adding to text 117
  specifying 117
dynamic titles
  example 317

Elements pane 16
  Add an Element pop-up window 17
  changing appearance of 19
  Insets panel 19
  Plot Layers panel 18
  showing or hiding 17
ellipse plots
  properties 164
error limits 68
examples
  creating classification panel 308
  creating grouped series plot 294
  creating heterogeneous panel 312
quick-start 22
running on SAS server 36
shared-variable graph with dynamic title 317

files
  saving Auto Charts to 93
  saving graphs to 76
footnotes 95
  adding 96
  editing 96
  formatting 96
  removing (example) 26
fringe plots
  properties 161

global legends 100
  adding 100
graph components 39
Graph Gallery 13
  adding graphs to 77, 282
  at start-up 275
creating classification panels 244
creating graphs from 47
creating heterogeneous panels from 225
opening and using 14
predefined tabs 15
tab descriptions 15
graph properties 121

F

files
  saving Auto Charts to 93
  saving graphs to 76
footnotes 95
  adding 96
  editing 96
  formatting 96
  removing (example) 26
fringe plots
  properties 161

G

global legends 100
  adding 100
graph components 39
Graph Gallery 13
  adding graphs to 77, 282
  at start-up 275
creating classification panels 244
creating graphs from 47
creating heterogeneous panels from 225
opening and using 14
predefined tabs 15
tab descriptions 15
graph properties 121
Graph tab
preference settings on 273

Graph Template Language (GTL) 4
graph windows
creating classification panels
  from blank window 246
creating graphs from blank window 48
creating heterogeneous panels from blank window 226

graphs
adding lines 70
adding plots 48
adding rows and columns 227
adding text entries 109
adding to Graph Gallery 77, 282
changing data assignment for plots in 53
changing single-cell graph to classification panel 248

copy and paste to another application 81
creating 46
creating Auto Charts 88
creating from blank graph window 48
creating from Graph Gallery 47
multi-cell 219
opening 79
properties 121
removing rows or columns 234
saving to a file 76
shared variables in 259
simple graph (example) 22
size of 273
viewing, copying, and saving code 80
group display options 66
  include missing group values 67
group order options 66
Group role 58, 59, 65
grouped data 65
grouped series plot
  example 294
GTL (Graph Template Language) 4

headers
  adding to cells 237
heterogeneous panels 219, 221, 223
adding headers to cells 237
adding rows and columns 227
creating 225
creating from blank graph window 226
creating from Graph Gallery 225
example 312
removing rows or columns 234
resizing rows or columns 230
sharing or unsharing a common external axis 231
high-low plots
data 63
properties 167
histogram
data 60
properties 153

I
include missing group values option 67
information dialogs 275
Insets panel 19

K
kernel plots
properties 161

L
labels
axis 180
data and curve 68
editing legend labels 103
layout options
classification panels 249
legends 99

M
model band
data 61
properties 163
multi-cell graphs 219
 differences among 221
in ODS Graphics Designer 219

N
needle plots
properties 151
normal plots
  properties 161

ODS Graphics Designer 4
  main tasks 6
  multi-cell graphs in 219
  starting 7
  supported platforms 5
  users of 4
ODS styles 113
  opening graphs 79
  outline color
    changing for legends 106

pbspline plots
  data 61
  properties 163
platforms supported 5
plot area 39
Plot Layers panel 18
plot properties 136, 137
plot roles 50, 57
plots
  adding to graphs 48
  assigning data to 49
  assigning data to new plots 50
  changing data assignment for 53
  selecting 69
  setting properties 137
Preference file location 276
  preferences 271
    Auto Chart tab 279
    Graph tab 273
    Render tab 277
  setting 272
  properties
    graph 121
    plot 136, 137

quick-start examples 22
  designing a simple graph 22
  enhancing graphs 27

recently used files 275
reference lines
  changing length of drop lines 75
  data 70
  properties 165
  repositioning 74
  types of 70
regression plots
  data 61
  properties 163
Render tab
  preference settings on 277
rendering options 277
repositioning
  legends 108
  reference lines 74
text entries 111
resizing
  rows or columns 230
rows
  adding to graphs 227
  arranging legend contents in 107
removing 234
resizing 230

S

SAS server
  running examples on 36
saving
  Auto Charts 93
  code for graphs 80
  graphs to a file 76
scatter plot matrices 220, 221, 251
  creating 253
scatter plots
  properties 150
series plots
  connect order 68
  properties 151
SGD files 4
SGDESIGN procedure 5
shared axes 231
shared variables 259
changing data used in graphs 265
creating graphs 262
example 317
features of 261
requirements for creating graphs 261
single-cell graphs
  changing to classification panel 248
skin 275
stack block plots
  See block plots
starting ODS Graphics Designer 7
step plots
  connect order 68
  properties 151
style elements
  specifying for text properties 113

T
text
  adding dynamic content to 117
text entries
  adding to graphs 109
  editing 110
  formatting 110
  removing from cells 112
  repositioning 111
  text properties
<table>
<thead>
<tr>
<th>Specifying Style Elements for</th>
<th>Tick Marks</th>
</tr>
</thead>
<tbody>
<tr>
<td>113</td>
<td>Customize</td>
</tr>
<tr>
<td>Titles</td>
<td>95</td>
</tr>
<tr>
<td>Adding</td>
<td>96</td>
</tr>
<tr>
<td>Adding to legends</td>
<td>104</td>
</tr>
<tr>
<td>Customizing (example)</td>
<td>25</td>
</tr>
<tr>
<td>Editing</td>
<td>96</td>
</tr>
<tr>
<td>Formatting</td>
<td>96</td>
</tr>
</tbody>
</table>

See also shared variables

Assigning data to plots 49

Vector plots

Data 60

Properties 158

Viewing code for graphs 80

**X**

X role 57

**Y**

Y role 57

**Z**

Z role 57
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore
for additional books and resources.